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INTRODUCTION 

Engineering and computer graphics play an important role in the training of specialists with a 
technical education. The ability to read and execute drawings is a prerequisite for successful work in the 
workplace. Therefore, the purpose of studying technical disciplines is to acquire knowledge, skills and 
abilities to read working assembly drawings and drawings of products made with both detachable and fixed 
connections, and to develop them using computer graphics tools, using knowledge and skills in further 
studies and future professional activities. 

While studying the subject, students get acquainted with the drawings rules in accordance with the 
Unified State Construction Code, with the types of design documentation, study the conventions and 
simplifications used in engineering drawings, learn to make sketches of parts, draw and read general types 
of drawings and assembly drawings of both welded and detachable products of medium complexity. 

Studying the discipline «Computer Graphics» provides students with a set of knowledge and skills 
necessary to perform individual tasks in an educational institution and further work in production. 

Computer and software support of the educational process plays an important role in the study of this 
subject. 

Before using a personal computer to make a drawing and other design documentation, a student must 
have a certain level of the theory of engineering graphics knowledge and have a sufficient level of skills in 
making and reading a drawing. The ability to analyse an orthogonal drawing of a geometric object, the 
ability to dissect its complex shape into simple constituent geometric bodies and the ability to synthesise 
them is the basis of an effective dialogue between a student and a computer. Therefore, when computing is 
widely used in the educational process, it is impossible to substitute the study of a subject for the study of 
computer application. 

After mastering engineering graphics, the training of a competent user should include the study of 
the use of computing technology in the field of machine graphics, the possibilities of applying various 
graphic skills and the study of special literature. Competent user is able to set himself tasks for the design 
of technical objects and the production of design documentation and is able to solve them with the help of 
such a modern tool as a computer.  

Thus, using their knowledge of engineering and computer graphics, students should move on to 
making drawings, constantly improving their skills in working with a computer graphics editor. 

This tutorial is intended primarily for students of technical specialities, but it can also be useful for 
a wide range of users: university students of all forms of education, engineers who want to master and use 
modern computer technologies in engineering drawings. 

 
 

  



6 

 
 
 

1. BASICS OF COMPUTER GRAPHICS 

Currently, there are many graphic editors and geometric modelling programmes available. Autodesk 
is one of the leading manufacturers of computer-aided design systems and software for designers, engineers, 
and architects. 

The AutoCAD system developed by this company is the world's leading computer-aided design 
(CAD) software platform designed for professionals who need to translate their creative ideas into real, 
dynamic projects. 

AutoCAD is an evolving core design environment, with each new version building on the best of the 
previous ones and addressing the following key challenges: 

- increasing the productivity and efficiency of users; 
- ensuring the reuse of existing developments; 
- seamless user collaboration in the design process; 
- adaptation of AutoCAD to the developers individual needs of object-oriented tasks. 
Запорука успіху Autodesk – світове визнання AutoCAD як стандарту де факто для розробки 

продуктів і комплектуючих, а також для документації. 
Завдяки випуску AutoCAD компанія Autodesk пропонує архітекторам, інженерам і 

проектувальникам новий інструмент для ще більш повного втілення їх ідей в реальність. 
The key to Autodesk's success is the worldwide recognition of AutoCAD as the de facto standard for 

product and component design and documentation. 
With the release of AutoCAD, Autodesk is offering architects, engineers and designers a new tool to 

bring their ideas to life. 

1.1. Downloading AutoCAD 

You can download AutoCAD in the following ways: 
- on the Taskbar, select Start → All Programs → Autodesk → AutoCAD from the menu; 
- on the Windows desktop, double-click the AutoCAD icon. 
When you start AutoCAD, a new drawing is created with no name. You can either start working in 

it or load an existing file from the disc. 
When you open a previously prepared drawing, all system variables are assigned the values they had 

during the last session. This happens because the variables are saved in the file along with the drawing. 
After the start, the Start window appears, designed as a permanent tab called Start (Figure 1.1). 
Figure 1.1 shows a variant of the window for starting work in the CREATE (Створення 

«Создание») mode. This mode is the main mode in which you start working with a graphic document.  
In the Get Started (Початок роботи «Начало работы»)column, select one of the main options:  
 Start Drawing (Початок побудов «Начало построения»);  
 Templates (Шаблони «Шаблоны»);  
 Open Files. (Відкрити файли «Открыть файлы») 
The same column contains three additional options for getting started: 
‒ option Open a Sheet Set (Відкрити підшивку «Открыть подшивку») allows you to open a binder 

(a set of project drawings); 
‒ The Get More Templates Online (Доступ до шаблонів в Інтернеті «Доступ к шаблонам в 

Интернете») option redirects you to a website with additional drawing templates; 
‒ the Explore Sample Drawings (Перегляд прикладів креслеників «Просмотр примеров 

чертежей») option offers to open a file from the Sample folder with examples of this version of AutoCAD. 
Clicking in the Work with drawings (Робота з креслениками «Работа с чертежами») rectangular 

area opens the AutoCAD working window (Figure 1.2). 
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After the system has finished loading, the working window contains an open document, i.e. a drawing 
that has been created (or opened for editing). The name of the current drawing file is displayed in the 
AutoCAD title bar and in the title bar of the drawing tab (in Figure 1.2, it is Drawing1.dwg). 

If you click on the Create button, the Select Template window appears in the upper left corner, 
where you can select the desired drawing template. 

 

 

Figure 1.1. The window for starting work (CREATE mode) 

1.2. The concept of a template 

You can make the set of session parameters available in new drawings you create. To do this, save 
the drawing as a template. A template is usually a drawing that does not contain any graphical objects and 
is used only to store standard values of system variables. 

Templates (files with the .dwt extension) are a very convenient way to create a set of drawings with 
the same settings. You can use both templates that come with AutoCAD and those that you create. You can 
save any existing drawing as a template. In this case, the values of all the settings of the saved document 
will be inherited by all new drawings created on its basis. 

Although any drawing will do as a template, it is best to prepare a set of standard templates that 
contain the most commonly used settings and basic elements: 

‒ type and accuracy of unit representation; 
‒ drawing limits; 
‒ setting up the step, grid and orthogonal «ОРТО» modes; 
‒ ayer organisation; 
‒ basic labels, frames and logos; 
‒ dimensional and text styles; 
‒ line types and weights (thicknesses). 
Any changes made to a drawing created from a template do not affect the template itself. 
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1.3. Calling the help system 

At any time while working with AutoCAD, you can access the electronic documentation for the 
programme. To do this, select Help from the drop-down menu. Alternatively, press the F1 key 

on the function keypad. 

1.4. User interface (Drawing and annotation) 

The basic elements of the AutoCAD window are completely similar to those of any modern Windows 
application. AutoCAD has a simple and user-friendly menu-based and command language interface that 
provides the user with convenient and efficient means of communicating with the computer when making 
drawings 

When you open the Get Started (Початок роботи «Начало работы») dialogue box, the AutoCAD 
window opens and the workspace is created (Figure 1.2 ). A workspace is a set of menus, palettes, toolbars, 
and panels that are configured to perform specific tasks, such as drawing in two or three dimensions. The 
user can easily create their own workspaces that are tailored to their needs. 

 

 

Fig. 1.2. The AutoCAD workspace 

The AutoCAD window consists of several parts, each of which performs specific functions: entering 
commands, displaying information you need when drawing, and so on. 

The central area of the working window is called the graphical screen, where all constructions are 
performed. On the graphical screen, the mouse pointer takes the form of a crosshair and is able to perform 
functions used in design: snapping to objects, setting coordinates and directions. When you leave the 
graphical screen, the pointer returns to its usual appearance. 

At the top of the window, there is a ribbon with tabs containing command buttons (Figure 1.2). It has 
replaced the menu items used in previous versions of the program. On the ribbon, the tools are arranged in 
the form of logical groups, which represent a compact palette of all the necessary tools for creating or 
modifying a drawing. 

For users who prefer the previous view of the window, it is possible to switch to the classic mode. 
Let's look at the ribbon with tabs for drawing two-dimensional objects. 
Main tab (Головна «Главная») ‒ here you can find the main tools used when working with drawings. 

This tab contains the following groups of commands: 
  Drawing (Малювання «Рисование») ‒ allows you to create graphic primitives, areas or polylines 

from closed elements, various masking objects, apply hatching, etc; 
  Edit (Редагування «Редактирование») ‒ contains tools for transforming objects, such as scaling, 

elongation, rotation, alignment, etc., as well as for editing hatching, spline, and other objects; 
  Annotations (Анотації «Аннотации») ‒ contains tools for creating text and tables, as well as for 

drawing dimensions; 
  Layers (Шари «Слои») ‒ allows you to work with layers; 
  Block (Блок «Блок») ‒ contains tools for working with blocks; 
  Properties (Властивості «Свойства») ‒ allows you to manage the properties of objects; 
  Groups (Групи «Группы») ‒ allows you to create and manage groups (i.e. named sets of drawing 

objects); 
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  Utilities (Утиліти «Утилиты») ‒ contains tools for measuring, quick selection and counting; 
  Clipboard (Буфер обміну «Буфер обмена») ‒ allows you to work with the clipboard (copy, cut, 

paste, etc.); 
 View (Вид «Вид») ‒ allows you to select the control standard used when creating a new drawing. 
Insert  (Вставка «Вставка») ‒ contains tools for working with blocks and links. The tab contains 

the following groups of commands: 
 Block (Блок «Блок») ‒ used to insert and edit blocks; 
 Block definition (Визначення блоку «Определение блока») ‒ allows you to create and edit data 

attributes that are in blocks; 
 Link (Посилання «Ссылка») ‒ used to manage links; 
 Point cloud (Хмара точок «Облако точек») ‒ allows you to insert point clouds into the 

drawing, i.e. closed polylines consisting of interconnected arcs. Point clouds are used to draw attention to 
any part of the drawing; 

 Import (Імпорт «Импорт») ‒used to import files of other formats; 
 Data (Дані «Данные») ‒ contains tools for working with updatable fields, OLE objects, 

hyperlinks, and other objects; 
 Link and extract (Зв'язування та вилучення «Связывание и извлечение») ‒ contains commands 

for working with links; 
 Location  (Місцезнаходження «Местоположение») ‒ allows you to specify the location of the 

object being created (this is important in construction drawings); 
 Contents  (Зміст «Содержание») ‒ used to search for drawings and open the control centre 

window. 
Annotations (Анотації «Аннотации») ‒ contains tools for creating text labels in the document. The 

following groups of commands are located on this tab: 
 Text  (Текст «Текст») ‒ contains tools for working with text (changing the style, font size, etc.); 
 Dimensions  (Розміри «Размеры») ‒ used to set dimensions; 
 Footnotes  (Виноски «Выноски») ‒ allows you to create and edit footnotes; 
 Tables  (Таблиці «Таблицы») ‒ contains tools for working with tables; 
 Mark  (Позначка «Пометка») ‒ contains tools for creating selection areas; 
 Annotation Scale (Масштабування анотацій «Масштабирование аннотаций») ‒ used to 

change the scale of annotation objects. AutoCAD defines annotation objects as various explanatory objects, 
such as dimensions, labels, text, etc. 

Parametrization (Параметризація «Параметризация») ‒ includes tools for parametric drawing 
that allow you to work with geometric and dimensional constraints. When using such constraints, the 
specified relationships between objects remain, even if the objects themselves change. This tab contains 
the following groups of commands: 

 Geometric  (Геометричні «Геометрические») ‒ designed to work with geometric constraints; 
  Dimensional  (Розмірні «Размерные») ‒ allows you to use dimensional constraints; 
  Management (Управління «Управление») ‒ allows you to manage constraints (delete, rename, 

set numerical values, formulas, etc.). 
View  (Вид «Вид») ‒ allows you to control the display of objects on the screen. Let's look at some 

of the groups of commands that are present on this tab: 
  Viewport tools (Інструменти видового екрана «Инструменты видового экрана») ‒ includes 

buttons for hiding or opening the viewport navigation tools: the PSC icon, the view cube, and the navigation 
bar. Here you can also open the motion navigator panel; 

 Model Viewports (Видові екрани моделі «Видовые экраны модели») ‒ allows you to create and 
edit floating viewports; 

 Palettes (Палітри «Палитры») ‒ provides quick access to various palettes that allow you to 
manage object properties, links to other drawing files and marks added to the document; perform various 
calculations, publish sheet binders, groups of sheets or individual sheets, etc; 

 Interface (Інтерфейс «Интерфейс») ‒ contains commands that are used when working with 
several open drawings. With this group, you can place document windows in the working area of the 
programme and fix their position. 
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Management (Управління «Управление») ‒ contains tools for changing various application 
settings, adapting the application interface (workspace, toolbars, menus, and keyboard shortcuts) to solve 
specific tasks. This tab also contains a group of commands for working with macros created in the VBA 
programming language. 

Output (Висновок «Вывод») ‒ This contains groups of commands for setting options for previewing 
your document before printing, printing, publishing to the web, and exporting. 

Add-ins (Налаштування «Настройки») ‒ contains additional tools in various categories that are 
easy to use and cover a wide range of AutoCAD functions, including drawing, selecting, and modifying 
objects. 

A360 (Autodesk 360) ‒ allows you to upload finished drawings to a specified location, open them 
online, display earlier versions of the drawing, share the drawing with other users, create a link (URL) to 
the drawing so that other users can view it, and receive notifications from them. 

Recommended Apps (Рекомендовані додатки «Рекомендованные приложения») ‒ Provides 
links to the Autodesk Exchange site and third-party AutoCAD sites where you can find many additional 
materials and tools. 

When you select certain objects on the ribbon, additional tabs may appear to help you work with 
them. For example, if you need to insert a table into a document, the Text Editor tab appears on the ribbon, 
with tools for editing the text you enter into the table. 

By default, the ribbon contains all the main tabs, and they contain all the panels that consist of a 
group of commands. To remove a tab from the ribbon, right-click on the ribbon and in the Show Tabs 
submenu, uncheck the box next to the name of the tab you want to remove from the ribbon. If you want to 
hide any panel from the tab, right-click on the tab and in the Show Panels submenu, uncheck the box next 
to the name of the panel you want to hide. 

You can remove any panel from the ribbon to turn it into a separate window (Figure 1.3). Such a 
panel will be displayed even if you select another tab, until you click the Return Panels to Ribbon button 
on this panel. 

 

 

Fig. 1.3. Click this button to return the panel to the tape 

To hide the ribbon, click the button with a downward triangle to the right of the ribbon tab names. 
The first click will collapse the ribbon to the tab and tool group icons, the second will show only the panel 
and tool group names, and the third will show only the tab names. The fourth click restores the ribbon to 
its original appearance.  

Above the ribbon is the application menu (the button with the letter «A»). It contains the items that 
replaced the tabbed ribbon in earlier versions of AutoCAD, as well as some other items. 

A quick access panel is next to the button for opening the application menu . It contains buttons for 
frequently used commands: Create, Open, Save, Save As, Print, Undo, and Redo (Створити, Відкрити, 
Зберегти, Зберегти як, Друк, Скасувати та Повторити «Создать, Открыть, Сохранить, Сохранить 
как, Печать, Отменить та Повторить»). Next is a button to open the menu that allows you to customise 
the Quick Access Toolbar: remove buttons for unnecessary tools or add buttons for necessary tools, display 
the Quick Access Toolbar above or below the ribbon, and open the menu bar. In particular, the Workspace 
command displays a panel that allows you to select a workspace for working on the model. If you don't 
change the initial settings, AutoCAD opens in the Drawing and Annotation workspace, which is the 
workspace most often used by designers. 

The Model, Sheet1 and Sheet2 tabs are displayed in the lower left part of the program window 
(Figure 1.4). The Model tab is active by default. This means that the screen displays the two- or three-
dimensional space of the model. When you click on any of the Sheet tabs (there can be any number of 
them), you are taken to the sheet space. To the left of the tabs are buttons for switching between them. 
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Fig. 1.4. Tabs for switching between sheet and model spaces  

In the lower left corner of the graphical area of the program window, a custom coordinate system 
CCS («ПСК») pointer is displayed (Figure 1.4). By default, AutoCAD uses the World Coordinate 
System WCS («МСК»). Its pointer is located at the point with coordinates (0, 0, 0). 

To configure the AutoCAD system settings, go to the View (Вид «Вид») tab on the ribbon and click 
the arrow button in the Interface (Інтерфейс «Интерфейс») section. The Options dialogue box 
(Параметри «Параметры») appears (Figure 1.5). 

 

 

Fig. 1.5. The «Screen» (Екран «Экран») tab of the «Options» (Параметри «Параметры») dialogue box  

At the bottom of the application window is a status bar with a set of buttons for controlling the 
drawing display. 

AutoCAD allows you to set the colour of various elements of the working window. To do this, do 
the following. 

1. Click the menu button with the letter «A» in the upper-left corner of the AutoCAD window. A 
menu appears to allow you to select program controls. 

2. Click the Options button in the lower right corner of the menu. 
3. In the Options dialogue box that opens, go to the Screen tab (Figure 1.5). 
4. In the Elements area of the window, click the Colours button. 
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5. In the Drawing window colour scheme window that appears, in the Context list, select the type 
of application window, in the Interface element list, select an element, and in the Colour drop-down list, 
select the desired colour. 

So, for example, to change the background of the model space to white, in the Context list, select 
2D model space, in the Interface element list, select Uniform background, and in the Colour list, select 
White. In the Swatch box, the background colour will change to white (Figure 1.6). 

6. Click the Accept and OK buttons to save the changes and exit the dialogue box. 
 

 

Fig. 1.6. Changing the background of the model space  

By default, the menu bar is hidden in the AutoCAD work window. To display it, click the down 
arrow button at the right end of the Quick Access bar and choose a command from the Show Menu Bar 
menu that appears. The application window will display the classic menu familiar to users of previous 
versions (Figure 1.7).  

 

 

Fig. 1.7. AutoCAD menu bar  

1.5. User interface (Classic AutoCAD) 

For ease of use, AutoCAD can switch to different workspaces ‒ 2D drawing (flat drawings), 3D 
modelling (three-dimensional models) and Classic AutoCAD (a minimal set of the most necessary tools). 
It is advisable to start learning AutoCAD from the Classic AutoCAD workspace.  

Figure 1.8 shows the classic AutoCAD desktop for Windows. It consists of the following elements:  
‒ drop-down menu ‒ the top line, located directly below the title of the application window; 
‒ standard toolbar ‒ the second line from the title; 
‒ object properties line ‒ the third line; 
‒ status bar ‒ the line at the bottom of the application window; 
‒ command line window ‒ above the status bar; 
‒ optional toolbars; 
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‒ on-screen menu ‒ optional, column on the right; 
‒ graphic field ‒ occupies another part of the desktop. 

 

 

Fig. 1.8. The AutoCAD workspace  

Drop-down menu (Падаюче меню) ‒ contains items that display AutoCad commands according to 
their functional purpose. 

Standard toolbar (Стандартна панель інструментів) ‒ contains buttons for control commands 
and commands used in the Windows environment. 

Object Property Panels (Панелі властивостей об'єктів) ‒ are panels for creating and managing 
layers, designed to work with the colour, type and weight of lines. 

Status bar (Рядок стану) ‒ contains the current cursor coordinates and buttons to enable/disable 
drawing modes. 

Command Line Window (Вікно командних рядків) ‒ used to enter commands and display 
AutoCAD prompts and messages. 

Toolbars (Панелі інструментів) ‒ contain buttons for calling drawing commands and editing 
commands. There are 35 panels in total. If necessary, you can display other panels. 

On-screen menu (Екранне меню) ‒ contains menus, submenus, commands, keys. When you select 
certain lines of the menu, you go to a submenu that defines a group of commands that are functionally 
related. 

Graphics area (Графічне поле) ‒ is the space in the middle of the AutoCAD workspace where all 
drawings and editing operations are performed. 

To view most of the command protocol ‒ the so-called command history ‒ you can switch to the text 
window. This window is called up by pressing the F2 function key. 

The crosshair cursor controlled by the pointing device (mouse) is used to mark points and select 
drawing objects. 
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1.6. Assignment of the control keys 

F1 ‒ Call up the system help. 
F2 ‒ opens the AutoCAD text window. 
F3 ‒ enables/disables the Snap mode. 
F6 ‒ enables/disables the display of cursor coordinates. 
F7 ‒ enables/disables the grid image. 
F8 ‒ enables/disables the «ОРТО» coordinate axis mode. 
F9 ‒ enables/disables the mode of fixation with a specified step. 
F10 ‒ enables/disables control from the tablet. 

1.7. Toolbars 

A drop-down menu bar provides access to most AutoCAD commands. This panel is called the system 
menu. The panel contains buttons with menu names. Clicking the buttons opens menus that group 
commonly used AutoCAD commands by function. Figure 1.9 shows the drop-down menu bar. 

If there is a small black triangle at the end of the menu, the item opens a secondary menu (submenu).  
If the menu item ends with three dots, it opens a dialogue box. 
 

 

Fig. 1.9. Drop-down menu bar  

The drop-down menu contains tabbed drawing tools: 
File (Файл «Файл») ‒ menu for working with files; 
Edit (Правка «Правка») ‒ the menu for editing parts of the graphical field of the Windows desktop; 
View (Вид «Вид») ‒ contains commands for controlling the screen, panning, switching between sheet 

space and model space, setting the viewpoint, removing invisible lines, colouring, tinting, and managing 
display options; allows you to install the necessary toolbars; 

Insert (Злиття «Слияние») ‒ allows inserting blocks, external objects, objects of other applications; 
Format (Формат «Формат») ‒ allows you to work with layers, colour, line types; control text 

style, size, point marker type, multiline style; set units of measurement, drawing borders; 
Toоls (Сервис «Сервис») ‒ contains tools for managing the system and the user screen, including 

setting drawing parameters and snaps using dialogue windows, and working with a custom coordinate 
system; 

Draw (Креслення «Черчение»)  ‒ contains drawing commands; 
Dimension (Розміри «Размеры») ‒ for commands to set dimensions and manage dimension 

settings; 
Modify (Редагувати «Редактировать»)  ‒ includes commands for editing drawing elements; 
Window (Вікно «Окно») ‒ a section that allows you to use commands to display multiple drawings 

simultaneously; 
Help (Довідка «Справка») ‒ contains a powerful hypertext help system. 
The AutoCAD desktop contains 6 of the 35 toolbars: the Standard toolbar (стандартна панель 

інструментів), the Styles toolbar (панель Стилі «Стили»), the Layers toolbar (панель Шари «Слои»), 
the Object Properties toolbar (панель Властивості об'єктів «Свойства объектов»), the Drawing 
toolbar (панель Малювання «Рисование»), and the Edit toolbar (панель Редагування 
«Редактирование»). For the convenience of working with a specific task, the user can display any other 
of the remaining toolbars on the desktop. 
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To call the required panel on the screen, right-click on any visible panel and select the name of the 
required panel in the list that opens, as shown in the figure (Figure 1.10). You can remove an unnecessary 
panel from the screen by doing the same thing again. 

 

 

Fig. 1.10. List of panels 

After a new panel is displayed, it appears as a separate window. You can use the mouse to drag it to 
any convenient location. This is done in the same way as with ordinary windows in Windows: place the 
mouse cursor on the panel window, press the left mouse button and drag the panel to the desired position 
without releasing it. You can also attach the panel to one of the edges of the AutoCAD window. To do this, 
simply drag the panel to the desired edge. 

1.8. Object properties  

AutoCAD lets you build geometric objects of many different types. You can use AutoCAD's drawing 
tools to create a wide variety of objects, from simple lines and circles to spline curves, ellipses, and shaded 
areas. When you draw objects, you specify points either by using a pointing device or by entering coordinate 
values on the command line. 

A set of properties is associated with each object you create in AutoCAD. 
A line type is assigned to the object: continuous, dashed, dotted, and so on. In addition to the standard 

ones, the user can create custom line types. 
The colour of an object allows you to visually associate it with other objects that have the same 

functional load. When printing a drawing, different colours of objects can be assigned lines of different 
thicknesses. 

Layers in AutoCAD are similar to tracing paper used in freehand drawing. Using layers allows you 
to create a drawing in layers that contain interrelated elements of its description. Objects are created in the 
current layer. Layers are assigned names, the layer name can be up to 31 characters, including letters, 
numbers, and special characters, and they can be assigned separate colours and line types. The use of layers 
provides the user with a wide range of options for managing the image on the screen. Thus, to reduce the 
saturation of a complex drawing, it is recommended to temporarily disable the visibility of layers that are 
not currently being worked on. 
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1.9. Working with the screen  

AutoCAD provides a wide variety of drawing views. When editing a drawing, you can quickly move 
from one view to another to make changes. 

Screen controls include: 
‒  to enlarge or reduce the drawing or its fragment on the screen; 
‒  move the drawing or its fragment on the screen.  
The easiest way to control the screen is in two ways: 
‒  and using the middle mouse button-wheel button. When you rotate the wheel away from you, the 

image on the screen increases, and when you rotate it towards you, it decreases. If you move the mouse 
while holding down the scroll wheel button, the image moves across the screen; 

‒  using buttons 1-4 on the standard toolbar (Figure 1.11). 
 

 

Fig. 1.11. Screen control buttons  

Buttons 1-4 in Figure 1.11 perform the following functions: 
1 ‒ the «Live Pan» (Панорамування в реальному часі «Панорамирование в реальном времени»)  

button moves the drawing on the screen when you move the mouse (the left mouse button is pressed, and 
the cursor takes the shape of a palm); 

2 ‒ the «Zoom in real time» (Зуммування в реальному часі «Зуммирование в реальном времени») 
button smoothly increases or decreases the drawing fragment by moving the cursor vertically up (increases) 
or down (decreases); 

3 ‒ the «Show Frame» (Покажи Рамка «Покажи Рамка»)  button changes the size of the visible 
part of the drawing; 

4 ‒ returns the previous screen view (previous scale). 
To change the size of the visible part of the drawing, use the ZOOM  (Покажи «Покажи») 

command. 
You can perform all of these screen changes with a trackball mouse. 
A wheel-button mouse is a two-button mouse with a small wheel-button between the buttons. The 

functions of the left and right buttons are the same as those of a standard mouse. The wheel can only be 
rotated in discrete increments. You can use the mouse wheel to zoom in and out of the drawing without 
using commands.  

By default, the zoom factor is set to 10 percent, and each one-digit incremental rotation of the mouse 
wheel causes a 10 percent change in the on-screen magnification factor. The ZOOMFACTOR system 
variable determines the sensitivity of commands to one discrete step of mouse wheel rotation (forward and 
backward). The larger the value, the greater the sensitivity.  

The following table shows the mouse operations supported by the program.  
 

For….  
 

It is necessary  

to change the on-screen 
magnification  

 turn the jog wheel forwards (to increase the factor) or backwards (to 
decrease the factor)  

to display the image within the 
drawing,  

press the wheel button twice  

panning 
move the cursor in the desired direction by holding down the wheel-
button 

joystick panning 
move the cursor in the desired direction by holding down the CTRL key 
and the wheel button 

call the object snap context 
menu 

assign the value 0 to the MBUTTONPAN system variable and click the 
wheel button 



17 

AutoCAD can restore up to 10 previous views in sequence. This number includes views obtained not 
only when zooming, but also when panning. The SHOW (Показать «Показать») command with the 
Previous (Попередній «Предыдущий») option restores only the on-screen magnification and position of 
the view, not the previous content of the drawing being edited. 

1.10. Finishing and saving the drawing  

You can save drawings or selected objects in the same way as in other applications. You can also 
manage auto-save operations and file backups. 

When working with a drawing, it is recommended to save it periodically. This will help to avoid data 
loss in the event of unforeseen situations, such as a power failure. 

The file name extension for drawings is .dwg. Until the user changes the file format, the drawings 
are saved by default in the last specified format. By default, the program creates a backup copy of the 
previous version of the drawing folder each time it is saved. Advanced users prefer to use the backup 
function. 

If you need to revert to a previous version of the file, you can rename the file with the .bak extension 
in the drawing folder and specify .dwg as the extension. 

By default, the program automatically saves the drawing 10 minutes after the last save. You can 
increase or decrease the interval between auto-save operations or disable auto-save. 

The first time you save a new document to a file, AutoCAD prompts you to rename it and allows 
you to select or create a folder in which to save it. It's best to save project-specific files in their own folder 
with a corresponding name. 

1.11. Graphical drawing primitives and commands for creating them 

Types of primitives  
 

AutoCAD drawings are built from a set of graphic primitives, which are drawing elements that are 
treated as a whole, rather than as a collection of points or objects. Drawing commands create graphic 
primitives and are found on the Draw drop-down menu. 

Primitives can be simple or complex. 
Simple primitives include the following objects: point, line, arc, circle, line, ray, ellipse, spline, and 

text.  
Complex primitives include: polyline, multiline, multitext, size, indentation, tolerance, hatching, 

block or external link inclusion, attribute, and bitmap.  
Any command can be called in one of three ways: 
1. Left-click on the corresponding icon on the toolbar. 
2. Left-click on the corresponding item in the drop-down menu. 
3. Enter the name of the command in the command line (either in uppercase or lowercase letters). 
In AutoCAD, each subsequent command can be used only after the previous command has been 

completed. The AutoCAD system is ready to work with the next command when the command line prompt 
looks like Command: 

It should be noted that regardless of the method of entering commands, you need to constantly 
monitor the command line to see the system's response and requests (options) and enter additional 
information (numeric value, keyword, point coordinates, etc.). 

Note.  It is further recommended that you note that the drawing, editing, and drawing 
commands, keys, and queries for these commands are mostly in English, with translations provided in 
parentheses. 

 
Point 

 

A point is entered by using the «Point» («Точка») command or by specifying two-dimensional (3D) 
coordinates or by clicking the mouse. A single command will enter points repeatedly until the <Esc> key 
is pressed.  



18 

By default, the point is displayed as a dot (.) on the screen, and it is not very visible in the drawing. 

You can make the point appear as a +, . , O, □ or any other symbol available by choosing Format→Display 
Points. In the dialogue box that opens (Figure 1.12), select the desired style of point display. Here you can 
also set the size of the point symbol. 

 

 

Fig. 1.12. The «Display points» (Відображення точок «Отображение точек») dialogue box 

From the «Drawing» menu, select «Point», or from the «Drawing» panel, select the corresponding 
button (left-click). 

«Point» (Точка «Точка»)  - calling the command  
The command appears on the command line: 
Command: Point : (set the coordinates of the point) 
Exit the command ‒ the key <Esc>. 
The PDMODE command can be used to change the type and the PDSIZE command to change the 

size of the marker. You can view the valid types of markers by using the VSLIDE command with the 
response «POINTS». 

You can also change the type and size of the point marker by calling the window from the Format 
menu  «Point Display», in which you can select the required type of point marker. 

 

Line 
 

You draw a line with the «Line» (Відрізок «Отрезок») command. 
Lines are the simplest objects in AutoCAD. They can be single segments or can be joined by 

endpoints to form a broken line. Each line( segment) is an independent AutoCAD object, even if it is part 
of another object.  

Draw Lines of a given length 
From the «Draw» menu, select «Line» or from the «Draw» panel, select the corresponding button 

(left-click) . 
«Line» (Відрізок «Отрезок») - calling the command 
The command appears on the command line: 
Line From point:   left-click on the screen 
To point(Specify the end point): @(length of the segment along the OX-axis, length of the segment 

along the OY-axis) 
Exit the command: right-click. 
Example.  Draw a rectangle with sides 5x10 mm. 
To do this: from the «Drawing» panel, select the «Line segment» button 
On the command line : 
Line From point:   left-click on the screen  (point 1) 
To point(Specify the end point): @5,0   (to point 2) 
To point(Specify the end point): @0,10   (to point 3) 
To point(Specify the end point): @-5,0   (to point 4) 
To point(Specify the end point): @0,-10  (close at point 1) 
Exit the command: right-click. 
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Loading the line type 
1. Choose «Line Types» from the «Format» menu or click the corresponding button in the «Object 

Properties panel». 
2. In the «Line Type Manager» dialog box, click the Load button (Figure 1.13). 
3. In the «Load/Reload Line Types» dialogue box, select a line type from the «Available Line Types 

list». Then click «OK» (Figure 1.14). 
 

 
 

Fig. 1.13. The «Line types manager» (Диспетчер типів ліній «Диспетчер типов линий») window 

 
Fig. 1.14. Selecting a line type from the  «Available line types»  

(Доступні типи ліній «Доступные типы линий») 
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4. The line type selected from the list is added to the list of line types in the «Line Type Manager» 
(Диспетчер типів ліній «Диспетчер типов линий») window. If you stand on it, you can make it active 
by clicking the «Current button» (Поточний «Текущий»)  (Figure 1.15). 

 

 

Fig. 1.15. Making the selected line type active 

5. Click the «OK» button. 
The line type selected from the list is also added to the «Line Types» drop-down list in the «Object 

Properties» (Властивості об'єктів «Свойства объектов») panel (Figure 1.16). 
 

 

Fig. 1.16. Selected line type in the «Object Properties» panel 

Example. Draw a dashed line with a length of 100 mm. 
1) switch on the «ОРТО» mode; 
2) to draw a dashed line, you need to: 
‒ in the object properties line of the «Properties panel», select «Line Types» and choose a dashed 

line if it is in the list. Otherwise, click «Other...» in the same window or choose «Line Types» from the 
«Format» menu; 

‒ in the «Line Type Manager» window, click the «Load» button; 
‒ in the window that opens, select the required line type and click OK; 
‒ place the cursor on the selected line type, click the «Current» button and «OK»; 
3) then select «Line» from the Drawing menu or from the Drawing panel; 
in the command line: 
Line From point (Specify the point 1): left-click on the screen 
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To point (Specify the end point): 100 (set the length of the segment and move the cursor in the 
desired direction) 

Exit the command: right-click or press the <ENTER> key.  
 

Drawing curved objects 
 

Drawing arcs 
 

An arc is drawn with the «Arc» (Дуга «Дуга») command. Since an arc is part of a circle, you must 
use both circle and arc parameters to draw an arc (Figure 1.17).  

AutoCAD provides a wide range of methods for drawing arcs (Figure 1.18).  

 

Fig. 1.17. Arc parameters 

You can draw arcs in different ways. By default, the arc is drawn by specifying three points: start, 
intermediate, and end, and the arc is drawn counterclockwise. You can also define the arc by specifying the 
centre angle, radius, direction or chord length using the «Drawing» drop-down menu. 

 

 

Fig. 1.18. Ways to create arcs 

«Arc» (Дуга «Дуга»)  ‒ calling the command 
Keys: 
Center (Центр «Центр»): 
Start point (Початкова точка «Начальная точка»): 
End point (Кінцева точка «Конечная точка»): 
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Angle (Кут «Угол»): 
Length of chord (Довжина хорди «Длина хорды»): 
Radius (Радіус «Радиус»): 
Direction (Напрям «Направление»): 
Drawing an arc from three points 
1. From the «Draw» menu, select «Arc» > «3 Points» or click the «Arc» button from the toolbar. 
2. Left-click the start point. 
3. Select the second point by left-clicking. 
4. Specify the end point. 
5. ENTER 
Example. Draw an arc from three points. 
To do this: From the «Drawing» panel, select the «Arc» button or  
choose «Arc» from the «Drawing» menu. 
In the command line: 
Centre/<Start point>:  50,30  (start point 1) 
Centre/End/<Second point>: 60,20  (second point 2) 
End point:   35,15  (end point 3). 
 
Example. Draw an arc by the start point, centre and angle. 
To do this: From the «Drawing» panel, select the «Arc» button or 

choose «Arc» from the «Drawing» menu. 
In the command line: 
Center/<Start point>:   30,20  (start point 1) 
Centre/End/<Second point>:  C(Ц)  (set the centre) 
Centre:      50,30  (coordinates of the 

centre - point 2) 
Angle/Lengt of chord/<End point>: A(У) (specify the angle) 
Included angle:    80  (angle size). 
 

Drawing a circle 
 
A circle is one of the most common objects in drawings. You draw a circle with the «Circle» (Коло 

«Круг») command. AutoCAD provides 6 ways to draw a circle (Figure 1.19): 
 

 

Fig. 1.19. Methods of drawing a circle 

1. At the given centre and radius of the circle.  
2. Given the centre and diameter of a circle.  
3. By two points (2P (2Т)). Drawing a circle by two given points that lie at the ends of the diameter.  
4. Given three points that do not lie on the same line (3P (3Т)). 
5. Given two points - tangents and a given radius (TTR (ККР) ‒ 2 points of touching, radius). The 

essence of this method is that a circle is drawn that is tangent to two other objects, for example, a segment 
and another circle that are already on the drawing (Figure 1.20, a). First, you need to set any point on the 
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first object (line) ‒ the Delayed Tangent (Затримана дотична «Задержанная касательная») marker 
will appear, then sequentially set any point on the second object (circle) - the Delayed Tangent marker will 
also appear on it.  

When prompted, specify the required radius of the circle and press <Enter>.  
You can draw many circles tangent to two objects, and which will differ in their radii (circles 1, 2, 3 

in Figure 1.20, a). 
6. By three tangents. This method is similar to the 3P (3Т)method, except that the points are the 

points of contact with the specified objects (Figure 1.20, b). Here, too, the Delayed Tangent marker appears 
when you specify objects. 

 
 

         a    b 

Fig. 1.20. Examples of circle construction using the  
2 points of touching, radius (2 точки дотику, радіус «2 точки касания, радиус»)  

method and three tangents: 
a ‒ a circle that is tangent to two other objects, b ‒ a circle that is tangent to three other objects 

«Cercle» (Коло «Круг») –  calling the command 
Keys:  
2P (2T) ‒ draws a circle at 2 points on the diameter. 
3P (3T) ‒ draws a circle from 3 points on the circle. 
TTR (ККР) ‒ Draws a circle using 2 tangents and a radius. 
Centre point («Центр») ‒ The point of the centre. 
 
Example. Draws a circle with the given centre and radius. Center at 

the point 40,20; radius = 20 mm. 
To do this, select the «Circle» button from the «Drawing» panel or 

select «Circle» from the «Drawing» menu. 
In the command line: 
3P/2P/TTR/<Centre point> (3T/2T/ККР/<Centre point>): 40,20 
Radius/<Diameter> (Circle radius or [Diameter]):  20 
To exit the command:  right-click. 
 
Example. Draw a circle using two points of diameter. 
To do this: from the «Drawing» panel, select the «Circle» button or  
 from the «Drawing» menu, select «Circle.» 
In the command line: 
3P/2P/TTR/<Centre point> (3T/2T/ККР/<Centre point>): 2P(2T) 
First point on diameter:   50,20   (point 1) 
Second point on diameter:  30,15   (point 2) 
Exit the command:  <ENTER> or right-click. 
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Example.  Draw a tangent circle to the other two circles. 
First, prepare two circles of smaller radius using the examples above. 

Then draw the third circle, which will be tangent to the first two circles. 
To do this, select the «Circle» button from the «Drawing» panel or 

choose «Circle» from the «Drawing» menu. 
At the command line : 
3P/2P/TTR/<Centre point> (3T/2T/QCD/<Centre point>): 

TTR(«KKР») (tangent to the other two primitives) 
Tangent to two primitives:  (specify the target on 1 circle) 
Enter second Tangent spec: (point to the target on the 2nd circle) 
Radius:    80 
Exit the command:  right-click. 

 
 

Drawing an ellipse 
 

An ellipse is drawn using the «Ellipse» (Еліпс «Эллипс») command.  
By default, ellipses are drawn by specifying two endpoints on the first axis and a third point that 

defines the distance from the centre of the first axis to the edge of the ellipse, which is half of the second 
axis (Figure 1.21). The first axis can be drawn at any angle to the horizontal.  

Another way to create ellipses is to specify the coordinates of its centre and the dimensions of its two 
semi-axes. The Rotation parameter sets the ratio of the axes of the ellipse by rotating the circle about the 
first axis. The greater the rotation angle A, the greater the ratio of the minor axis to the major axis. Rotation 
angles with values from 89,4 to 90,6 degrees are not allowed, because the ellipse will look like a straight 
line in this case. Values that are multiples of these rotation angles result in a mirror effect every 90 degrees. 

 
 

 
Fig. 1.21. Parameters for creating an ellipse 

«Ellipse» (Еліпс «Эллипс»)  calling the command. 
Keys: 
Arc (Дуга «Дуга») allows you to draw elliptical arcs 
Center (Центр «Центр») – The centre of the ellipse 
Rotation (Поворот «Поворот») – the angle of rotation of the 

second axis 
Example.  Construct an ellipse along two semi-axes. 
To do this: from the «Drawing» panel, select the «Ellipse» button or from the «Drawing» menu, 

select «Ellipse» 
In the command line : 
Centre/<Axis endpoint 1>:   30,10 (1 point of the ellipse axis) 
Axis endpoint 2:    50,30  (2nd point of the ellipse axis) 
<Other axis dictation>/Rotation: 10  (size of the other half of the axis). 

 
Drawing polylines 

 
A polyline is drawn with the «Pline» (Полілінія «Полилиния») command. A polyline can be closed 

or open. Polylines are useful for creating three-dimensional objects. 
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A polyline is a connected sequence of segments. All these segments are a single object. Polylines 
can consist of linear and arc segments, as well as any combination of them. Polylines are used when you 
want to work with a set of segments as a whole. In a polyline, you can change the width and curvature of 
the segments.  

The created polylines can have different widths, which is set by the Width and Half Width keys. You 
can set a different width for each segment; in addition, segments can be narrowed or widened if the widths 
at the start and end points are different. These options are available after you specify the start point when 
you draw a polyline. 

The Width and Half Width keys specify the width of the next segment of the created polyline. If you 
specify a value of 0, a thin segment with zero width is drawn. Any non-zero positive width values result in 
the creation of wide lines that are displayed as shaded or as contours, depending on the state of the shading 
mode. The Half Width key specifies the distance from the centre line of a wide polyline to its edge.  

«Pline» (Полілінія «Полилиния») ‒ calling the command. 
Keys: 
Half–width (Напівширина «Полуширина»)  ‒ The distance from the centreline of the wide polyline 

to the edge of the polyline  
Width (Ширина «Ширина») ‒ The width of the next segment. You are prompted for the start and 

end widths 
Undo (Відмінити «Отменить») ‒ to cancel the last segment 
In segment creation mode: 
Keys: 
Arc Arc (Дуга «Дуга»)  ‒ switch to arc mode 
Сlose (Замкни «Замкни»)  ‒ to close the segment. 
Length (Довжина «Длина»)  ‒ the length of the segment as a continuation of the previous segment 

in the same direction. 
In arc mode: 
Angle (Кут «Угол»)  ‒ centre corner 
Center (Центр «Центр»)  ‒ centre of the arc 
Сlоsе (Замкни «Замкни»)  ‒ Close the arc 
Direction (Напрям «Направление»)  ‒ direction 
Line segment (Відрізок «Отрезок») ‒ Switch to line mode 
Radius (Радіус «Радиус»)  ‒ the radius of the arc 
Second point Друга («Вторая»)  ‒ Second point of the arc 
The following features of a polyline can be noted in comparison with simple primitives:  
‒ a polyline is a single object that can be conveniently used for deletion or editing operations (for 

example, drawing a parallel line);  
‒ a polyline is convenient for drawing bold lines in a drawing;  
‒ the variable width of the polyline segments can be used for graphic effects (arrows, etc.).  
 
Example. Draw a broken line with the line thickness set. 
In the «Drawing» panel, click the «Polyline» button or choose «Polyline» from the «Drawing» menu. 
On the command line: 
Pline (Полілінія «Полилиния») 
From point:  40,10  (Point 1)  
Arc/Cl/…/Width: W(Ш)   
Starting width:  0.5    
Ending width:  0.5     
Arc/Cl/…/Width:50,12  (Point 2) 
Arc/Cl/…/Width:W(Ш)   
Starting width:  3     
Ending width:  0     
Arc/Cl/…/Width:60,14  (Point 3) 
Arc/Cl/…/Width: <ENTER>  
 
 



26 

Example. Draw an arrow using a polyline. 
In the «Drawing» panel, click the «Polyline» button or choose «Polyline» from the «Drawing» menu, 

turn on the <ОРТО> mode. 
On the command line  
Pline (Полілінія «Полилиния») 
From point (Початкова точка «Начальная точка»): Click on the screen and specify the direction 

of the arrow (Point 1) 
Arc/Cl/…/Width (Наступна точка або [Дуга/.../Ширина] «Следующая точка или 

[Дуга/…/Ширина]»): W(Ш)  (Select width) 
Starting width: 0 (Initial width) 
Ending width: 2 (Final width) 
Arc/Cl/.../Width (Next point or [Arc/.../Width]): 5 (Set the arrow length, point 2 appears) 
Arc/Cl/.../Width (Next point or [Arc/.../Width]): W(W) (Select width) 
Starting width: 0 (Initial width) 
Ending width: 0 (Final width) 
Arc/Cl/.../Width (Next point or [Arc/.../Width]): 10 (Set the length of the segment, point 3 appears) 
Arc/Cl/.../Width (Next point or [Arc/.../Width]): <ENTER> (Exit). 
 

 
 

Spline  
 

A spline is formed by specifying all the points to be smoothed with the «Spline» (Сплайн «Сплайн») 
ine command. The spline can be closed, building a smooth curve according to the specified defining points 
and the direction of the tangents at the start and end points. It can be used to approximate curves that require 
a lot of labour to draw accurately. For example, complex lines of intersection of bodies can be drawn using 
splines. In a traditional (paper) drawing, several nodal points (from 3 to 7) are drawn using precise methods 
(e.g., descriptive geometry), and templates are used to construct the entire curve. In Figure 1.22 a hyperbola 
and a parabola are created from the given points using a spline. Splines are also used to draw curves of any 
shape. 

 

 

Fig. 1.22. Splines  

«Spline» (Сплайн «Сплайн») ‒ calling the command 
Keys: 
Object (Об'єкт «Объект») - converts a smoothed polyline to an equivalent spline 
Fit Tolerance (Допуск «Допуск») - if the value is zero, the spline passes through the specified points, 

if it is positive, it passes through the specified deviation. 
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Multiline 
 

You can draw a multiline with the «Mline» (Млінія «Млиния») command. 
A multiline is a multi-line line that contains from 2 to 16 equidistant line segments. Multiline allows 

you to quickly draw walls on plans and sections of buildings. 
 

Creating and editing with «handles» 
 

Draw a multiline that contains two lines with a distance of 200 mm between them. This can be a wall 
outline on a building plan. The width of the line (wall) is set by the Scale option: 

«Mline»  / Scale / 200 / specify a start point / move the cursor to the side ‒ a double line will follow 
the cursor / specify a second point / draw several segments of the multiline. 

Draw multilines with the «ОРТО» mode enabled. Start building from the left point of the contour 
(Figure 1.23, a), going around the contour clockwise: 

«Mline»  / build a contour, setting the dimensions to eyeball scale. Close the drawing with the Close 
option. 

You can edit the multiline by moving the «handles» that appear when you specify the multiline: 
‒ point to the constructed line – «handles» appear; 
‒ turn on the End object snap and the object tracking mode (F11); 
‒ by moving the «handles» in the object tracking mode, change the contour view as in the examples 

(Figure 1.23, b, c); 
‒ F2 ‒ display the text window and consider the list of current parameters  
Location = Top, Scale = 20, Style = STANDARD. commands. 
The list shows the current settings: 

 
               а         b       с 

Fig. 1.23. Multiline contour:  
a – initial, b, c – after editing with «handles» 

Editing properties 
 

Basic properties of a multi-line: Line Weight, Scale, Fill Colour, Line Type Scale, Location - can be 
edited in the «Properties» dialogue box: 

- select the multiline and right-click / select Properties from the context menu / change the parameters 
of the selected line, for example, assign a new Line Weight and Multiline Scale, Location. 

There are a number of significant restrictions on editing a multiline. You can't edit the parameters 
specified by the multiline style: the number of line segments, their offset, ends and joints, and a number of 
others. The multiline style itself cannot be edited if the file contains at least one line of this style. You 
cannot assign a different style to a created multiline. 

Another limitation is that the weight and layer of a multiline is set to the same value for all its 
segments. If you need to set these parameters separately, you'll need to split the line into segments. In this 
case, the special properties of the multiline are lost. 

 
Editing intersections 

 
Multiline editing is performed with the Mledit command: 
Multiline editing is performed with the «Mledit» (Млред «Млред») command: 
«Mledit» or double-left-click on any multiline opens the «Multiline Editing Tools» («Инструменты 

редактирования мультилиний») dialogue box (Figure 1.24). 
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Intersection editing involves cross, tie, or angle joints. When editing, the sequence and location of 
the marks are important. 

The Multiline editing command also allows you to delete and add vertices and breaks. 
 

 

Fig. 1.24. Multiline editing tools window 

Multiline style 
 

The style is set with the «Mlstyle» (Млстиль «Млстиль»), command, which allows you to create 
multilines for different purposes. The multiline style determines the number of lines included in it, the 
distance between the lines, the type and colour of each line, the fill, the ends and joints of the lines. 

Let's create a new style based on the STANDARD style (Figure 1.25, a, b): 
‒ «Multiline Style» / in the «Multiline Styles» dialogue box, click the «Create» button / in the next 

«Style Creation» window, enter a name for the new style, for example, 1 
Continue ‒ the new style parameters window opens (Figure 1.25, a).  
  

 

Fig. 1.25. Style settings window:  
a ‒ style settings window, b ‒ example style, c ‒ «Load-bearing wall» style 
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The STANDARD style element list contains two lines. The offset of each line from the conditional 
axis is 0.5 units. This means that the distance between the lines is one. So, when you assign a line scale, 
you set a new distance between the lines. 

Change the parameters of the new style (Figure 1.25, a): 
‒ Specify Add ‒ a new element with an offset of 0 appears in the list. If you do not change the offset, 

the coordinate axis of the wall will be crossed out; 
‒ Line type ‒ change the type of the added line to an axial dashed line; 
‒ in the Ends group of settings(Торцы), check the Segment: End; 
‒ Set the fill colour to yellow, for example; 
‒ tick the Show joint checkbox; 
‒ If you have any questions during the setting, click the Help button; 
‒ OK to finish setting the style; 
‒ in the «Multiline Styles» window, click Set / OK ‒ the style is created and set by default; 
– «Mline» / draw a line with a new style (Figure 1.25, b). 
Compare the parameters of the drawn line with the style settings: centreline, open start and closed 

end, fill, and link joints. 
‒ In the Properties window, edit the stroke length of the centreline.  
 

Copying a style 
 

The style is saved in the file where it was created. It can be transferred to another file when copying 
a multiline through the memory buffer. You can save a style to a special external file with the .mln 
extension. In this case, the style becomes publicly available. 

Exercise. Save the style of the external walls to an external file by placing it in your working folder: 
‒ «Multiline Style» / in the Multiline Styles dialog box, select Save / in the Save Multiline Style 

window, open the working folder / name the new style / OK. 
You can save all the created styles in one file. In the future, the saved style can be loaded into any 

dwg file. To load a style: 
‒ «Mlstyle» / in the «Multiline Styles» dialogue box, select Load / find the style file / specify the 

style name / OK / Install / OK. 
Теxt 

 
You can define set different types (styles) of text in AutoCAD. 
Use the Format drop-down menu to open the Text Styles window, or type the Style command at the 

command line. 
«Text» (Текст «Текст») ‒ calling a command 
Queries: 
Text style name(or?) (Ім'я текстового стилю «Имя текстового стиля») 
Specify full...( Вкажіть повне ім'я шрифту або ім'я файлу «Укажите полное имя шрифта или 

имя файла») 
Height (Висота «Высота») ‒ sets the height of the area that includes the letter 
Width factor(Ступінь стиснення-розтягування «Степень сжатия–растяжения»)  ‒ Sets the 

scale factor 
Obligating angle (Кут нахилу «Угол наклона») ‒ The angle of the text relative to the norms: positive 

to the right, negative to the left. 
Back wards? (Праворуч наліво? «Справа налево?»)‒ sets the text in reverse order 
Upside-down?(y/n) (Перевернутий? «Перевернутый?») ‒ set the text upside down 
Vertical?(y/n)( Вертикальний? «Вертикальный?»)  ‒ Write letters one above the other. 

 
Single line text  

 
The «Text» (Текст «Текст») command creates a single-line text object. When you call the 

command, a simplified version of the block occurrence editor opens, which is a bounding box with a text 
height that increases in size as you type. 
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The command is designed to create a set of lines located one below the other. You can move to the 
next line by pressing the <ENTER> key. Each line is a separate object that can be moved and formatted. 

The «Text» command can be accessed from the «Drawing» → «Text» → «Single line menu». 
Queries: 
Justify/Style/<Start point (Вирівнювання/Стиль/<Початкова точка «Выравнивание/Стиль/ 

<Начальная точка»>  
<Enter> or Space ‒ to move the carriage directly under the previous character 
Height(Висота ‒ determines the height of uppercase letters 
 Rotation angle (Кут нахилу «Угол поворота») 
Text-enters text. 
Setting a text style when creating a single-line text:  
1. Click Draw → Text → Single line.  
2. Enter s (style).  
3. At the Style Name prompt, type the name of the existing text style.  
To get a list of text styles, you can type a question mark (?), then press <ENTER> twice.  
4. Continue creating the text.  
Set the alignment mode for single-line text:  
5. Click Draw → Text → Single line. 
6. Enter s (Style).  
7. Set the alignment mode. For example, type v (вв) to align the text up and left.  
8. Continue drawing the text.  
Create a single-line text  
9. Click Draw → Text → Single line. 
10. Specify the insertion point of the first character. When you press the <ENTER> key, the 

program will place the new text directly under the text object created last (if any).  
11. Set the height of the text. The height prompt appears if the current text style has a zero height.  
The text insertion point and the cursor are connected by a line.  
12. Set the text rotation angle.  
13. You can set the angle by entering a numeric value or by using a pointing device. 
14. Enter a line of text. Press <ENTER> at the end of the line. If necessary, enter additional lines.  
15. If you specify a different insertion point, the cursor moves to the specified position, and you can 

continue typing. Each time you press <ENTER> or specify a point, a new text object is created.  
16. To end the command, press <ENTER> on an empty line. 
 
Note.  The AutoCAD system has the ability to include special symbols in the text string, such as 

a diameter icon, a degree symbol, a tolerance icon, plus or minus, etc. This is done with the help of 
special control codes. They should be entered directly when typing - they will be automatically replaced 
with the appropriate characters. Special symbols must be entered in the form of control sequences in 
English, each of which begins with two percentage symbols «%%». 

For example, the following control sequences are possible (to be entered in English only): 
%%d - special symbol for degree   (º)  (45º → 45%%d) 
%%c - special symbol for diameter  (Ø)  (Ø20 → %%c20) 
%%p - special tolerance symbol   (±)  (±2 → %%p2). 
%%u - special underline symbol   (text) 
%%% - special percentage symbol  (%)  (100% → 100%%%) 
 
Example.   Set the text style. 
To do this: 
- from the «Format» menu, call «Text Style» (Текстовий стиль «Текстовый стиль») (Figure 1.26) 
‒ the Text Styles window appears on the screen (Figure 1.27); 
‒ click on the «New» tab in the window that appears, name the new text style «Size» (Figure 1.27). 

After that, in the «Text Style» window, you need to (Figure 1.28): 
‒ in the «Font name» area, select the font type «txt.shx»; 
‒ in the «Height» area, select the font height, for example, 6; 
‒ in the «Degree of stretch» area, leave the value 1; 
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‒ in the «Slope angle» area, select the angle of the letters to be 15; 
‒ click the «Apply» button. 
The text style is now selected and active. 
 

 

Fig. 1.26. A fragment of the text style call window 

 

Fig. 1.27. Naming a new text style 

 

Fig. 1.28. Setting the text style 
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Multi-line text  
 

The «MTEXT» (МТЕКСТ «МТЕКСТ») command allows you to create text consisting of several 
text lines or paragraphs, fitted into a user-specified paragraph width. The number of lines is not limited. 
The entire multi-line text is a single object that can be moved, rotated, erased, copied, mirrored, stretched, 
and scaled. 

The possibilities for editing multi-line text are wider than for single-line text. In particular, for multi-
line text, the text editor built into AutoCAD is used, which allows you to form not only entire phrases, but 
also individual words and letters. It even has a spell checker. Working in this editor is absolutely identical 
to working in any text editor (for example, WORD).  

Multiline text «MTEXT»  consists of one or more paragraphs that behave as a single object when 
manipulated.  

You can enter one or more paragraphs of multiline text in the text editor used at the point of editing, 
in an alternative text editor, or on the command line. You can also paste text from .txt and .rtf files.  

Before you can type or import text, you must set the border to the paragraph width of multi-line text. 
Unlike the width, the length of the text is not determined by the border, but depends only on the size of the 
object's text data. You can use the handles to move and rotate multi-line text objects. 

The text editor used in the editing area is a window with a ruler at the top and a text formatting panel. 
The editor window is transparent, which allows you to control the position of the text you're typing relative 
to other objects. 

You can apply different formatting to multi-line text by changing the specified text style. The 
formatting affects only the selected text; the current text style isn't affected.  

You can set the font and size of the text, and you can change the type (bold, italic, underline) and 
colour. You can also set the angle, change the character spacing, and expand or contract symbols. 

The «MTEXT» command can be accessed from the «Drawing» → «Text» → «Multiline menu». 
Keys: 
Height (Висота «Высота»)  
Justify (Вирівнювання «Выравнивание») 
Rotation (Поворот «Поворот») 
Style (Стиль «Стиль») 
Width (Ширина «Ширина») ‒ the width of the paragraph 
After defining the parameters, the Multiline «Text Editor window» is displayed, where you enter the 

text (Figure 1.29). 
 

 

Fig. 1.29. The multi-line text editor window 

Create multi-line text 
1. Click «Draw»→ «Text» → «Multiline». 
2. Set the width of the multiline text area with a border.  
3. The text editor used at the editing location is displayed.  
4. To indent the first line of a paragraph on the horizontal ruler, move the First Line marker to the 

position where the text should begin. To indent other lines of the paragraph, move the «Paragraph marker» 
on the horizontal ruler.  
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5. To set the tab positions, click the mouse button in the desired places on the horizontal ruler.  
6. To set a text style other than the default one, expand the «Style» list in the Editor panel and select 

the desired style.  
7. Enter the text.  
8. Click OK in the «Text Format» pane. 

1.12. Editing graphic elements in a drawing 

After you start, AutoCAD prompts you to select objects. You can complete the object set by pressing 
the <ENTER> or <SPACE> key.  

There are two ways to edit in AutoCAD: you can either invoke the command first and then select the 
objects you want to edit, or you can select the objects first and then edit them. All editing commands are 
invoked from the «Modify» (Редагувати «Редактировать») drop-down menu or from the panel of the 
same name. 
 

Exploding objects 
 
The «Explode» (Розчленувати «Расчленить») command is used to split blocks into their 

component primitives. This command is called from the Edit drop-down menu «Modify» (Редагувати 
«Редактировать») or the panel of the same name. 

When exploding, single objects are transformed into a set of separate components. The command 
does not produce a visible effect. For example, polylines, rectangles, rings, and polygons are split into 
segments and arcs when exploded. The appearance of the splitted object remains the same, but the colors 
and line types of the objects may change as a result of floating colors, layers, and line types.  

Splitting dimensions and hatching. 
When you disassemble dimensions and hatching, the associative relationship between elements is 

lost, resulting in a set of simple objects such as segments, texts, and points. 
Splitting polylines. 
When you split a polyline, information about its width is lost. The resulting segments and arcs are 

placed along its centerline. 
Splitting blocks. 
When you split a block, attributes are removed from the block, but the original attribute descriptions 

are retained. The colors and line types of individual objects that are formed at the intersection of the blocks 
may change. 

Splitting external links. 
External references are drawing files that have been inserted from other drawings and that retain a 

link to their original description. External links and the blocks inherited from them cannot be dismembered. 
 

Deleting and restoring objects 
 
To delete (erase) the generated set of objects, use the «Erase» (Стерти «Стереть») command. The 

command is called from the «Modify» menu or the panel of the same name. You can select objects to be 
erased in any of the available ways, that is, by left-clicking on the object or selecting it with a cross-hatched 
frame. 

To restore deleted objects, use the «Oops» command. 
 

Object snapping 
 
When you enter points, you can use the geometry of objects that are available in the drawing. This 

input method is called object snapping. It allows you to precisely specify points such as the center of a 
segment or arc, the center of a circle, and the intersection of an arc and a circle. The Object Snap panel 
provides access to the object snapping functions. This panel contains the following buttons with brief 
explanations: 
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  Temporary Tracking Point (Точка відстеження «Точка отслеживания») ‒ use tracking with 
an intermediate point; 

 Snap From (Зміщення «Смещение») ‒ offset from another (auxiliary) point;  
 Snap to Endpoint (Кінцева точка «Конточка») ‒ the end point;  
 Snap to Midpoint (Середина «Середина») ‒ the midpoint;  

 Snap to Intersection (Перетин «Пересечение») ‒ the intersection point;  
 Snap to Apparent Intersection (Удаваний перетин «Кажущееся пересечение») ‒ the point at 

which the extension of two objects intersects;  
 Snap to Extension (Продовження лінії «Продолжение линии») ‒ the point of extension;  
 Center (Snap to Center) (Центр «Центр») ‒ the center of an arc or circle;  
 Quadrant (Snap to Quadrant) (Квадрант «Квадрант») ‒ a point in the quadrant of an arc or 

circle (these are points located at 0, 90, 180, and 270 degrees);  
 Snap to Tangent (Дотична «Касательная») ‒ the point of contact:  
 Snap to Perpendicular (Нормаль «Нормаль») ‒ perpendicular to the object;  

 Snap to Parallel (Паралельно «Параллельно») ‒ parallel to the object;  
 Snap to Insert (Точка вставки «Точка вставки») ‒ the point at which you insert text, a block, or 

an external link;  
 Snap to Node (Вузол «Узел») ‒ the node point;  

 Snap to Nearest (Найближча «Ближайшая») ‒ the point closest to the object;  
 Snap to None (Нічого «Ничего») ‒ without using object snapping;  
 Object Snap Settings (Режими прив'язки «Режимы привязки») ‒ sets up permanent snapping 

modes.  
To open the Object Snap Settings window, select Drawing Modes from the Tools menu or type the 

command at the command prompt: «Osnap» (Прив'яжи «Привяжи») and select the required settings. 
 
Example. Snap to the endpoints of the primitives. 
To draw the first segment: from the «Drawing» menu, 

select «Line» or from the «Drawing» panel, select the 
appropriate button (left-click). 

The command appears on the command line: 
Line From point (Вказати початкову точку 

«Указать начальную точку»):    
Click the Point icon in the Object Snap pane and type 1 
To point: Click the Point icon in the Geometry pane 
 and type 2 
To point: <ENTER, or right-click > 
To create other segments: do the same, but point to 3 and 4. 
 
Example. Draw a perpendicular from the point «P» to the three elements. 
First, you need to make the point visible. To do this, call the «Display Points» window from the 

«Format» menu and select the desired point marker. Then use the Point command to draw the point P, 
anchoring it to the middle of the segment. Then you can complete the task. 

LINE (Відрізок «Отрезок») ‒ command call 
From point: click the Node icon in the Object 

Linkage panel and specify 1 
To point: click the Normal icon in the Object Snap 

pane and specify 2 
To point: <ENTER> 
Repeat the same for the other elements. 
 
Example.  Draw two tangent lines to the circle 

from the point «P». 
LINE (Відрізок «Отрезок») – command call 
From point: click on the Node icon in the Object 

Snap panel and specify 1 



35 

To point: click on the Tangent icon in the Object Snap panel and specify 2  
To point: <ENTER> 
Repeat the same for the second tangent. 

 
 

Moving a set of objects 
 
You can change the position of objects by rotating and aligning them, as well as by moving them 

without changing their orientation and size. For precise movement, you can use step snapping, coordinate 
input, handles, and object snapping modes. 

To move objects, select the «Move» button from the «Modify» panel or choose «Move» from the 
«Modify» menu. 

In the command line : 
«Move» (Перенести «Перенести») – calling the command 
Select objects: select an object (with the selection box or by left-clicking on the object and selecting 

the object)  
Select objects: continue selecting an object if not everything is selected  
Select objects: at the end of the selection, right-click (end of selection) 
<Base point or displacement>/Mult:   specify the starting point  
Second point of displacement:   point to the new point where the object is moved  
 
Example. Move the circle (the base point of the move is the center of the circle) to the point «P». 
 

 
 
Call the transfer command. 
In the command line : 
«Move» (Перенести «Перенести») 
Select objects:  select the object (with a box or by clicking on the circle with the left mouse button) 
Select objects:  right-click (end of selection) 
<Base point or displacement>/Mult:   select the base point for the transfer, that is, click on the icon 

in the Object Snap - Center panel and specify 1 (circle) 
Second point of displacement: specify the new position of the base point, that is, select the icon in 

the Object Snap - Node panel and specify 2.  
 

Commands for propagating objects 
 

To create copies of an object in the current drawing, use one of the following methods: 
‒ if you want the copy to be located at an arbitrary distance from the original object, use the «Copy» 

(Копіювати «Копировать») command; 
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‒ if the copy should be located at a normal to the segments of the original object, use the «Offset» 
(Подоба «Подобие») command;  

‒ If you want the copy to be a mirror image of the original, use the «Mirror» (Дзеркало «Зеркало») 
command; 

‒ if the copies are to be arranged in ordered rows or in a circle, use the «Array» (Масив «Массив») 
command. 

«Copy» (Копіювати «Копировать») – a command that allows you to create duplicate objects within 
the current drawing relative to the specified base point and offset point.  

«Offset» (Подоба «Подобие») – is a command designed to copy objects by shifting them by a 
specified distance along the normal to each segment of the object. You can use this command to shift arcs, 
elliptical arcs, two-dimensional polylines, rays, infinite lines, as well as rings and ellipses. Shifting curved 
objects creates curves with larger or smaller diameters, depending on the direction of the shift. 

«Mirror» (Дзеркало «Зеркало») –  is a command that allows you to copy objects with a mirror 
image relative to an axis defined by two drawing points. When creating objects in mirror image, the original 
object data can be either saved or deleted 

«Array» (Масив «Масив») –  is a command that allows you to create groups of identical objects 
arranged in a certain order - in rows and/or columns, or in a circle. Such sequences of objects are called 
rectangular or circular arrays in AutoCAD, respectively. When you create a rectangular array, the number 
of copies you get in it is determined by the number of rows and columns, as well as the distances between 
them. When you create a circular array, copies of an object are arranged in a circle centered at a certain 
point. 

 
Copying objects 

 

You can repeatedly copy objects one by one or in groups within the current drawing; you can also 
copy between different drawings and applications.  

To copy objects within the same drawing, select the desired objects and then specify the start and 
end points of the copy vector. These points are called the start and end points, respectively, and can be 
located anywhere in the drawing. 

To copy a set of objects: 
1.From the «Modify» menu, choose «Copy», or from the «Modify» panel, choose the appropriate 

button. 
2. Select the objects you want to copy and press <ENTER>. 
3. Specify a base point using object snapping. 
4. Specify the second point of movement. 
5. Specify the next move point. Continue copying; press <ENTER> to finish. 
Example. Get two copies of the part drawing. 
«Copy» (Копіювати «Копировать») – calling the command. 
Select objects:  вибір об'єкта click the left mouse button (specify p.1)  
Select objects: right-click (end of selection) 
Base point: click with the left mouse button (specify p.2 ‒ select the base point) 
Second point of displacement: left-click (specify p.3) 
Second point of displacement: left-click (specify p.4) 
Second point of displacement:  <ENTER>. 
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Copying using the Windows clipboard. 
If you want to use objects from another AutoCAD drawing or from a file created in another 

application, you must copy those objects to the Windows clipboard and then paste them into the current 
drawing. Copy-and-paste operations using the clipboard are different from normal copying, where objects 
are copied from one point to another within the same drawing. 

Note.  When you paste an object into another drawing, it acquires the properties of the layer into 
which it is inserted (color, line type, etc.). 

 
Drawings of similar objects 

 
Command «Offset» (Подоба «Подобие») creates an object similar to an existing object with a given 

offset/ 
«Offset» – calling the command. 
Questions: 
Offset value or Point (Величина зміщення або точка <Через точку> «Величина смещения или 

Точка <Через точку>») –  offset or key <Through point>  
Select the object to offset (Виберіть об'єкт для зміщення «Выберите объект для смещения») – 

select the object to be shifted. Do not use a cross-sectional frame. 
Specify the point that defines the offset direction ‒ show the cursor in which direction to offset if an 

offset was specified.–   
If you select the <Through point> key, you need to specify the point through which the displaced 

object will pass. The specified distance must be greater than 0. 
Example. Draw a similar circle at a distance of 20 mm. 
To do this: from the «Modify» panel, select the «Offset» button or from the «Modify» menu, select 

«Offset». 
On the command line  
Offset distance…(Відстань від об'єкта «Расстояние от 

объекта»): 20 
Select objects to offset:  
Side to offset: point the cursor to the direction where a 

similar object will be created  
Select objects to offset:  repeat the operations for other objects 

in the other direction  
To leave the command: <ENTER>. 

 
Mirroring a set of objects 

 
Command «Mirror» (Дзеркало «Зеркало») provides the formation of mirror images of existing 

objects in the drawing. Objects are mirrored relative to the reflection axis defined by two points. After the 
operation, the original objects can be erased or left. Mirroring can be performed in any plane that is 
coincident with the XY plane of the current UCS. Although it is allowed to mirror the viewport in sheet 
space, this does not affect the view or objects in model space. 

«Mirror» – calling the command. 
Ouestions: 
Select the object (Вибір об'єктів «Выбор объектов»)  
The first point of the mapping axis (Перша точка осі відображення «Первая точка оси 

отображения»)  
Second point (Друга точка «Вторая точка»)  
Delete old objects? (Видаляти старі об'єкти? «Удалять старые объекты?») 
When mirroring, texts, attributes, and their definitions are also mirrored. To make the text resulting 

from mirroring look familiar, you need to assign the system variable MIRRTEXT a value of 0. To do this, 
enter the MIRRTEXT variable in the command line and enter 0 when prompted for a new value. By default, 
this variable is enabled. 
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Example. Create a symmetrical drawing using mirroring. 
On the command line : 
«Mirror» (Дзеркало «Зеркало») 
Select objects: 
Select objects: <ENTER> (all selected) 
First point of mirror line: point to 1 (tip/end) of the display 

line (конточку лінії відображення)  
Second point: point to 2(tip/end) of the display line 

(конточку лінії відображення) 
Delete old objects?:  N(Н)  (Do you want to delete the old image? If not, right-click. If yes, type 

Y(Да) and ENTER). 
 

Repeating a set of objects (array) 
 

Command «Array» (Масив «Массив») provides multiple copies of selected objects arranged in a 
rectangular or circular structure or along a trajectory. Objects arranged in this way are called a rectangular 
or circular array (Figure 1.30).  

For a rectangular array, you can specify the number of rows, columns, and levels of the array, the 
distance between rows and columns, and the angle of rotation of the array of objects relative to the 
trajectory.  

For a circular array, you define the number of objects, the center around which they will be located, 
the fill angle, and the method of filling the array - with or without rotation of objects.  

For an array, an arbitrary trajectory (2D or 3D trajectory) is selected, the number of objects, the 
distance between them, and the orientation of the objects are determined. 

 
 

 

Fig. 1.30 .Arrays 

Important! Remember that all elements of an array are perceived as a single object - an array. To 
be able to work with each element of the array separately, you should split the array into separate elements 
using the Explode command. 

 
«Array» – calling the command. 
Keys: 
Rectangular - defines a rectangular array by rows and columns; 
Circular - defining a circular array  
Questions for a rectangular array: 
Number of rows 
Number of columns 
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Distance between rows 
Distance between columns 
Questions for a circular array: 
Base/Center of array 
Number of elements 
Fill angle 
Rotation angle - objects are rotated relative to their anchor point according to the rotation of the 

array itself. 
Example. Create a rectangular array with 3 columns and 4 rows. 
To do this: from the «Modify» panel, select the «Array» button or from the 

«Modify» menu, select «Array» 
On the command line  
«Array» (Масив «Масив») 
The «Array» window opens (Figure 1.31) 
Select «Rectangular array» 
Rows: 4 
Columns: 3 
Between rows: 12 (distance between rows) 
Between columns:: 9 (distance between columns) 
Click Select objects: select an array element (rectangle) 
The Array window returns 
Click OK 

 

Fig. 1.31. The window for calling the «Array» command (Rectangular array) 

Example. Create a circular array centered at 35,210 in the amount of 6 with the angle of filling the 
array 270°.To do this: from the «Modify» panel, select the «Array»  button or from the «Modify» menu, 
select «Array» 

In the command line  
«Array» (Масив «Массив») 
The Array window opens (Figure 1.32) 
Select «Circular array» 
Center:    35,210 (center of the array) 
Number of elements: 6 (number) 
Fill angle:  270  (the angle of filling the array) 
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Click Select Objects: select the array element (small circle) 
The Array window returns 
Click OK 

 
 

 

Fig. 1.32. The window for calling the Array (Circular Array) command 

Rotating a set of objects 
 
The «Rotate» (Повернути «Повернуть») command changes the orientation of existing objects by 

rotating them around a specified point, called the origin. By default, a positive angle value rotates the object 
in a counterclockwise direction, and a negative angle value rotates the object in a clockwise direction. 

The base point can be anywhere in the drawing. The rotation angle determines how many degrees 
the object will be rotated around the origin. 

The «Rotate» command rotates a set of objects. 
«Rotate» ‒ command call 
Questions: 
Base point ‒ the center of rotation; 
Rotation angle ‒ sets the angle that determines the current position of the object 
Example. Rotate a set of objects by 45. 
On the command line:  
«Rotate» (Повернути «Повернуть»)  
Select objects:    (object selection) 
Select objects:   <ENTER> (all selected) 
Base point:     Point to the center of the turn 
<Rotation angle>/Reference: 45   (set the angle) 
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Scaling a set of objects 
 
Command «Scale» (Масштаб «Масштаб»)  allows you to resize the selected primitives 

simultaneously along the X, Y, Z axes according to the scaling factor. The scale factor multiplies the 
dimensions of the selected objects by the specified scale. A value of the scale factor greater than 1 enlarges 
the objects, and a value less than 1 reduces them. 

You can create a base point anywhere in the drawing. If the selected base point is on the selected 
object, it becomes the anchor point for scaling. 

«Scale» – calling the command. 
Questions: 
Selecting objects 
Base point - sets the center of scaling 
Scale - specifies the scaling factor.  
If the scale factor is greater than one, the object is enlarged, if it is less than one, it is reduced. 
Example. Make a drawing at a scale of 2:1. 
On the command line:  
«Scale» (Масштаб «Масштаб») 
Select objects:   
Select objects: <ENTER> (all selected) 
Base point:   :   Point to the center of the zoom  
<Scale factor>/Reference:  2  (increase by 2 times). 

 

 
 

Dividing an object into parts 
 
Command «Divide» (Поділити «Поделить») allows you to divide a primitive into a specified 

number of equal parts by placing marks along the object at the points of division. The selection of objects 
for division is carried out by direct indication. 

«Divide» – You can call the command from the command line and also from the Draw → Point → 
Divide drop-down menu. 

When you divide an object using a marker, a query is issued: 
Number of segments/Block: 
The marker image is defined in the «Format» → «Point Display» menu. 
To divide an object into parts using a block, use the Block key.  
In this case, requests are issued: 
Name of the block to be inserted: 
Example. Divide the arc into 6 equal parts. 
From the «Format» menu, choose «Point Display», and 

then set the type and size of the marker. Then: 
On the command line:  
Divide 
Select objects to divide:  вибір об'єкта 1 
<Number of segments>/Block: 6 (кількість сегментів) 
<ENTER>. 
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Breakdown of an object into its component parts 
 
To break an object into parts, you can use the «Break» (Розірвати «Разорвать») command. You 

can break a segment, circle, arc, polyline, ellipse, spline, line, or ray without erasing it or with erasing it. 
«Break» – calling the command. 
Questions: 
Select object 
Second point (або П для першої точки «или  П для первой точки»): 
If you use a direct pointing to select an object, it is assumed that the point used to select the object is 

the point of the break origin. If this is not the case, you must enter the «First» (Перша «Первая») key in 
response to the prompt.  

Example. Break the circle at points 1 and 2. 
To do this: from the «Modify» panel, select the «Break» 

button or from the «Modify» menu, select «Break» 
In the command line:  
Break  
Select objects: select a circle 
Specify second break point or (First point): F(P) to select the first point (point 1) 
Specify second break point: Specify the second break point (point 2). 

 
Trimming and extending lines 

 
The «Trim» (Обрізати «Обрезать»)  and «Extend» (Подовжити «Удлинить»)  commands are 

very similar. They allow you to trim an object (objects) with other objects intersecting it or extend it to the 
desired object (Figure 1.33).  

First, you need to specify the cutting edges (the object along which you want to cut or extend the 
object being edited), and then specify the object to be cut (extended) on the sides where you want to cut it. 

 

 

Fig. 1.33. Trimming and extending objects 

Trimming off a part of an object along a specified border 
 
The «Trim» (Обрізати «Обрезать»)  command partially erases a segment, arc, or polyline exactly 

along the cutting edge. 
«Trim» – calling the command. 
Questions: 
Select the cutting edges: - The trimming edges can be segments, arcs, circles, polylines, ellipses, 

splines, lines, rays. 
Select the object to be cut: - You must specify the part of the object to be deleted. 
If the selected object is not intersected by any cutting edge, a message is displayed: 
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«Object does not intersect an edge» 
 
Example. Cut off the parts of the circle that are outside the 

rectangle. 
To do this: from the «Modify» panel, select the «Trim» 

button or from the «Modify» menu, select «Trim» 
In the command line:  
«Trim» 
Select objects:  cutting edge, 1 and 2 
Select objects:  <ENTER>  (edge selected)  
Select objects to trim…: point to the areas of primitives to 

be deleted, 3 
Select objects to trim…:<ENTER>. 
 

«Extending» objects to the border 
 
Command «Extend» (Подовжити «Удлинить») extends existing objects to the boundary edge. You 

can extend the following primitives: line (segment), arc, elliptic arc, and polyline. 
«Extend» – call command. 
Questions: 
Select bounding edges: - edges can be segments, arcs, or polylines. 
Select the object to be extended: objects are selected by pointing to the part that is to be extended. 

Only direct pointing to the object is allowed. 
If you specify multiple bounding boxes, the object is extended until it reaches the first bounding box. 

You can select the same object again to extend it to the next bounding edge.  
Example: Extend objects (segments) to the specified border (arc). 
To do this, select the «Extend» button from the 

«Modify» panel or choose «Extend» from the 
«Modify» menu.  

On the command line  
Extend  
Select objects: select the border 
Select objects: <ENTER> (all selected) 
Select objects to extend...: sequentially specify 

the objects to be extended 
Select objects to extend...:<ENTER>. 

 
Drawings of connections 

 
Command «Fillet» (Сполучення «Сопряжение») is used to connect objects with an arc of a given 

radius. The command smoothly joins segments, arcs, circles, or linear segments of a polyline. 
When specifying objects for pairing, you cannot use a box. 
You can connect two circles, two arcs, a line and a circle, a line and an arc, or a circle and an arc, 

lines, rays, and ellipses. 
The radius of connection is the radius of the arc. By default, the connection radius is either 0 or the 

last value entered. Changing the radius only affects the subsequent fills, leaving the existing ones 
unchanged. The current connection radius is stored in the system variable FILLETRAD. 

To set the radius of the connection: 
1: From the «Modify» menu, select «Fillet», or from the «Modify» panel, select the appropriate 

button. 
2. At the question Enter connection radius: Enter the Radius key. 
3.Set the connection radius. 
4. Press ENTER to call the «Fillet» command again. 
5. Select the objects to be connected.  
This is how you configure the settings. The last entered pairing radius is memorized. 
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To connect two segments :  
1: From the «Modify» menu, select «Fillet» or from the «Modify» panel, select the appropriate 

button. 
2. Select the first segment. 
3. Select the second segment. 
The Polyline key means that the connection operation is performed with the entire polyline. A 

command appears to select a polyline: 
Select a 2-dimensional polyline: 
If the connection radius value is other than 0, the system inserts connection arcs at each vertex. 
You cannot create a connection for segments that are too short to be connected, or for segments 

that diverge in different directions. 
You can create a connection for equilateral segments, lines, and rays. In this case, the diameter of 

the arc of the connection is automatically determined equal to the distance between the lines. 
Example. Make a connection of segments 1 and 2 with a radius of 10 mm. 
To do this: from the «Change» panel, select the «Fillet» button or from the «Change» menu, select 

«Fillet» 
On the command line  
«Fillet» 
Select first objects or [Polyline/raDius/Trim/…]:D(Д) (setting 

the radius of connection) 
Enter fillet radius:  10  (enter the specified radius) 
Select first objects or [Polyline/raDius/Trim/…]: select the 

object 1 
Select second objects :    select the object 2. 

Drawing of chamfers 
 
Command «Chamfer» (Фаска «Фаска») performs the operation of trimming two non-parallel 

rectilinear objects at specified distances from their intersection point (chamfering), while building a new 
segment connecting the trimming points. The command is executed on both intersecting and non-
intersecting segments (the segments are first extended until they intersect). Chamfering can be performed 
on segments, polylines, lines, and rays.  

To determine the chamfer dimensions: 
Questions: 
First chamfer length: 
Second chamfer length: 
Keys: 
Polyline (Полілінія «Полилиния») – allows you to chamfer a polyline; 
Distance (Дистанція «Дистанция») – adjusts the chamfer length; 
Angle (Кут «Угол») – allows you to set the length for the first line and the angle relative to the first 

line for cutting the second line. 
Trim (Відрізати «Обрезать») – allows you to determine whether or not to trim lines before 

chamfering. 
Method (Метод «Метод») – allows you to choose one of the methods for setting chamfer 

dimensions - by distance or by distance and angle. 
If the point of intersection of objects is outside the drawing limits and limit control is enabled, 

chamfering is not performed. 
Example. Remove a 5x5 mm chamfer. 
To do this, select the «Chamfer» button from the «Modify» panel or choose «Chamfer» from the 

«Modify» menu. 
In the command line  
«Chamfer»  
Select…(…Polyline/Distance...):D(Д) (select the chamfer length) 
Enter first chamfer distance:  5  (first chamfer length) 
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Enter second chamfer distance:  5 (second chamfer length) 
Select…(…Polyline/Distance...):   (specify 1) 
Select second line:     (specify 2) 
Right-click and repeat the «Chamfer» command as many times as necessary: 
Select first line:     (specify 3) 
Select second line:     (specify 4 etc). 
 

 
 

Edit the text 
 
There are several options for editing text and its properties: 
‒ Command «Ddedit» or from the Modify → Object → Text → Edit drop-down menu allows you 

to edit the content of single-line text in the «Edit Text» dialog box. You can also double-click on the text 
you want to edit to access the «Edit Text» dialog box;  

‒ Command «Ddmodify» or the «Properties tool» on the «Object Properties» toolbar lets you edit 
text properties in the «Text» dialog box. 

 
Editing with the handles 

 
You can quickly edit selected objects using handles, small squares that appear at the defining points 

of the selected objects.  
To turn on the grips, use the «Ddgrips», command, or this command is called from the Tools → 

Setup menu. The Setup dialog box is displayed, in which you need to select the Select button (Figure 1.34). 
The parameters of the handles are set on this tab. 

 

 

Fig. 1.34. The «Setup» dialog box 
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Handle size ‒ an area that allows you to change the size of the handles by moving the pointer to the 
left or right. 

Handles ‒ an area that allows you to assign a color to the selected and unselected handles. 
To delete the handles, press the <Esc> key. 
When you work with handles, you select objects before editing them, and manipulate them using the 

mouse pointer or keywords. Some handles (shown in Figure 1.35) allow you to directly affect an object. 
The most convenient way to select the editing mode using handles is to use the handle context menu 

(Figure 1.36). The copy mode can be selected from the context menu ‒ «Copy» (Копіювати 
«Копировать»). The multiple copy mode remains active until another current handle mode is selected or 
the <Enter> key is pressed to complete the operation. 

To edit the entire primitive (or set of primitives) using the handles, you need to select this primitive 
(or set of primitives), right-click, and use the menu that appears to execute the following commands: 
«Erase» (Стерти «Стереть»), «Move» (Перемістити «Переместить»), «Copy Selected» (Копіювати 
вибрані «Копировать выбранные»), «Scale» (Масштаб «Масштаб»), «Rotate» (Повернути 
«Повернуть»). 

 
 

 

Fig. 1.35. Examples of primitives with handles 

 

 

Fig. 1.36. Context menu of the handle 



47 

Blocks also have handles. You can choose to connect a single handle for the block as a whole at the 
block insertion point, or handles for each individual object in the block. These options for block handles 
are also set on the «Selection» (Вибір «Выбор») tab of the «Customize» (Налаштування «Настройка») 
dialog box with the «Handles within block» (Ручки всередині блоку «Ручки внутри блока») check box. 

1.13. Hatching 

You can create different types of hatching in AutoCAD. Filling is filling a specified area with a 
specified pattern. 

Hatching a closed area or contour is done using the commands «Hatch» («Штрих») and «Внаtсh» 
(«Кштрих»). 

The «Bhatch» command allows you to hatch a closed area either by simply pointing inside the path 
or by selecting objects. This command allows you to apply associative and non-associative hatching. 
Associativity here means that when you change the boundaries, the hatching changes as well. Non-
associative hatching does not depend on the border outline.  

The «Hatch» command defines the path automatically based on the point that belongs to the area 
you want to hatch. All objects that are partially or fully within the hatching area and are not its outline are 
ignored and do not affect the hatching process. A path can contain protruding edges and islands that you 
can either stroke or skip. Isles are enclosed areas that are located inside the hatching area. You can also 
define paths by selecting objects. 

You can call the «Hatch» command from the «Drawing» drop-down menu or by clicking the icon 
on the panel of the same name. The «Hatch and Gradient» (Штрихування та градієнт «Штриховка и 
градиент») dialog box appears on the screen (Figure 1.37). Use the «Structure» (Структура 
«Структура») button to select a hatching type. 

 

 

Fig. 1.37. The «Hatch and Gradient» («Штриховка и градиент») dialog box 
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You can create a custom stroke type. To do this, in the «Type» «Тип»  area, select «Custom» 
(Користувальницький «Пользовательский») from the drop-down list. After that, set the hatching angle, 
the distance between the hatching lines, and, if necessary, turn on the «Cross-hatch» (Хрест-навхрест 
«Крест-накрест») switch to draw additional lines at a 90º angle to the main hatching lines. 

You can create associative hatching or not create a block containing all the hatching lines. To do this, 
turn on the «Associative» (Асоціативна «Асоциативная») or «Create Separate Hatching» 
(Створювати окремі штрихування «Создавать отдельные штриховки») switches in the «Setup» 
(Налаштування «Настройка») area. 

To automatically create a hatching path, click the «Add: Selection Points» (Додати: точки вибору 
«Добавить: точки выбора») button. AutoCAD prompts you for the interior points. To create multiple 
paths, you must select multiple interior points. 

If AutoCAD determines that the path is not closed or that the point is not inside the path, an error 
message appears on the screen. 

 To select objects as a hatch path, click the «Add: Select Objects» (Додати: вибрати об'єкти 
«Добавить: выбрать объекты») button. 

 To select a path based on parameters other than the specified ones, click the «Advanced Options» 
(Додаткові опції «Дополнительные опции») button. The Advanced Options dialog box appears on the 
screen. The «Path Set» (Набір контурів «Набор контуров») area allows you to define a set of paths.  

In the «Islets» (Острівці «Островки») area, you can set the following stroke styles: 
 ▪ «normal style» (нормальний стиль «нормальный стиль») ‒ is when areas separated from the 

outer contour neighborhood by an odd number of intersections are shaded, and areas separated from the 
outer contour neighborhood by an even number of intersections are not shaded; 

 ▪ «outer style» (зовнішній стиль «внешний стиль») ‒ is when the area is shaded from the outer 
contour to the first internal intersection; 

 ▪ «ignoring style» (ігноруючий стиль «игнорирующий стиль») ‒ is when the entire area is 
shaded without taking into account its internal structure. 

 
The «Hatch» command allows you to apply only non-associative hatching, which can be used, for 

example, to hatch areas of a drawing that do not have closed boundaries. 
 
Example. 
 

 
           normal style            outer style     ignoring style 

1.14. Applying dimensions 

Dimensions express the geometric dimensions of objects, the distances and angles between them, 
and the coordinates of individual points. In AutoCAD, dimensions are of three basic types: linear, radial, 
and angular.  

Linear dimensions are divided into horizontal, vertical, equidistant, inclined, ordinate, base, and 
dimensional chains. 

Dimension images contain the following components: 
‒ «dimensional line»(розмірну лінію) ‒ a line with arrows at the ends, drawn parallel to the 

corresponding dimension. For angular dimensions, the dimensional line is an arc; 
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‒ «arrows» (стрілки) ‒ arrows, serifs or any marker defined as a block to indicate the ends of the 
dimensional line; 

‒ «an offset line» (виносну лінію) ‒ only for linear and angular dimensions; 
‒ «dimension text» (розмірний текст) ‒ a text string containing a dimension. You can accept the 

size automatically calculated by AutoCAD or replace it with your own text. 
‒ «tolerances» (допуски) ‒ text that indicates the amount of allowable deviation from the nominal 

value; 
‒ «boundaries» (межі)‒ if necessary, tolerances can be added to dimensions. In this case, the 

dimensional text will be the upper and lower values, i.e., the maximum allowable dimensions, not the 
nominal dimension with tolerances; 

‒ «alternative units» (альтернативні одиниці) – розмір можна задавати одночасно в двох 
системах виміру; 

‒ «rendered size» (винесений розмір) ‒ used if the dimensional text cannot be placed next to the 
object; 

‒ «center marker and center lines» (маркер центра й осьові лінії) ‒ a marker is a small cross that 
marks the center of a circle or arc. Axial lines are lines with a break that intersect in the center of a circle 
or arc and divide it into quadrants. 

‒ dimension representation (зображення розміру) ‒ all lines, arrows, arcs, and text elements that 
make up a dimension are treated as a single dimensional primitive when associative dimensioning is set. 
Associative dimensions change in accordance with the changes in the elements that are being dimensioned. 

To set the dimension parameters, use the dimension style.  
«Dimensional style» (Розмірний стиль «Размерный стиль») – is a named set of values for all 

dimensional variables that defines the type of dimension in the drawing. All dimensions are created using 
the current dimension style. The default style is STANDARD. 

You can work with dimensional styles using the «DDIM» command in the «Dimension Styles» 
(Диспетчер розмірних стилів «Диспетчер размерных стилей») dialog box, «Style...» (Стиль… 
«Стиль…») item of the «Dimension» (Розміри «Размеры») drop-down menu. 

Let's customize the dimensional style. To do this: 
a) from the «Format» menu, call «Dimensional styles» 
b) to create a new dimensional style in the «Dimensional Style Manager» (Диспетчер розмірних 

стилів «Диспетчер размерных стилей») window, click the «New» (Новий «Новый») button and name 
the style, for example, «Training» («Навчальний»), then click «Next» (Далі «Далее») (Figure 1.38). 

 

 

Fig. 1.38. The window for creating a new dimensional style 
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c) in the window that opens, «New dimensional style: Educational» (Новий розмірний стиль: 
Навчальний «Новый размерный стиль: Навчальний»), do the following: 

- on the «Lines» (Лінії «Линии») tab ‒ change the «Indentation from the object» (Відступ від 
об'єкта «Отступ от объекта»), set it to 0 (Figure 1.39) 

 

 

Fig. 1.39. View of the dimensional style on the «Lines» (Лінії «Линии») tab 

- on the «Symbols and arrows» (Символи та стрілки «Символы и стрелки») tab ‒ set the «Arrow 
size» (Розмір стрілки «Размер стрелки») to 5 (Figure 1.40) 

 

 

Fig. 1.40. View of the dimensional style on the  
«Symbols and arrows» (Символи та стрілки «Символы и стрелки») tab 



51 

- on the «Text» (Текст «Текст») tab ‒ set the label to «Along the dimensional line» (Уздовж 
розмірної лінії «Вдоль размерной линии») and in the «Vertical text alignment» (Вирівнювання тексту 
по вертикалі «Выравнивание текста по вертикали») area select «Above the line» (Над лінією «Над 
линией») (Figure 1.41) 

- on the «Placement» («Размещение») tab ‒ set the label to «Dimensional line between the 
outriggers» (Розмірна лінія між виносними «Размерная линия между выносными») (Figure 1.42) 

- on the «Basic units» (Основні одиниці «Основные единицы») tab ‒ set the «Accuracy» 
(Точність «Точность») to 0 (Figure 1.43) 

 

 

Fig. 1.41. View of the dimensional style on the «Text» (Текст «Текст») tab 

 

Fig. 1.42. View of the dimensional style on the «Placement» (Розміщення «Размещение») tab 
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Fig. 1.43. View of the dimensional style on the «Basic units» (Основні одиниці «Основные единицы») tab 

To set the dimensions, use the «Dimensions» (Розміри «Размеры») menu or the corresponding 
toolbar. 

 
Example. Set the linear dimensions of the rectangle. 
1) From the «Dimensions» menu, call «Linear» 

(«Линейный») or click on the icon of the same name. 
2) Using the «Point» (Кінцева точка «Конточка») object 

snap, select point 1, then point 2, stretch the size to the specified 
distance, and left-click. 

 
 
Example. Set a slanted rectangle size. 
1) From the «Dimensions» menu, call «Parallel» 

(Паралельний «Параллельный») or click the icon of the same 
name. 

2) Using the «Point» (Кінцева точка «Конточка») object 
snap, select point 1, then point 2, drag the dimension to the 
specified distance, and left-click. 

 
Example. Setting the base size. 
1) From the «Dimensions» menu, select «Linear» 

(Лінійний «Линейный») or click the icon. 
2) Using the «Point» object snap, select point 1, then point 

2, drag the dimension to the specified distance, and left-click. 
3) From the Dimensions menu, select Basic or click the icon 

of the same name. Use the point snap to specify point 3, then point 
4. 

 
Example. Setting up a consistent dimensional chain. 
1) From the «Dimensions» menu, select «Linear» or click the icon of the same name. 
2) Using the «Circle Center» (Центр кола «Центр окружности») object snap, specify point 1, then 

point 2, drag the dimension to the specified distance, and left-click. 
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3) From the «Dimensions» menu, click «Continue» (Продовжити «Продолжить») or click the icon 
of the same name. 

Using the «Circle Center» object snap, select point 3, then point 4. 
 

 
 

Example. Setting the corner size. 
1) From the «Dimensions» menu, select «Angular» (Кутовий 

«Угловой») or click the icon of the same name. 
2) Specify 1, then 2, drag the size to the specified distance, and left-

click. 
 
Example. Setting the size to the diameter. 
1) From the «Dimensions» menu, call «Diameter» (Діаметр 

«Диаметр») or click on the icon of the same name. 
2) Specify a circle, stretch the size to the specified distance, and left-

click. 
 
 
 
Example. Setting the size to a radius. 
1) From the «Dimensions» menu, select «Radius» (Радіус 

«Радиус») or click the icon of the same name. 
2) Specify the arc, drag the size to the specified distance, and 

left-click. 
 
Example. Drawing axial lines. 
On the command line:  
Dimcen (setting the size of the axes) 
Current value…:20 (set the size of the axes) 
<ENTER> 
Dimcenter 
Select arc or circle:  specify a circle or arc. 

1.15. Distribution of a drawing by layers 

Using layers allows you to create a drawing in layers that combine interrelated elements of its 
description. Drawing layers can be compared to sheets of transparent tracing paper. Let's imagine that we 
have transparent sheets of paper. The first sheet contains a graphic representation of the part, the second 
contains its dimensions, and the third contains the hatching. If you overlap all three sheets, the drawing of 
the part will be displayed with dimensions and hatching. If you remove the third sheet, you'll see the part 
with dimensions. If you remove only the second sheet, the image will be displayed with hatching and no 
dimensions. 

Objects are created in the current layer. 
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The layer has the following properties: 
«Name» (Ім'я «Имя») – This field specifies the name of the layer. It can contain up to 31 symbols, 

including letters, numbers, and special characters: The layer name cannot contain spaces; 
«On» (Увімкнути «Вкл») – This column indicates the status of the layer. A layer can be visible 

«ON» (Увімкнути «Вкл») or invisible «OFF» (Вимкнути «Откл»). Only the primitives belonging to the 
visible layer are displayed on the screen and drawn on the paper, but primitives in invisible layers are part 
of the drawing and participate in regeneration; 

«Freeze» (Заморожений «Заморожен») – freezing means disabling layer visibility and excluding 
primitives belonging to the frozen layer from the generation of primitives during regeneration. This 
increases the speed of execution of commands such as «ZOOM». By default, each layer is unfrozen, as 
indicated by the sun icon. Clicking on this icon with the mouse you will freeze the layer (then a snowflake 
will be shown instead of a sun). Similarly, clicking on a snowflake will unfreeze the layer, and a sun will 
appear again instead of a snowflake; 

«Lock» (Блок «Блок») – primitives on a locked layer remain visible, but you can't edit them. You 
can make a locked layer the current layer, draw on it, change the color and type of line, freeze it, and apply 
help commands and object snapping to the primitives drawn on it. Unlocked layers are marked with an 
open padlock icon, and locked layers are marked with a closed padlock; 

«Color» (Колір «Цвет») – defines the color of the primitives of a given layer; 
«Linetype» (Тип лінії «Тип линии») – the name of the line type that will be used to draw all segments, 

circles, arcs, and two-dimensional polylines belonging to the layer; 
«Lineweight» (Вага лінії «Вес линии») – specifies (indicates) the thickness of the line. This 

thickness will be used for all objects on this layer; 
«Plot Style» (Стиль друку «Стиль печати») – specifies the plotting style for the layer. In the 

advanced settings of the «Plot» (Друк «Печать») dialog box, there is a «Plot style table» (Таблиця стилів 
друку «Таблица стилей печати») list. Here you can select the color style that you want to apply to the 
plot when it is printed. This allows you to change the color scheme of the drawing by replacing one color 
with another when printing. 

«Plot» (Друк «Печать») – Here you can specify whether this layer is printed when the drawing is 
output or not. Layers with the printer icon checked will be printed. If you click on this icon with the mouse, 
a ban icon will appear, and all constructions on the layer will not be printed. 

Note. The layer named «Defpoints» is not allowed for printing, so it should be used for plots 
only as an auxiliary layer. 

When you create a new drawing, a layer named «0» is automatically created, with a white color and 
a «CONTINUOUS» (БЕЗПЕРЕРВНИЙ «БЕСПРЕРЫВНЫЙ») line type. Layer «0» cannot be deleted 
or renamed. 

The presence of layers in a drawing and their properties can be determined by a template. You can 
set the line type and color of primitives to be either the same as the «BYLAYER»,  layer or different from 
it. 

You can control layer property settings with the «DDLMODES» and «LAYER» («ШАР»), 
commands, the «Layer...» (Шари... «Слои...») item on the «Format» (Формат «Формат») drop-down 
menu, and the «Layer & Linetype Properties» (Диспетчер властивостей шарів «Диспетчер свойств 
слоев») dialog box. From this dialog box, you can create a new layer, set the color and line type for all 
primitives or objects, and make the layer you want the current layer. 

 
Creating a new layer and line types  

 
To create a new layer, click the «Layer Properties Manager» (Диспетчер властивостей шарів 

«Диспетчер свойств слоев») button on the «Layers» (Шари «Слои») toolbar. The window that appears 
lists layer controls, existing layers, and their properties (Figure 1.44). It's a good idea to rename the new 
layers according to their purpose. 

One of the layers can be the current layer on which the elements required for this layer are drawn.  
When you create a new layer, you need to set the color, type, and thickness of the line by clicking in 

the corresponding columns (Color, Line Types, Line Weight) of a particular layer of the Manager window. 
In the dialog box that opens, set the desired property. Layer properties are set in the same way as object 
properties. 
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Fig. 1.44. Layer properties in the «Layer Properties Manager» window 

1.16. Block 

A block (or block description) is a collection of related drawing objects that are treated as a single 
object. You can insert blocks into a drawing with scaling and rotation. You can break them down into their 
component objects and edit them, as well as change the block description. In the latter case, AutoCAD 
updates all existing occurrences of the block and applies the new description to the newly inserted blocks. 

Using blocks simplifies the drawing process. You can use blocks for the following purposes, for 
example: 
 To create a standard library of frequently used symbols, assemblies, and parts. After that, 

you can insert these blocks an unlimited number of times instead of drawing all their elements every time. 
 Quickly and efficiently edit drawings by inserting, moving, and copying entire blocks 

rather than individual geometric objects. 
 To save disk space by addressing all occurrences of a single block. 

A block can consist of primitives created on different layers, with different colors, and different types of 
lines. All these properties of the primitives are preserved when you combine them into a block and when 
you insert the block into the drawing. However, there are three exceptions: 

- primitives created on a special layer named «0 are generated on the current layer when a block 
is inserted; 

- primitives created in the color of the «BY BLOCK» inherit the color of the block; 
- primitives created with the «BY BLOCK» line type inherit the block line type. 
A block can contain other blocks. Using blocks can save a lot of memory. Each time you insert a 

block into a drawing, AutoCAD adds only the block's insertion location, scale factors, and rotation angles 
to the existing information. 

Each block can be associated with attributes, i.e. textual information that the user can change when 
inserting the block into the drawing and which can be displayed on the screen or remain invisible. 

When you insert a block, the block image appears on the drawing. Each time you insert a block, you 
set the scale factors and the angle of its rotation. Scale factors for different axes (X, Y, Z) can be different. 

Using blocks in AutoCAD allows you to systematically organize your drawing tasks; it simplifies 
the creation, editing, and sorting of drawing objects and related information.  

 
 
Creating of block 
The «BMAKE» command is used to create a block, and after it is activated, the information in the 

block creation window is filled in - the objects included in the block are selected, the base point of insertion 
is specified, and the block is named. The created block is an integral part of the drawing in progress and 
can be inserted into it several times. It is advisable to use this operation if there are several identical devices 
in the diagram or elements of the same type in the device design. 
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To replenish the library, you can save a newly created block to it using the «WBLOCK»  command, 
specifying its name and the path to the library. 

To replenish the library, you can save a newly created block in it using the command, specifying its 
name and the route to the library. 

Inserting a block 
When you insert another drawing into a drawing, AutoCAD treats the inserted drawing the same way 

you would a block. Subsequent inserts are based on the block's description (which lists its geometric 
objects), and you can specify different block positions, scale factors, and rotation angles 

By default, AutoCAD uses the point with coordinates 0,0,0 as the base point for pasted drawings. 
You can change this by opening the current drawing and using the command. 

1: Choose Block from the Insert menu. 
2. In the Insert dialog box, specify the name of the block and the place where it is inserted into the 

current drawing, and whether you want to split the block after insertion. 
3.If you have modified the external DWG file from which the block was read, you can redefine the 

block in the current drawing by clicking the File button and specifying the file name. 
4.All occurrences of the block in the current drawing are updated based on the contents of the 

specified file. 
5. Click OK. 
Exploding of blocks 
When explodeded, single objects will turn into a set of separate components. The command does not 

produce a visible effect. For example, polylines, rectangles, rings, and polygons are broken into segments 
and arcs when dismembered. Groups are split into constituent elements or smaller groups when exploded. 

The appearance of the split object remains the same, but the floating colors, layers, and line types 
may change the colors and line types of the objects. 

When you split a polyline, information about its width is lost. The resulting segments and arcs are 
placed along its centerline. If you're splitting a block that contains a polyline, you'll need to split it 
separately. When you split a ring, its width also becomes zero. 

Explodting blocks with unequal scale factors along the X, Y, and Z axes can lead to the most 
unexpected consequences. External links and related blocks cannot be split.  

To explode the object: 
1. From the «Modify» (Редагувати «Изменить») menu, choose «Explode» (Розчленувати 

«Расчленить»), or from the «Modify» (Редагувати «Изменить») panel, choose the appropriate button. 
2. Select the objects you want to explode. 

1.17. External references 

Using external links allows you to work with other drawings without constantly inserting them into 
your drawing. When you load or print a drawing, each external link is automatically reloaded to reflect the 
most recent state of the referenced drawing file. AutoCAD creates a temporary key file while the external 
link is loaded. 

A link can be called another type of block. Linking (reference) an external link is done by inserting 
the entire drawing as a block. 

Dependent symbols have a temporary name consisting of the reference name, a vertical bar, and the 
original symbol name. For example, if you insert a ris.dwg drawing containing a layer named OSN as an 
external link into a drawing, the OSN layer will be renamed to RIS/OSN before the layer is added to the 
drawing's layer table.  

1.18. Obtaining a hard copy of the drawing 

The last step in working with a drawing is to make a hard copy on paper. 
After the layout is complete, the drawing is output to a printer or plotter. If you are using the Windows 

system printer for printing, no preliminary printing operations are required. If the drawing is sent to a 
plotter, you need to configure it: select the plotter driver, input/output ports, assign perimeters, etc. 
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Before printing, the user can set the drawing area, scale, rotation of the drawing, and sheet position. 
At the same time, the user can set the correspondence between the pen numbers and line weights, on the 
one hand, and the colors of graphic objects, on the other. 

You can configure AutoCAD to use many different output devices and store multiple configurations 
for a single device. AutoCAD stores more than 29 plotter configurations in the acad.cfg file. Each plotter 
configuration contains the following information: device driver name, device model name, port ID to which 
the device is attached, sheet size, orientation, scale factor, pen settings, optimization, drawing origin, and 
rotation. 

AutoCAD does not store plotter configuration information in the drawing file. 
Before you display the drawing on the plotter, you can preview how it will fit on the sheet. To do 

this, use the «PREVIEW» command or choose «File» → «Preview» from the drop-down menu. This 
automatically enables real-time image zooming to view fine details of the drawing.  

To access the plotter, use the «PLOT» command or select the «Print» dialog box from the «File» 
→ «Print» drop-down menu. In this window, you can set configuration parameters that control the final 
output of the drawing. 

In the «Printable Area» (Область, що друкується «Печатаемая область») area, you can define 
the following parameters: 

«Screen» (Екран «Экран») ‒ displays the entire view in the graphical area; 
«Borders»  (Межі «Границы») ‒ displays the area containing all drawing objects; 
«Limits» (Ліміти «Лимиты»)‒ displays everything within the specified drawing boundaries; 
«Frame» (Рамка «Рамка») ‒ displays the area defined by the window; 
«Print to file» (Друк у файл «Печать в файл») ‒ saves the information to a file. 
In the «Format» (Формат «Формат») area, you can define the size and orientation of the sheet. 
In the «Print Scale» (Масштаб друку «Масштаб печати») area, you can change the scale of the 

drawing by turning the «Fit» («Вписать»)  switch on/off. 
In the «View» (Перегляд «Просмотр») area, you can view the full drawing or view the drawing 

area. 
After setting all the parameters, print the drawing by clicking the «OK» button. 

1.19. Model space and sheet space 

A model space is an AutoCAD space in which object models are created in both two-dimensional 
and three-dimensional modeling. Indications that you are currently in a model space in an AutoCAD 
window are the USC icon on the drawing area, the «Model» button at the bottom of the drawing area, and 
the «MODEL» button in the status bar. 

Work in the model space takes place on non-overlapping viewports (windows), where the main 
drawing or model is created. If there are several viewports on the monitor screen, edits made in one of them 
are applied to all others. However, you can set the screen magnification, viewpoint, grid spacing, and step 
for each viewport separately. 

«Sheet space» (Простір листа «Пространство листа») is the AutoCAD space required to 
display the spatially generated object model in overlapping viewports. If you didn't use sheet space, you 
would have to fill the model space with graphic information that is only needed to generate drawing sheets. 
After all, all additional graphic information - the drawing sheet frame, the main inscription, and other 
graphic and text information - is not related to the actual model and is needed only on a hard copy of the 
drawing sheets. 

«A sheet»(Лист «Лист») is a component of the AutoCAD environment that simulates a sheet of 
paper and stores a set of settings that are used for printing. You can place viewports on a sheet, as well as 
build geometric objects (for example, elements of a main lettering). A drawing can contain several sheets 
with different types of models; each sheet has its own print scale and page size. The image of the sheet 
looks exactly like the sheet drawn on the plotter. 

Sheet space is strictly two-dimensional, and you can only see it from a view perpendicular to the 
sheet plane. In AutoCAD, the sheet space is indicated by the USC icon and the «Sheet» (Лист «Лист») 
button in the status bar at the bottom of the AutoCAD Desktop. 

In sheet space, the USC icon is triangular and always appears in the lower-left corner of the drawing 
area. 
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After you create floating viewports, you can make changes to the model by switching from the 
«Sheet» (Лист «Лист») tab to the «Model» (Модель «Модель») tab. 

1.20. Viewports 

«A viewport» (Видові екрани «Видовые экраны») is an area of the graphical screen that displays 
a portion of the drawing model space. 

There are two types of viewports: non-overlapping and overlapping. 
Non-overlapping viewports are arranged on the monitor screen like tiles on a wall. They fill the entire 

graphic area and cannot overlap. Viewports can be displayed on the plotter only one at a time.   
Overlapping viewscreens are similar to rectangular windows that can be positioned on the screen and 

moved around in any way. These viewports can be overlapped and crossed out at the same time. 
You can save the entire viewport or any part of it by naming it. Views of model space and sheet space 

are saved separately. 
The configuration of non-overlapping viewports can vary. The possibilities for placing viewports 

depend on their number and size. To select the configuration of viewports, you can open the Model: Non-
overlapping Viewport dialog box, which is called from the View → Non-overlapping Viewport → 
Placement drop-down menu. 

Depending on what you need, you can use different methods to create viewports. When the 
«TILEMODE» system variable is set to «1 (On)», you can use the «VPORTS» command to create and 
manipulate viewports, which divides the screen into multiple, non-overlapping viewports. 

1.21. Creating and using templates 

Using templates eliminates the need to perform repetitive actions when creating a drawing. The 
AutoCad system contains many templates of its own, but we need to create our own templates that will 
comply with the current ГОСТ and ДСТУ. 

 
Creating an A4 format template 
 
The drawing space in AutoCad is infinite. Even when you define drawing boundaries, you only 

define the area of the drawing space that is to be treated as a drawing when printing and creating various 
drawing layouts. At the same time, you can draw outside these boundaries. Moreover, these boundaries are 
not visible on the screen. In order to distinguish between drawing boundaries, you need to explicitly outline 
them, i.e. draw a border, which will determine the format of the sheet. 

Let's draw an A4 frame that marks the boundaries of the drawing. To do this: from the «Drawing» 
panel, select the «Line» (Відрізок «Отрезок») button. 

In the command line: 
Line From point (Specify the starting point): 0,0  (point 1) 
To point(Specify the end point ):   210,0  (to point 2) 
To point(Specify the end point):   210,297 (to point 3) 
To point(Specify the end point):   0,297  (to point 4) 
To point(Specify the end point):   С(З)  (lock in a point 1) 
To draw out the inner borders of the format, call the same command and specify the following corner 

coordinates: 
 lower left ‒ 20.5 
 lower right ‒ 205.5; 
 upper right ‒ 205.292; 
 upper left ‒ 20.292. 
And in the same way, using the «Line» («Отрезок»), command, the knowledge and skills gained, 

cross out the main inscription and prepare a specification drawing with the appropriate stamp. 
Now you need to save the created formats as a template so that you can use them as a basis later. To 

do this, choose File → Save As from the menu. Next, in the «Save Drawing» dialog box that appears, select 
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the .dwt type in the «File Type» field, and then specify a name for the template in the «File Name» field. 
Click «Save» and the template is ready (Figure 1.45). 

 

 
 

 

Fig. 1.45. Template saving window 
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So, knowing the dimensions, you need to create the following format templates: 
A1 horizontal 
A1 vertical 
A2 horizontal 
A2 vertical 
A3 horizontal 
A3 vertical 

1.22. Development of drawings in the AUTOCAD environment 

It is recommended to create a drawing in AutoCAD in the following sequence: 
1. Create a new drawing using the NEW command from File => New... or by clicking the New icon 

on the standard toolbar. 
2. To open the Preparation Wizard in the Create New Drawing dialog box, select the Call Wizard 

icon. Then, in the Select Wizard list, select Quick Prepare. 
3. In the Quick Preparation dialog box, set the length measurement to «Units» and then «Decimal». 

When you define the boundaries of the drawing area, in the Drawing Area dialog box, set the width and 
length. 

4. Click on the «Grid» button in the status bar or use the F7 function key to turn on the grid display. 
5. To display the entire drawing area on the screen, use the ZOOM command from the View = Zoom 

= All drop-down menu, or click the Zoom All icon in the standard toolbar. 
6. Save the drawing using the QSAVE command from File => Save or by clicking the Save icon in 

the standard toolbar. 
7. Insert a frame of the desired format into the drawing (if you have already prepared one). Insertion 

is performed by using the INSERT command from the Insert => Block... menu, then clicking the Insert 
Block icon in the Drawing toolbar. This brings up the Insert Block dialog box. 

8. Create new layers in the Layer Properties Manager dialog box, which can be accessed from Format 
=> Layer... or by clicking the Layer icon in the object's properties bar. 

We recommend creating 4 layers: 
 Contour ‒ for lines of the main contour; 
 Dimensions ‒ for dimensional lines; 
 Axial lines ‒ for axial lines; 
 Plot ‒ for additional plots; 
 Thin lines ‒ for hatching. 
9. In the Layer Properties Manager dialog box, set the line weights for the newly created layers: for 

the Contour layer ‒ 0.8; for the Dimensions, Axis Lines, and Thin Lines layers ‒ 0.3. For the Axis layer, 
set the line type to Center2. It is recommended that you set different color shades for all of them. 

10. Create the desired text style in the Text Style dialog box, accessed from the Format => Text 
Style... menu.  

11. Fill in the main label. It's recommended that you zoom in on the body of the text to enlarge it. 
Then use the DTEXT command from the Draw => Text => Single Line Text menu or click the Dtext icon 
in the toolbar. When filling in a stamp, it is convenient to use the Fit key of the DTEXT command.12. 
Перш, ніж формувати основний контур, слід зробити шар поточним. Це здійснюється в діалоговому 
вікні Layer Properties (Диспетчер свойств слоев), що завантажується з меню Format (Формат) => 
Layer... (Слои...) або клацнути мишею по піктограмі Layers (Слои) у рядку властивостей об'єктів. 

13. Turn on the cursor binding to the grid nodes by left-clicking on the (STEP) button in the status 
bar or by pressing the F9 function key. 

14. Using the RECTANG and CIRCLE commands, build the main contour of the horizontal 
projection of the pattern and using the LINE command, build the main contour of its frontal projection. 
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15. Make the Axis Lines layer the current layer and use the LINE command to create the axis lines 
of both projections of the pattern. 

16. Make the Thin Lines layer the current layer and hatch the section area of the part by using the 
Hatch command from the Draw => Hatch... menu or by clicking the Hatch icon on the Draw toolbar. 
Selecting the Hatch command brings up the Boundary Hatch dialog box, where you set the Pattern area to 
ANSI31; the Scale area to 1; and the Angle area to 0. 

17. Set dimensions. Make the Dimensions layer the current layer, then create a dimensional style 
using the DIMSTYLE command in the Dimension Style Manager dialog box. The command can be 
accessed by choosing Dimension => Style... or by clicking the Dimension Style icon on the Dimension 
toolbar. It is recommended to set: the size of the arrows in the Arrow size: field to 5; in the Offset from 
origin: field, select 0, which determines the indentation of the outline lines from the object; in the Text 
style: list, specify the name of the created text style; in the Text height: list, select 3.5; in the Offset from 
dim line: field, select 1.3. 

18. To display the weight (thickness) of the lines on the screen, click the LWT button in the status 
bar at the bottom of the Desktop. 

19. Save the drawing 

1.23. General concepts of 3D modeling 

In many industries, AutoCAD is widely used in the development of design and construction 
documentation. 

Major changes and the development of new features in the latest versions of AutoCAD allow it to be 
used in modeling three-dimensional objects. 

Three-dimensional modeling provides the developer with a number of advantages. 

1.23.1. Advantages of 3D modeling 

Possibility of spatial viewing 
 

When creating models of any complexity in space, the user can see their relative position and estimate 
the distance between them. The model can be freely moved in space, viewing many options. 

The ability to control the viewpoint allows you to conveniently select a view of the three-dimensional 
model being developed. Real-time zooming and panning with the ability to freely rotate the camera around 
the model allow you to quickly view objects from any point of view. 

With the use of layers for various purposes, it is easy to control the visibility of parts of 3D models. 
Creating sectional planes allows you to make sure that the internal structure of the model is correct. 

 
Automatic projection creation 

 
After creating a three-dimensional model, the user can get its two-dimensional projections not only 

on the main planes, but also on any plane of his or her choice. 
The created projections are easy to manage, moving them freely in the space of the sheet. 

 
Automatic creation of cuts and sections 

 
Sections and cross-sections are created automatically, the user only has to select the line of the section 

or cross-section. 
The user can create as many sections and cross-sections as needed. 

Remove invisible lines and get realistic images  
 
AutoCAD clearly distinguishes which edges or faces in each view need to be removed or which 3D 

objects overlap, and removes or shows the appropriate elements. 
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The created 3D model can be shown in a painted form with shadows. In this form, all model objects 
are presented in the color that belongs to them directly or through a layer. 

Objects can also be assigned a material or texture. 
The models look most realistic when they are tinted with materials, with superimposed textures, and 

when lighting is set. It is possible to perform tinting on a raster field, for example, a model of a cottage can 
be shown on the area where it will be built, using a photo of this area as a raster background. 

 
Possibility of engineering analysis  

 
For solids, it is possible to define parameters such as mass and volume, center of mass, moments 

and radii of inertia, centrifugal moments of inertia, and principal moments in the X, Y, Z directions relative 
to the center of mass. 

AutoCAD allows you to quickly calculate any dimensions of objects that are necessary for their 
production, determine the areas and perimeters of closed objects. 

1.23.2. Types of three-dimensional models 

Frame models 
 
Wireframe models are created from points, segments, and curves that describe the edges of an 

object and have no edges. That is, such a model is a skeletal description of a three-dimensional object. Such 
models only resemble 3D objects in appearance, they do not participate in tinting and coloring (since they 
do not have faces) and do not overlap each other when placed in depth. 

 
Surface models  

 
Surface models are described by the edges and faces of a three-dimensional object, that is, they are 

limited to surfaces. Using surfaces allows you to create the most complex three-dimensional objects. Unlike 
wireframe models, surface objects represent the model more realistically in space, as they can cover objects 
in the background and give a shadow when toned. However, they do not have physical properties: mass, 
center of gravity, etc. 

 
Solid State Models 

 
A solid model (or body) is an image of a three-dimensional object that stores information not only 

about edges and faces, but also information about its volumetric properties. 
Each type of model has its advantages and disadvantages. Each type of model has its own 

technologies for creating and editing. 
Since different types of models have their own methods of creation, it is not recommended to mix 

several types in one drawing. 

1.23.3. Methods for setting three-dimensional coordinates 

When creating three-dimensional objects, analogs of two-dimensional coordinates are used. 
However, the development of three-dimensional objects in AUTOCAD, unlike drawing on a plane, 
involves setting the third coordinate, which determines the volume of the product. 

As with a plane drawing, in three-dimensional modeling, you can enter point coordinates using 
different coordinate systems. 

 
In three-dimensional space, both absolute coordinates (which are counted from the origin of the 

coordinate system) and relative coordinates (which are counted from the last point specified) are used. 
Relative coordinates are indicated by the @ symbol before the coordinates of the point you want to 
specify. 
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Cartesian (rectangular) coordinates 
 
When specifying coordinates in this system, the X coordinate is first determined, then the Y 

coordinate, and the Z coordinate is the last. 
Absolute Cartesian coordinates in three-dimensional space are specified in the format X,Y,Z. 

Relative coordinates have the format @X,Y,Z. 
The current Z coordinate level is associated with the XY plane of the current coordinate system. 

Using the level (elev) command, you can set the required value of the level and height of three-dimensional 
objects. By default, the level is zero. 

If you define a level other than zero, then this will determine the plane for which all Z coordinates 
will be set, if this coordinate is not explicitly specified. 

 
Cylindrical and spherical coordinates 

 
When working in 3D space, two new types of coordinates are used - cylindrical and spherical, which 

are analogous to polar coordinates on the plane. 

1.23.4. Setting the position of points in 3D space 

Coordinate filters 
 
Coordinate filters allow you to set the coordinates of a new point based on the coordinates of 

existing points. Filters are usually used with object snaps. 
Filters are used during the execution of a command when a request for the coordinates of a new 

point is made. The coordinates of the new point are selected as one or two coordinates of an already created 
point, and then the missing coordinates are specified. 

To specify a filter on the command line, use the format .coordinate, 
where the coordinate is one of the characters X, Y, Z, or a combination of them. 
There is a set of six filters: .X, .Y, .Z, .XY, .XZ, .YZ. 
 

World Coordinate System (WCS) and User Coordinate System (UCS) 
 
AutoCAD has a concept called the world coordinate system (WCS). This is a conventional 

coordinate system that is accepted as the initial reference system. 
In three-dimensional constructions, the WSC is a coordinate system in which the XY plane is 

horizontal, and the origin is a point that is convenient for calculations and setting coordinates 
It is not always convenient to work in the WSC, as it may be suboptimal during the construction 

process. When drawing, it is convenient to select a coordinate system for each projection that starts at a 
specific projection point. 

Coordinate systems created by the user during drawing are called user coordinate systems. The 
accepted abbreviation is UCS. 

The creation of a UCS is performed by the UCS command, which has many options. 
At some point in time, only one coordinate system is active, which is called the current one. The 

current coordinate system is identified by the icon of its axes. The sign of the world coordinate system is a 
rectangle at the origin and the letter W. 

It is not allowed to change the WSC. 
At any given time, you can switch from one coordinate system to another. 
In three-dimensional constructions, the coordinate system defines the drawing plane relative to 

which objects are created, editing commands are executed, and coordinates are determined. 
Spatial constructions are associated with constant redefinition of the construction plane. This can 

be a parallel movement of the plane and the origin to a new point in space, rotation of the construction plane 
relative to the spatial axis, or determination of the plane by three points. 

It is convenient to manage the WSC using the UCS. The user coordinate system is named when 
the created CCS, which you will repeatedly work with, does not match the standard one. 
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AutoCAD has six standard orthogonal UCS : top, bottom, front, back, left, and right. By default, 
the parameters of the orthogonal USC are calculated relative to the WSC. 

1.23.5. Coloring 3D objects 

AutoCAD lets you create photorealistic images. To do this, use the «Render» (Тонувати 
«Тонировать») command. Executing this command requires preparatory operations that take time. 
However, to get a visual representation of the model, it is enough to remove invisible contour lines or color 
objects. 

To do this, use the options of the  «Shademode» command. It is convenient to use the «Shade» 
command to call up the command options. 

In «2D Wireframe» («2D Каркас») mode, objects are depicted as segments and curves without 
coloring, and line types and thicknesses are displayed. 

The «3D Wireframe» («3D Каркас») mode displays the object in the form of segments and curves, 
with material colors. A three-dimensional UCS symbol is displayed. 

In «Hidden» (Приховування невидимих ліній «Скрытие невидимых линий») mode, the object 
is rendered in a wireframe view, but the lines that define the back edges are not displayed. In this mode, 
objects in the background are obscured by objects in the foreground and become invisible. 

«Flat Shaded» (Плоске «Плоское») mode. In this mode, objects are colored, and curved edges 
don't have a smooth transition. Invisible faces and edges are not displayed. 

«Gouraud Shaded» mode. Objects are colored and curved edges have smooth transitions. 
This mode gives objects the most realistic look without using photorealistic tinting. Invisible edges 

and faces are not displayed, but the materials that are assigned to the objects are visible. 
In «Flat Shaded, Edges On» (Плоске, з кромками «Плоское, с кромками») mode, objects are 

rendered as a combination of Flat Shaded and 3DWireframe modes. In this case, the edges are colored in 
the color you specify, and the visible wireframe lines are displayed. 

The Gouraud Shaded, Edges On mode is a combination of the Gouraud Shaded and 3D 
Wireframe modes. In this case, the edges are colored in the color you specify, and the visible wireframe 
lines are displayed. 

Checklist questions 

1. What are the main panels that appear on the screen when you start AutoCAD and what do they do? 
2. How do I create or open a drawing in AutoCAD? 
3. Ways to enter commands in AutoCAD. 
4. What is a «graphic primitive» in AutoCAD? What primitives exist? 
5. How to create text? What types of text exist? 
6. What is object snapping? Its purpose. List the types of object snapping. 
7. What are «layers» and their purpose? How to create layers in AutoCAD? 
8. What command allows you to hatch an area? How do you select a hatching pattern? 
9. What are the edit commands? What kind of question is present in the edit commands? 
10. Editing with handles. How to understand it? 
11. List the ways to select objects. 
12. In which submenu are the commands for setting the dimention? List these commands. 
13. What is a «block»? Its creation and purpose. 
14. What is the point of creating blocks from objects that are often reproduced on the drawing? 
15. On what layer should a block be created so that when inserted into the drawing, the objects of the block 

take on the properties of the current layer? 
16. In what case can you change the color of objects in a block after inserting it? 
17. What is the sequence of actions to create a block from existing objects on the drawing? 
18. What is the most acceptable way to specify the point of insertion of the block (Base point)? 
19. What are the considerations for choosing the block insertion point? 
20. How to complete the selection of objects to be included in the block?  
21. How do I place the created block on the drawing field? 
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22. How do I load a block from a file? 
23. What are the advantages of three-dimensional modeling? 
24. What types of three-dimensional models exist? 
25. What are the ways to create solid models you know? 
26. What is the difference between the section and section of the body?  
27. What is tinting and when is it used? 
28. Name the sequence of actions to create design documentation from a three-dimensional model.  
29. The concept of sheet space and model space. How do they differ? 
30. The concept of a template in AutoCAD and how to create it? 
31. How do I save and print a drawing in AutoCAD?   
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2. BASIC REQUIREMENTS AND INFORMATION FROM REGULATORY,  
GUIDANCE MATERIALS AND STANDARDS 

2.1. Requirements of the standards for the design of drawings 

When making drawings, a lot of conventions are used in depicting objects and their elements, a lot 
of information is provided in the form of symbols, etc. In order for such information to be understandable 
to every specialist, there must be a common technical language and terminology, which is ensured by state 
standards. All drawings are prepared in accordance with the requirements of applicable standards.  

2.1.1. Formats and basic labels 

In accordance with ДСТУ ISO 5457:2006, the format of a drawing sheet is determined by the 
dimensions of its sides. Each standard format has a designation, for example, A0. The basic formats are 
determined by sequentially dividing the long sides of the A0 format (1189 x 841 mm) in half, with an area 
equal to 1 m2. The dimensions of the main formats are shown in 

Table 2.1  

Format dimensions 

 
Additional formats may be used, the long side of which must be a multiple of the short side of the 

main format. The dimentions of additional formats are given in Table 2.2. 
 

Table 2.2 

Dimensions of additional formats 

Multiplicity Format 
 АО А1 А2 АЗ А4 

2 1189x1682 - - - - 
3 1189x2523 841x1783 594x1261 420x891 297x630 
4 - 841x2378 594x1682 420x1189 297x841 
5 - - 594x2102 420x1486 297x1051 
6 - - - 420x1783 297x1261 
7 - - - 420x2080 297x1471 
8 - - - - 297x1682 
9 - - -  297x1892 

 
The designation of an additional format consists of the designation of the main format and the 

multiplicity of the additional format to the short side of the main format For example, the 420x1486 format 
is designated A3x5. A border is drawn on the format at a distance of 5 mm from the edge on three sides of 
the sheet and at a distance of 20 mm from the fourth left edge (Figure 2.1). 

Format designation Dimensions of the sides in mm (format) 

А0 841 x  1189 
А1 594 х 841 

А2 420 х 594 

АЗ 297 х 420 
А4 210 х 297 
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Fig. 2.1. Format sheet design 

The main inscription is placed in the lower right corner of the format. Formats, except for A4, can 
be arranged both horizontally and vertically. The A4 format is laid out vertically only. 

The main inscription on text documents and drawings is made in accordance with ДСТУ EN ISO 
7200:2005. The main inscriptions, depending on the purpose, may have different shapes. The content, 
location and size of the main inscriptions, as well as the size of the frames should correspond: in drawings 
and diagrams ‒ to Form 1 (Figure 2.2); on the title page of text documents ‒ to Form 2 (Figure 2.3); on the 
following sheets of text documents and drawings ‒ to Form 2a (Figure 2.4). 

 

 

Fig. 2.2. Basic inscription (form 1) for drawings 

In the columns of the main inscriptions indicate: 
1 ‒ name of the product; 
2 ‒ designation of the document; 
3 ‒ designation of the material of the part (fill in the column only on the part drawings); 
4 ‒ the letter assigned to the document (on study drawings – «N»); 
5 ‒ weight of the product; 
6 ‒ scale; 
7 ‒ serial number of the sheet (on documents consisting of one sheet, the column is not filled in); 
8 ‒ the total number of sheets (the column shall be filled in on the first sheet); 
9 ‒ name or identification number of the company that issued the document 
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(do not fill in this field if the identification code is included in the document designation); 
10 ‒ nature of work performed by the persons signing the document; 
11 ‒ names of the persons signing the document; 
12 ‒ signatures of the persons whose names are indicated in column 11; 
13 ‒ date of signing the document;  
14...18 - changes that are being made. 
 

 

Fig. 2.3. Basic inscription (form 2) on the cover page of text documents 

 

Fig. 2.4. Basic inscription (form 2a) on the following sheets of text documents and drawings 

2.1.2. Scales 

Scale is a measure of reduction or increase in the image of an object in relation to nature. In 
accordance with ДСТУ ISO 5455:2005, the scales shown in Table 2.3 are recommended for use. 

 

Table 2.3 

Scales 

Scale of reduction 
1:2; 1:2,5; 1:4; 1:5; 1:10; 1:15; 1:20;  
1:25; 1:40; 1:50; 1:75; 1:100; 1:200;  

1:400; 1:500; 1:800; 1:1000 
Natural  
value 

1:1 

Scale of increase 
2:1; 2,5:1; 4:1; 5:1; 10:1;  
20:1; 40:1; 50:1; 100:1 

 
For large objects, use scales of 1:2000, 1:5000, 1:10000, 1:20000, 1:50000.  
In necessary cases, it is also allowed to use the scale of magnification (100/n):1, where n is an integer. 

In the corresponding column of the main inscription, the scale is indicated without the letter «М», for 
example, 1:2, 2:1, etc. 
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2.1.3. Lines 

When using drawings, use the lines established by ГОСТ 2.303-68 (Table 2.4).  

Table 2.4 

Типи ліній Types of lines 

№ p/n Name Image Thickness Appointment 

1 Solid thick main 

 
 

 

Lines of visible contours, lines of cross-
sectional contours (outlined and included 
in the section) 

2 Solid thin 

Contour lines of superimposed sections, 
dimensional and  
dimensional and outline lines. Hatching 
lines, shelf lines, and underline labels   

3 Solid wavy 
 

Lines of demarcation between view and 
section. Break lines 

4 Stroke 

  

Invisible contour lines 

5 Dashed line thin 
 

 

Axial and center lines 

6 
Dashed line 
thickened 

 

Designation of surfaces to be heat treated 
or coated. Representation of elements 
located in front of the cutting plane 

7 Opened 

   
Section lines 

8 
Solid thin with a 

fracture 
Long break lines 

 
Line thickness, stroke length of dashed and dotted lines shall be the same for all images on the format 

and shall be selected depending on the scale and complexity of the image. Dashed lines should intersect 
and end with strokes. 
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2.1.4. Application of dimensions and base 

The basis for determining the size of a part and its elements is the dimensions shown in the drawing.  
The dimensions in the drawings are applied taking into account the design features, the operation of 

the part in the product, and the technology of its manufacture and control. such requirements determine the 
bases from which the part is measured during its manufacture, control, and assembly. Bases are divided 
into design, technological and measurement bases. Bases can be primary and secondary. 

Design bases are collections of surfaces, lines, and points that determine the position of a part in a 
product, i.e., a set of elements relative to which a part is oriented in a mechanism (Figure 2.5). 

As a rule, design bases are used to define dimensions that determine the position of the mating 
surfaces of the product, taking into account the possibilities of manufacturing and dimensional control. 

A measuring base is a set of surfaces, lines, and points against which dimensions are measured when 
measuring the manufacture of a part. 

A technological base is a surface against which a part is oriented during its manufacture. 
 

 
Fig. 2.5. Design bases 

When performing working drawings of parts that are made by casting, stamping, forging or rolling, 
indicate no more than one dimension that connects the machined surfaces with the surfaces that are not 
subject to machining. This dimension defines the finishing and roughing process bases. The finishing 
technological base is the main one and is processed first. The position of auxiliary technological bases is 
determined relative to the main ones. It is recommended that all dimensions on working drawings of parts, 
except for the dimensions of the position of mating surfaces, be applied from technological or measuring 
bases. This follows from the definition of a part drawing as a document containing data for its manufacture 
and control. The rules for applying dimensions are defined by ДСТУ ГОСТ 2.307:2013.  

When applying dimensions to a drawing of a part, the total number of dimensions should be minimal 
but sufficient for its manufacture and control. 

It is not allowed to repeat the dimensions of the same element in different images, with the exception 
of reference dimensions, which are indicated for greater ease of use of the drawing. Reference dimensions 
in the drawings are marked with a «*», and in the technical requirements are written: «*Dimensions for 
reference». 

Dimensions should not be shown in a closed chain unless one of the dimensions is shown as a 
reference. 

It is recommended to group dimensions referring to the same structural element (groove, protrusion, 
hole, etc.) in one place, placing them in the image that shows the element shape most fully. 

As a rule, the dimensions of several identical elements of a product are drawn once, indicating the 
number of these elements (Figures 2.6, 2.7). If the same elements (e.g., holes) are located on different 
surfaces and shown in different images, the number of these elements is recorded separately for each 
surface. 
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      Fig. 2.6. Application of dimensions        Fig. 2.7. Application of dimensions 

The dimensions of symmetrically placed elements (except for hol  es) are applied once, grouped in 
one place, without specifying the number of elements (Figures 2.8, 2.9). 

 
 

 

Fig. 2.8. Dimensions of symmetrically placed elements 

 

Fig. 2.9. Dimensions of symmetrically placed elements 

When specifying dimensions that determine the distance between evenly spaced elements (e.g., 
holes), it is recommended that instead of a dimensional chain, the dimension between adjacent elements be 
specified as the product of the number of gaps between elements and the size of the gap (Figure 2.10). 
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Fig. 2.10. Drawing of dimensions defining the distance between evenly spaced elements 

In cases where, for whatever reason, a large number of dimensions are drawn from a single baseline 
(Figure 2.11), it is permissible to draw one common dimensional line from the 0 mark for linear and angular 
dimensions instead of separate dimensional lines. 

 

 
Fig. 2.11. Features of dimensioning 

The drawing of each part must contain its overall dimensions - the largest measurements in each 
coordinate direction. 

These dimensions are necessary for the selection of the workpiece and equipment, and for the 
development of the manufacturing process of the part. These dimensions can be marked as reference 
dimensions with a «*». 

Linear dimensions and their maximum deviations in the drawings are indicated in millimeters 
without the designation of the unit of physical quantity. For dimensions that are recorded in technical 
requirements and explanatory notes, the units of measurement must be indicated in the drawing field. 

If the radii of roundings, bends, etc. are the same throughout the drawing or one radius prevails, then 
instead of placing the dimensions of these radii on the drawing, make a note in the technical requirements, 
for example: «Radius of rounding 4 mm», etc. 

Sometimes in designs, it becomes necessary to jointly machine parts (or their elements) that are part 
of a given product (for example, a hole in a housing consisting of two halves). The dimensions with the 
maximum deviations of the elements to be machined together are enclosed in square brackets and recorded 
in the technical requirements: «Machining according to the dimensions in square brackets shall be 
performed jointly with the...». 

When marking dimensions on drawings, use the series of numbers that should be preferred, taking 
into account the requirements of the relevant standards for normal linear dimensions and angles normal 
radii of rounding and chamfers, normal cones and cone angles, etc. 
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2.2. Welded joints 

2.2.1. Types of welding and methods of their implementation 

Today, there are many types of welding and methods of welding. The main ones are shown in Table 
2.5 

Table 2.5 

Types of welding 

ГОСТ Тitles 

5264-80 Manual arc welding. Welded joints. 

8713-79 Submerged arc welding. Welded joints. 

11533-75 Automatic and semi-automatic submerged arc welding. Welded joints at acute and obtuse angles. 

11534-75 Manual arc welding. Welded joints at acute and obtuse angles. 

14771-76 Arc welding in shielding gas. Welded joints. 

14776-79 Arc welding. Welded joints. 

14806-80 Arc welding of aluminum and aluminum alloys in inert gases. Welded joints. 

15164-78 Electroslag welding. Welded joints. 

15878-79 Resistance welding. Welded joints. 

16310-80 The joints are welded from polyethylene, polypropylene, and vinyl. 

23518-79 Arc welding in shielding gas. Welded joints at acute and obtuse angles 

23792-79 Welded electrical contact connections 

 
Arc welding is performed with an electric arc that occurs between the electrode and the parts to be 

welded. 
Gas welding is performed with a flame of a combustible gas (acetylene, hydrogen, methane, propane-

butane, etc.) burned in a stream of oxygen. The torch flame feeds filler material (electrodes or welding 
wire) into the metal heating zone. Gas welding is used for non-ferrous metals and cast iron. 

Resistance welding is carried out with heat generated by the flow of high-powered electric current 
through the parts to be welded and the creation of contact pressure between them. 

2.2.2. Classification of seams of welded joints 

Weld seams are classified according to the type of joint, cross-sectional shape, edges of the parts to 
be welded, position of the seam in space, and the location of the seams relative to the force acting on 
them. 

Depending on the location of the seams relative to the direction of the force acting on them, there 
are frontal (1), flank (2) and oblique (3) seams (Figure 2.12). 

 

PP

3

1

2  
Fig. 2.12. Types of joints according to their location relative to the direction of the force acting on them: 

1 ‒ frontal, 2 ‒ flank, 3 ‒ oblique 
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Depending on the position of the seam in the space it occupies during welding, there are bottom (I), 
vertical (II), and ceiling (III) seams (Figure 2.13). 

Seams 1a (Figure 2.13), which are applied horizontally when the product is vertical, are called 
horizontal seams. 
 

 

 1а

 
Fig. 2.13. Seam types according to position in space: 

I ‒ bottom, II ‒ vertical, III ‒ and ceiling 

According to the relative position of the parts to be welded, the following types of joints are 
distinguished: C ‒ butt joint (Figure 2.14, a), H ‒ overlap (Figure 2.14, b), У ‒ corner (Figure 2.14, c), T ‒ 
T-joint (Figure 2.14, d). 

 

 
a             b             с          d 

Fig. 2.14. Types of connections: 
a ‒ butt joint, b ‒ overlap, с ‒ corner, d ‒ T-joint 

Regardless of the welding method, the seams of welded joints are conventionally depicted: visible 
seams are represented by a solid main line (Figure 2.15, a), invisible seams are represented by a dashed 
line (Figure 2.15, b). A visible single weld point, regardless of the welding method, is conventionally 
marked with a «+» sign (Figure 2.15, c). Invisible single weld points are not marked. 

 

 
   а            b     c 

Fig. 2.15. Conditional representation of welds of welded joints: 
а ‒ visible seams, b ‒ invisible seams, с ‒ visible single welding points 

The edges of the parts to be welded can be prepared in different ways: without bevels (Figure 2.14, 
b, d), with bevels of two edges (Figure 2.14, a), etc. To distinguish between them, a numerical designation 
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of the prepared edges is added to the corresponding letter symbol: С1, 
C2,С3,...;Н1,Н2;У1,У2,У3...;Т1,Т2,Т3.... 

The seam can be one-sided (Figure 2.16, a) and two-sided (Figure 2.16, b,c), continuous or 
intermittent with a chain (Figure 2.17, a) or staggered (Figure 2.17, b) arrangement of the welded sections. 

When designing welded structures, it is necessary to take into account the technological and strength 
features inherent in different types of welded joints. For example, lap joints, which are easy to assemble 
and do not require high precision of workpieces, are recommended for use only for connections of lightly 
loaded elements that are subject to static load. Lap joints should not be used in structures subjected to 
vibration alternating loads because they have a very low endurance limit (up to 40% of the base metal). T-
joints are widely used in welded structures, as they operate reliably under static load. 

In cases where it is necessary to guarantee an increase in the vibration strength of tack welds, local 
machining of their surface and transitions to the metal surface of the welded parts is performed. 

The best type of welded joint is a butt joint, which has a tensile strength not inferior to the base metal. 
 

    а 

 
 

       b               c           а                b 

 

 

2.2.3. Manual arc welding 

ДСТУ EN ISO 9692-1:2014 specifies the main types, structural elements and dimensions of welded 
joints made of steels and iron-nickel and nickel-based alloys, made by manual arc welding. The main types 
of welded joints shall comply with those given in Table 2.6 

Welded joints at acute and obtuse angles. 
The main types, structural elements and dimensions of welded joints at acute and obtuse angles are 

specified in ГОСТ 11534-75.   The main types of such joints are shown in Table 2.7. 
 

Figure 2.16. Types of seams: 
a ‒ one-sided, b,с ‒ two-sided 

Figure 2.17. Types of seams: 
а ‒ continuous or intermittent with chain, 

b ‒ staggered arrangement 
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Таble 2.6 
Types of connections and their symbols 

 

Types of 
connections  

Shape of prepared 
edges  

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

With edge banding 

One-sided 

  
1-4 С1 

 
  

1-12 С28 

With one edge flanging 
  

1-4 
 

С3 

No beveled edges 

  
С2 

One-sided with 
removable backing 

  

1-4 

С4 

One-sided on the 
leftover substrate 

  

С5 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

No beveled edges 

One-sided locking 
  

1-4 С6 

Two-sided  

 

2-5 С7 

No edge beveling with 
subsequent gouging 

 
 
 

 

6-12 С42 

 
 
 
 
 
 
 

With a beveled edge 

One-sided  

  

3-60 

С8 

One-sided with 
removable backing 

  

С9 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

With a beveled edge 

One-sided on the 
leftover substrate 

  

3-60 

С10 

One-sided 

  

С11 

Two-sided 

  

С12 

With a curved bevel on 
one edge 

  

15-100 

С13 

With a broken bevel of 
one edge 

  

С14 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

With two symmetrical 
bevels on one edge 

 
Two-sided  

  

8-100 С15 

With two symmetrical 
curved bevels on one 

edge   

30-120 С16 

With two asymmetrical 
curved bevels on one 

edge   

12-100 С43 

With beveled edges 

One-sided 

 
 

3-60 

С17 

One-sided with 
removable backing 

  

С18 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges  

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges  Welded seam 

Joint 

With beveled edges 

One-sided on the 
leftover substrate 

  

6-100 С19 

One-sided locking 

  

3-60 

С20 

Two-sided 

 

 

С21 

Beveled edges with 
subsequent gouging 

 
 
 

8-40 С45 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

With curved beveled 
edges 

Two-sided 

  

15-100 

С23 

With broken edge bevel 

  

С24 

With two symmetrical 
beveled edges 

Two-sided 

  

8-120 С25 

With two symmetrical 
curved edge bevels 

Two-sided 

  

30-175 С26 
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Table continuation 2.6 
 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Joint 

With two symmetrical 
broken edge bevels 

Two-sided 

 
 

3-175 С27 

With two asymmetrical 
edge bevels 

  

12-120 

С39 

  

С40 

Corner With one edge flanging One-sided 

  

1-4 У1 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Corner 

With one edge flanging 

One-sided 

  

1-12 У2 

No beveled edges 
  

1-6 

У4 

  

1-30 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Corner 

No beveled edges Two-sided 
  

2-8 

У5 

  

2-30 

With one edge beveled 

One-sided 

 

 3-60 

У6 

Two-sided 

 

У7 
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Table continuation 2.6 
 
 Types of 

connections 
Shape of prepared 

edges 
Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Corner 

With two symmetrical 
bevels on one edge 

Two-sided 

  

8-100 У8 

With beveled edges 

One-sided 

 

 

3-60 

У9 

Two-sided 

 

У10 
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Table continuation 2.6 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Tavrovo 

No beveled edge 

One-sided 

 

 
2-40 

Т1 

Two-sided 

 

Т3 

With one edge beveled 

One-sided 

 

 
3-60 

Т6 

 
Two-sided 

 

Т7 
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Table continuation 2.6 
 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Tavrovo 

With curved bevel of 
one edge 

Two-sided 

  

15-100 Т2 

With two symmetrical 
bevels on one edge 

  

8-100 Т8 

  

12-100 Т9 
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Table continuation 2.6 
 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 

Cross-sectional shape 
Thickness of 

welded parts, mm 
Connection 

symbols Prepared edges Welded seam 

Tavrovo 
With two symmetrical 
curved bevels on one 

edge 
Two-sided 

  

30-120 Т5 

Overlap No beveled edges 

One-sided 

 

2-60 

Н1 

Two-sided 

 

Н2 
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Table  2.7 

Basic types, structural elements and dimensions of welded joints 

 
 Types of 

connections 
Shape of prepared 

edges 
Type of weld seam Cross-sectional shape of the prepared edges and the weld 

Thickness of 
welded parts, mm 

Connection angle of 
parts β, degrees 

Welded joint 
designation 

symbol 

Corner No beveled edges 

One-sided 

 

1-6 
179-91; 

89-5 

У1 

7-30 
135-91; 

89-5 

One-sided on steel 
removable or left-in 

backing 

 

1-6 179-136 

У2 

7-26 135-91 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam Cross-sectional shape of the prepared edges and the weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Corner 

No beveled edges Two-sided 

 

2-8 
179-91 

 

У3 2-30 135-91 

9-30 89-45 

Зі скосом одного 
окрайка 

One-sided 

 

4-26 
179-136; 

89-46 
У4 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges and the 

weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Corner 

With one edge beveled Two-sided 4-60 
179-136; 

89-45 
У5 

With two bevels on one 
edge 

Two-sided 12-60 
179-165; 

89-75 
У6 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges and the 

weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Corner 

With two asymmetrical 
bevels on one edge 

Two-sided 12-60 
179-165; 

89-75 
У7 

With two bevels on one 
edge and one bevel on 

the other edge 
Two-sided 

 

12-60 179-136 У8 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges and  

the weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Tavrove No beveled edges 

One-sided 

 

1-30 91-175 Т1 

Two-sided 

 

1-60 91-135 Т2 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges 

 and the weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Tavrove 
With one bevel on one 

edge 

One-sided 

 

4-26 91-134 Т3 

Two-sided 

 

4-60 91-134 Т4 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges  

and the weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Tavrove With one edge beveled 

One-sided 

 

2-30 
89-45; 
91-135 

Т5 

Two-sided 

 

2-60 
89-45; 
91-135 

Т6 
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Table continuation  2.7 

Types of 
connections 

Shape of prepared 
edges 

Type of weld seam 
Cross-sectional shape of the prepared edges 

 and the weld 
Thickness of 

welded parts, mm 
Connection angle of 

parts β, degrees 

Welded joint 
designation 

symbol 

Tavrove 

With two bevels on one 
edge 

Two-sided 

 

12-60 
91-100; 
89-80 

Т7 

With two asymmetrical 
bevels 

one edge 
Two-sided 

 

12-60 
101-110; 

79-70 
Т8 
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2.2.4. Conventional designation of welded seams 

Weld seams designation is performed in accordance with ДСТ 2.312-72. The structure of a 
standard weld or weld point designation is shown in Figure 2.18. 

 
hyphens 

 

1 2 3 4 5 6 7

 

Fig. 2.18. Structure of the standard seam symbol 

In the weld seam designation, the numbers mean: 
 
1 ‒ additional signs of a closed line seam and an assembly seam; 
2 ‒ standard designation for types and structural elements of welds; 
3 ‒ alphanumeric designation of seams; 
4 ‒ symbol of welding method (may be omitted) (Table 2.9); 
5 ‒ sign    and size of the catenary; 
6 ‒ characteristic of a weld seam or a single weld point, - (for a discontinuous weld seam - the length 

of the welded section, the sign Z or I and the pitch); 
7 ‒ auxiliary signs, which are selected from Table 2.8. 
Welding methods are divided into: Р ‒ manual; П ‒ semi-automatic; A ‒ automatic. 
ДСТУ EN ISO 9692-1:2014 establishes the following designations for types of welding in shielding 

gases: 
ИН ‒ in inert gases with a non-consumable tungsten electrode without filler material; 
ИНп ‒ in inert gases with a non-consumable tungsten electrode with filler material; 
ИП ‒ in inert gases and their mixtures with active gases with a consumable electrode; 
УП ‒ in carbon dioxide with a melting electrode. 
However, all welds, regardless of the welding method, are depicted in the same way. 
It is better to draw a line with a one-way arrow ending in a horizontal shelf from the image of the 

visible seam. Distinguish between the front and back sides of the seams (Figure 2.19) 
If the arrow of the line-extension is directed to the front side of the seam (Figure 2.19, a), the symbol 

is applied above the shelf, if it is directed to the back side, it is applied below the shelf (Figure 2.19, b). 
For a single-sided weld, the side from which the welding is performed is considered the face, and for 

a double-sided weld with asymmetrical bevels, the side from which the main weld is performed. Either side 
may be considered as the face of a double-sided weld with symmetrical bevels. In the seam designation, 
auxiliary symbols (Table 2.8) are drawn as solid thin lines. The height of these symbols shall be equal to 
the height of the digits included in the seam designation. The seam catenary mark (equilateral right triangle) 
is drawn as a solid thin line. The height of the mark and the digits that make up the seam designation must 
be the same. 

Non-standard seams are depicted with the application of structural elements necessary to perform the 
seam according to this drawing (Figure 2.20). In the technical specifications, make the entry: «Manual 
electric arc welding». 
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Table 2.8 
Auxiliary symbols in the weld seam designation 

Auxiliary symbol 
Meaning of the auxiliary 

symbol 

Positioning of the auxiliary symbol in relation to the shelf of 
the line-extension drawn to the seam image 

on the front side on the back side 
 

Remove the seam 
reinforcement 

 

 

 

 
 

 

Process seam sagging and 
irregularities with a smooth 
transition to the base metal 

 

 

 
 

 

 
Perform the seam during 

installation of the product, 
i.e. when installing the 

product according to the 
installation drawing at the 

place of use 

 

 
 

Interrupted or point seam 
with a chain arrangement, 

line angle - 60° 

 

 

 
 

 

 

Intermittent or dotted seam 
with a staggered 

arrangement 

 

 

 
 

 

 

Seam along a closed line. 
The diameter of the sign is 

3..5 mm 

 

 

 
Seam along an open line (the 

sign is used when the 
location of the seam is clear 

from the drawing) 
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Table 2.9 

Letter designations of some types, methods and techniques of welding 

Welding type and method Letter designations 
Electric arc Е 
Electric arc under the flux layer Ф 
Electric arc surrounded by shielding gases З 
Electric arc with an open arc О 
Electroslag ШЕ 
Contact Кт 
Gas Г 
Ultrasonic Уз 
Friction Тр 
Cold Х 
Plasma Пз 
With an electron beam Ел 
Diffused Дф 
A beacon of light Лз 
By explosion Вз 
Induction И 
Gas pressing Гп 
Termite Тм 
Radio frequency currents Рч 
Helio (solar) Гс 

 

 
      а             b 

Fig. 2.19. Seam designation: 
a ‒ front side of the seam, b ‒ reverse side of the seam 

 

Fig.  2.20. Image of a non-standard seam 
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Examples of weld symbols: 
 
1. The butt joint seam without beveled edges is one-sided, made by manual arc welding in a closed 

line on the front side. 
 

 
 

 
The same on the reverse side 

 

 
 

2. Branded seam without beveling of edges, double-sided, intermittent with a staggered arrangement, 
performed by manual arc welding in shielded gases with a non-consumable metal electrode. The weld gauge 
is 6 mm. The length of the welded section is 50 mm. Step 100 mm on the front side. 
 

 
 
 

The same on the reverse side  
 
 

 
 
 

2.2.5. Electrodes for manual arc welding 

The design, dimensions, general technical requirements and symbols for coated metal electrodes 
for manual arc welding of steel are specified in ГОСТ 9466-75. 

Diameters of electrodes for manual arc welding, thicknesses of parts to be welded with them and 
welded seam (for butt joints) are recommended to be selected according to Table 2.10. 
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Table 2.10 

Dependence of the electrode diameter on the thickness of the welded parts 

Dimensions in millimeters 

Diameter of the 
electrode rod 

Thickness of welded 
parts 

Cathette seam 
When welding pipes 

Outer diameter of the 
pipe 

Pipe wall thickness 

1,6-2,0 1-3 1-2 18-76 1,5-3,0 

2,5-3,0 3-6 2-4 89-219 3-6 

4,0 5-10 3-6 273-426 7-9 

5,0-6,0 8-15 5-8 - - 

8,0 10-20 8-10 - - 

10,0 
12,0 

20-25 10-12 - - 

 
Electrodes for welding carbon and low-alloy steels are shown in Table 2.11 

 

Table 2.11 

Types of electrodes for carbon and low-alloy steels 

 
Electrodes for welding high-alloyed corrosion-resistant steels and alloys are shown in Table 2.12. 

 

Table 2.12 

Types of electrodes for corrosion-resistant steels and alloys 

 
 

Steel grade welded 
Electrode type by 
ГОСТ 9467-75 

Electrode brands 

До Ст 3 Э 34 АН-I 
Ст 3 кп Э 42 АНО-5,АНО-17  and others 

Ст 3 сп, Ст 3 пс, Ст 3 Гсп Э 42 А УОНИ-13/45, УП-1/45  and others 

10,15, 20, 15К, 16К, 18К, 20К Э 46 
АНО-13, АНО-3, АНО-4, 

 МР-3, АНО-18, ОЗС-4,ОЗС-6, ОЗС-3, ОЗС-
12  and others 

16ГС, 09 Г2С, 10Г2, 10Г2С1, 
17ГС,17Г1С 

Э 50 А 
УОНИ-13/55, УП-1/55, УП-2/55, К-5А, 

АНО-11, ВП-4, ОЗС-29  and others 
15 Г2СФ Э 55 ОЗС/ВНИИСТ-27 
09 Г2ФБ Э 60 ОЗС-24М 

Steel grade welded 
Electrode type by 

ГОСТ 10052-75 ( еlectrode brands) 
08Х18Г8Н2Т 
08Х22Н6Т 

Э-07Х20Н9 (ОЗЛ-8, АНВ-29), 05Х22Н5Г2Б (ОЗЛ-40) ТУ-14-168-43-80, Э-
08Х20Н9Г2Б (ОЗЛ-7, ЦЛ-11, Л-38М), Э-08Х19Н10Г2Б(АНБ-23, ЦТ-15) 

12Х18Н9, 08Х18Н10 Э-07Х20Н9(ОЗЛ-8), Э-04Х20Н9(ОЗЛ-36) 
12Х18Н9Т, 08Х18Н10 Э-07Х20Н9(ОЗЛ-8,АНВ-29) 
12Х18Н10Т, 08Х18Н12Б, 
10Х18Н9ТЛ 

Э-04Х20Н9(ОЗЛ-36), Э-08Х20Н9Г2Б(ОЗЛ-7, ЦЛ-11, Л-38М, Л-40М, АНВ-35), Э-
08Х19Н10Г2Б(АНВ-23, ЦТ-15) 

03Х18Н11 Э-02Х19Н9Б(АНВ-13) за ТУ,  
Э-02Х21Н10Г2(ОЗЛ-22) 

03Х19АГЗН10 Э-02Х19Н9Б(АНВ-13) за ТУ 
10Х19Г14Н4Т Э-03Х15Н9АГ4(АНВ-24) 
03Х13АГ19, 07Х13АГ20 Э-07Х20Н9(ОЗЛ-8, АВН-29), Э-04Х20Н9(ОЗЛ-36) 
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2.2.6. Simplification of weld seam designation 

Some simplifications are allowed in the designation of welds: 
1) if several identical welds are shown in the drawing, they are assigned the same number as on the 

shelf of the line-footnote instead of the symbol; the full symbol is written only for one of these welds, 
indicating the number of welds and their sequence number (Figure 2.21) 

 

 
Fig. 2.21. Simplification of weld seam designation 

If all the seams are the same, then no sequence number is assigned, and the line-notes are made 
without shelves, except for the seam on which the symbol is written (Figure 2.22). 

 

ГОСТГОСТГОСТГОСТГОСТГОСТГОСТГОСТГОСТГОСТГОСТ 5264-80- -К5 5ГОСТГОСТГОСТ

 
Fig. 2.22. Simplification of weld seam designation 

2) if all welds in the drawing are made according to one standard, the standard number is not 
indicated in the symbol for each weld, and an entry is made in the technical requirements such as 
«Welds...according to...» or in the table; 

3) in the drawing of a symmetrical product, it is allowed to mark with lines-extensions and mark 
the seams on one of the symmetrical parts (Figure 2.23); 

4) if the product has several identical component parts that are welded with the same seams, it is 
allowed to mark the seams only in one of the parts shown (Figure 2.24) 
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Fig. 2.23. Simplification of weld seam designation 

 
Fig. 2.24. Simplification of weld seam designation 

5) it is allowed not to mark the seams in the drawing with the help of the lines, but to indicate welding 
by an entry in the technical requirements, if such an entry unambiguously determines the place and methods 
of welding, types of seams, their location and dimensions of structural elements in cross-section, for 
example: «Welds at  5264- T780- -ГОСТ ».  

2.3. Detachable joints 

2.3.1. Thread types 

A metric thread (Figure 2.25) is characterized by a profile angle of α= 60°. The most common metric 
threads are those with diameters from 1 to 600 mm. The main feature of the metric thread profile is that its 
vertices are cut off along the inner diameter of the nut at a distance of H/4, and along the outer diameter of 
the bolt at a distance of H/8 from the top of the theoretical profile. 

The following standards have been established for metric threads: ДСТУ ГОСТ 16093:2018 - for 
the profile of the thread in pitch from 0.075 to 6 mm; ГОСТ 8724-2002 - for diameters and pitches. 

The symbol for metric threads includes the letter M, nominal diameter, pitch (for small pitch threads), 
and the letters LH for left-hand threads. For example, a thread with a nominal diameter of 24 mm with a 
large pitch is designated M24; a thread of the same diameter with a small pitch of 1.5 mm is designated 
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M24x1.5; left-handed threads of the same diameter with a large and small pitch are designated M24LH and 
M24x1.5LH, respectively. 

The following are added to the symbol for a metric multi-tap thread: the stroke value and, 
in parentheses, the letter P with the pitch value. For example, a metric three-thread thread with a 
nominal diameter of 24 mm, a stroke of 3 mm and a pitch of 1 mm is designated M24x3(P1); a 
thread with the same parameters but left-handed is designated M24x3(P1)LH. 

Table 2.13 

Nominal diameters and pitches of metric threads 

Dimensions in millimeters 
Nominal diameter of the thread d Steps. Р 
1st row 2st row 3st row Big Small  

2 - - 0,4 0,25 - - - - - 
- 2,2 - 0,45 0,25 - - - - - 

2,5 - - 0,45 0,35 - - - - - 
3 - - 0,5 0,35 - - - - - 
- 3,5 - (0,6) 0,35 - - - - - 
4 - - 0,7 0,5 - - - - - 
- 4,5 - (0,75) 0,5 - - - - - 
5 - - 0,8 0,5 - - - - - 
- - (5,5) - 0,5 - - - - - 
6 - - 1 0,75 0,5 - - - - 
- - 7 1 0,75 0,5 - - - - 
8 - - 1,25 1 0,75 0,5 - - - 
- - 9 (1,25) 1 0,75 0,5 - - - 

10 - - 1,5 1,25 1 0,75 0,5 - - 
- - 11 (1,5) 1 0,75 0,5 - - - 

12 - - 1,75 1,5 1,25 1 0,75 0,5 - 
- 14 - 2 1,5 1,25 1 0,75 0,5 - 
- - 15 - 1,5 (1) - - - - 

16 - - 2 1,5 0,75 0,5 - - - 
- - 17 - 1,5 (1) - - - - 
- 18 - 2,5 2 1,5 1 0,75 0,5 - 

20 - - 2,5 2 1,5 1 0,75 0,5 - 
- 22 - 2,5 2 1,5 1 0,75 0,5 - 

24 - - 3 2 1,5 1 0,75 - - 
- - 25 - 2 1,5 (1) - - - 
- - (26) -  1,5 - - - - 
- 27 - 3 2 1,5 1 0,75 - - 
          
- - (28) - 2 1,5 1 - - - 

30 - - 3,5 (3) 2 1,5 1 0.75 - 
- - . (32) . 2 1,5 - - - - 
- 33 - 3,5 (3) 2 1,5 1 - - 
- - 35 - 1,5 1,25 - - - - 

36 - - 4 3 2 1,5 1 - - 
- - (38) - 1,5 - - - - - 
- 39 - 4 3 2 1,5 1 - - 
- - 40 - (3) (2) 1,5 - - - 
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Table continuation 2.13 

Nominal diameter of the thread d Steps. Р 

1st row 2st row 3st row Big Small 

42 - - 4,5 (4) 3 2 1,5 1 - 

- 45 - 4,5 (4) 3 2 1,5 1 - 

48 - - 5 (4) 3 2 1,5 1 - 

- - 50 - (3) (2) 1,5 - - - 

- 52 - 5 (4) 3 2 1,5 1 - 

- - 55 - (4) (3) 2 1,5 - - 

56 - - 5,5 4 3 2 1,5 1 - 

- - 58 . (4) (3) 2 1,5 - - 

- 60 - (5,5) 4 3 2 1,5 1 - 

- - 62 . (4) (3) 2 1,5 - - 

64 - - 6 4 3 2 1,5 1 - 

- - 65 . (4) (3) 2 1,5 - - 

- 68 - 6 4 3 2 1,5 1 - 

- - 70 - (6) (4) (3) 2 1,5 - 

72 - - - 6 4 3 2 1,51

- - 75 - (4) (3) 2 1,5 - - 

- 76 - - 6 4 3 2 1,51

- - (78) - 2 - - - - - 

80 - - - 6 4 3 2 1,51

- - (82) - 2 - - - - - 

- 85 - - 6 4 3 2 1,5 - 

90 - - - 6 4 3 2 1,5 - 

- 95 - - 6 4 3 2 1,5 - 

100 - - - 6 4 3 2 1,5 - 

 
The metric tapered thread is produced with a taper of 1:16 and a nominal diameter of 6...60 mm. It 

is intended for tapered threaded connections, as well as for connecting an external tapered thread with an 
internal cylindrical thread having a nominal profile in accordance with ДСТУ ГОСТ 16093:2018. 

The conventional designation of the thread consists of the letters MK (for tapered threads) or M (for 
internal cylindrical threads), the nominal pitch diameter and the number of the tapered thread standard (only 
for internal cylindrical threads): MK16x1.5; M16x1.5 ГОСТ 25229-82. 

The conventional designation of a tapered threaded connection corresponds to the one used for a 
tapered thread, for example, MK16x1.5. The connection of an internal cylindrical thread with an external 
tapered thread is indicated by the M/MK ratio, nominal diameter, pitch and the number of the tapered thread 
standard: M/MK16x1.5 ГОСТ 25229-82 or, if the thread is left-handed, M/MK16x1.5LH ГОСТ 25229-
82. 

Cylindrical pipe threads are used in cylindrical threaded connections, as well as in connections of an 
internal cylindrical thread with an external tapered thread. The profile and main dimensions of the thread 
are specified in ГОСТ 6357-81, where the following notations are used (Figure 2.26): d is the outer diameter 
of the outer thread (pipe); d1 is the inner diameter of the outer thread; d2 is the average diameter of the outer 
thread; D1 is the outer diameter of the inner thread; D2 is the inner diameter of the inner thread (coupling); 
D is the average diameter of the inner thread (coupling); P is the thread pitch; H is the height of the initial 
triangle; H1 is the working height of the profile; R is the radius of curvature of the apex and the trough. 

The designation of a cylindrical pipe cutter consists of the letter G, the size of the cutter in inches, 
and the accuracy class of the medium diameter. As always, the designation is supplemented by the letters 
LH for left-handed threads. 

 
 



106 

Examples of symbolic notation: 
 
* 1 ¾ pipe cylindrical thread, accuracy class A ‒ G 1 ¾-A; 
* 1 ½ cylindrical pipe thread, left-hand, accuracy class B ‒ G 1 ½ LH-B. 
The fit is denoted by a ratio, the numerator of which is the accuracy class of the internal thread and 

the denominator is the accuracy class of the external thread: G 1 ¾ ‒ A/A; G 1 ¾ LH-A/B. 
The connection of an internal pipe cylindrical thread of accuracy class A according to ГОСТ 6357-

81 with an external pipe tapered thread according to ГОСТ 6211-81 is designated as follows:  G/R 1 ¾-A. 
The pipe tapered thread has a taper of 1:16 and is used in tapered threaded connections, as well as 

for connecting an external tapered thread to an internal cylindrical thread. The profile and main dimensions 
of the thread comply with ГОСТ 6211-81.  

The conventional symbol of a thread consists of the letters R (for tapered outer thread), Rc (for 
tapered inner thread), Rp (for cylindrical inner thread) and the thread size. The designation of the left-hand 
thread is supplemented by the letters LH. 

Examples of symbols: 
External pipe tapered thread 1½:  R1½; 
internal pipe tapered thread 1½:   Rc1½;  
internal pipe cylindrical thread 1½” (with tolerances according to ГОСТ 6211-81):  Rp1½; 
left-hand thread:  R½LH; Rc½LH; Rp1½ LH 
 

 
 
 
 
A threaded connection is designated by the ratio of the internal thread designation (numerator) to the 

designation of the external thread (denominator) and the size of the thread: 
‒ pipe tapered thread (internal- external) - Rc/R1¼ ; 
‒ internal pipe cylindrical thread of accuracy class A (ГОСТ 6357-81) and external pipe tapered 

thread - G/R ¼-A, G/R1¼LH-A 
A trapezoidal thread is a type of running thread. Its main purpose is to transmit movement in the 

forward and reverse directions and to transmit forces along the axis. The thread can be made in single or 
multi-pass. The basic profile common to external and internal threads and the dimensions of its elements 
(Figure 2.27) are established by ГОСТ 9484-81. 

The following dimensional designations are used: d - outer diameter of the outer thread (screw); D - 
outer diameter of the inner thread (nut); d2 . D2 are the average diameters of the outer and inner threads, 
respectively; d1 , D1 are the inner diameters of the outer and inner threads, respectively; P is the thread 
pitch; H is the working height of the original triangle; H is the working height of the profile. 

The trapezoidal single-step thread is used for diameters of 8...640 mm. Its main dimensions for these 
diameters are set by ГОСТ 24737-81, and nominal diameters and pitches are regulated by ГОСТ 24738-
81. The symbol for a single-step trapezoidal thread consists of the letters Tr, the nominal diameter of the 
thread pitch, and the designation of the middle diameter tolerance field (a number indicating the degree of 
accuracy and a letter indicating the main deviation). 

 
 

Figure  2.25. Metric thread profile Figure  2.26. Metric thread profile 
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Examples of symbolic notation: 
 
Trapezoidal single-step external thread with a diameter of 50 mm and a pitch of 8 mm is Tr50x8-7e;  
thread with the same parameters, internal ‒ Tr50x8-7H;  
thread with the same parameters for threaded connections - Tr50x8-7H/7e. 
The nominal diameters, pitches, strokes and tolerances of trapezoidal multi-tap threads are set forth 

in ГОСТ 24739-81, and their profile in ГОСТ 9484-81. 
he symbol for a trapezoidal multi-pass thread consists of the letters Tr, nominal diameter, stroke 

value, the letter P with the pitch value in parentheses, and the letters LH for the left-hand thread. For 
example, Tr20x8(P4) is a trapezoidal multi-thread with a nominal diameter of 20 mm, a stroke of 8 mm 
and a pitch of 4 mm. Left-hand thread with the same parameters: Tr20x8(P4)LH. 

The thrust thread (Figure 2.28) and its parameters (profiles, diameters, pitches and main dimensions) 
are regulated by ГОСТ 10177-82. 

The following designations are used for elements of this type of thread: d, D are the outer diameters 
of the outer thread (screw) and inner thread (nut), respectively; d2, D2 are the average diameters of the outer 
and inner threads, respectively; D1 is the inner diameter of the inner thread; P is the thread pitch; H is the 
height of the initial triangle; H1 is the working height of the profile; d3 is the inner diameter of the outer 
thread; h3 is the height of the profile of the outer thread; ac is the gap at the top of the thread; R is the radius 
of curvature in the hollow of the outer thread. 

The symbol of the stop thread consists of the letter S, the nominal diameter and the pitch value: 
S50x8. For the left-hand thread, the letters LH: S50x8LH. The stroke value and the letter P and the pitch 
value are added to the symbol of the multi-pass stop cutter in parentheses. For example, S50x20(P10) is a 
two-step thread with a pitch of 8 mm and a stroke of 20 mm. A left-hand thread with the same parameters 
is designated S50x20(P10)LH. 

The reinforced thrust thread according to ГОСТ 13535-87 has a 45° and 3° inclination of the profile 
sides. This is a single-step thread with diameters of 80...2000 mm. The symbols for this thread include the 
letter S, 45° inclination angle, nominal diameter, and pitch: S45 200x12. 

Round threads for sanitary fittings are characterized by a profile, main dimensions and tolerances 
established by ГОСТ 13536-68. The thread is intended for spindles, valves, mixers and toilet taps (ГОСТ 
19681-94). The symbol for a round thread consists of the letters Kr, nominal diameter, pitch designation 
and standard designation: Kp12x2.54 ГОСТ 13536-68 

 
 
 
 
 

 
 
 
 

Fig. 2.27. Trapezoidal thread Fig.  2.28. The thrust thread 
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2.3.2. Thread images on drawings 

ДСТ 2.311-68 establishes the rules for depicting threads and applying their designations in 
drawings. 

A thread on a rod is depicted by solid (main) lines along its outer diameter and by solid thin 
lines along its inner diameter (Figure 2.29, a). The thread in the hole is shown by the main lines 
along its inner diameter and by solid thin lines along the outer diameter (Figure 2.29, b). 

In the images obtained by projection onto a plane parallel to the axis of the rod or hole, a continuous 
thin line shall be drawn along the entire length of the cut without overlap, and in the images obtained by 
projection onto a plane perpendicular to the axis of the rod (hole), an arc open at any point, approximately 
equal to ¾ of the circumference, shall be drawn along the inner (outer) diameter with a continuous thin line 
(Figure 2.29). When depicting a cut, the thin line is applied from the main line at a distance of not less than 
0.8 mm and not more than the size of the cut pitch. 

An invisible thread is represented in the drawing by a dashed line of equal thickness along the outer 
and inner diameters (Figure 2.30, a). The line that defines the edge of the thread is drawn on the rod and in 
the hole at the end of the full profile of the thread (before the start of the match). The cut boundary is shown 
along the outer diameter line and is represented by the main solid thick line (Figure 2.30, b) or a dashed 
line if the cut is shown as invisible (Figure 2.31). 

Hatching in sections and cross-sections is carried out to a continuous baseline, that is, to the line of 
the outer diameter of the thread on the rod and the inner diameter in the hole (Figure 2.31). As a rule, the 
lengths of the threads on the rod and in the hole are shown without coincidence of the threads (Figure 2.32, 
a ). If necessary, the lengths of the threads are shown with the coincidence, and the dimensions are given 
as shown in Figure 2.32, b.  The coincidence of the cut is depicted as a solid thin straight line (Figure 2.32, 
b, 2.33, a, c). The image of the undercut of the cut is shown in Figure 2.33, a, c.  The undercut may be 
depicted as shown in Figure 2.33, b, d. 

 

 
b            b 

 
 
 
 

 
a        b 

Fig. 2.31. Depiction of cutters: 
а ‒ in the hole, b ‒ on a rod 

Fig. 2.29. Depiction of cutters: 
а ‒ on a rod, b ‒ in the hole 

Fig. 2.30. Depiction of cutters: 
а ‒ invisible thread, b ‒ thread border 
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a         b 

Fig. 2.32. Thread length: 
а ‒ in the hole, b ‒ on a rod 

 
 

a        b                  c   d 

Fig. 2.33. Image of the undercut: 
а, b ‒ on a rod, c, d  ‒ in the hole 

The main plane of the tapered thread on the rod is shown, if necessary, as a solid thin line (Figure 
2.34, a). In drawings where no thread is made, the end of a blind tapped hole may be shown as shown in 
Figure 2.34, b, c, even if there is a difference between the depth of the hole and the length of the thread. 
Chamfers that do not have a special structural purpose on the rod and in the tapped hole shall not be shown 
in the projection onto a plane perpendicular to the axis of the rod or hole. A continuous thin line of the 
image of the cut on the rod shall intersect the line of the chamfer boundary (Figure 2.35). 

 

 

a           b      c 

Fig. 2.34. Image of a tapered thread on a rod: 
а ‒ main area, b ‒ no threading is performed 

A thread with a non-standard profile (Figure 2.36) is depicted with all the dimensions required for 
its manufacture ‒ pitch, recess width, outer and inner diameters, maximum deviations, etc. In addition to 
these parameters, the drawing shows additional data on the number of turns and direction (for the left-hand 
thread). 

In the sections of a threaded connection, only the part of the thread that is not covered by the rod cut 
is shown in the image on a plane parallel to its axis in the hole (Figure 2.37). 

When a thread is cut, a special technological element is made on the rod and in the hole to allow the 
threading tool to exit ‒ a groove (an annular groove on the rod or an annular gouge in the hole - Tables 2.14 
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and 2.15). Cut designations in the drawings are shown in accordance with the relevant dimensional and 
tolerance standards and refer to the outer diameter of the cut for all cuts (Figure 2.38), except for tapered 
and cylindrical pipe cuts. The dimensions of overlaps, undercuts and flutes for external and internal metric 
cuts must comply with ГОСТ 27148-86 (Figure 2.39). 
 

 

Fig. 2.35. Image of chamfer on the rod and in the hole 

 

Fig. 2.36. Image of a thread with a non-standard profile 

 

Fig. 2.37. Image of threaded connection sections 
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Fig. 2.38. Thread designation in drawings 

Type 1 
 

 
Fig. 2.39. Image of external and internal metric thread grooves 
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Table 2.14 

Sizes of grooves and chamfers of external metric threads 

Dimensions in millimeters 

Table 2.15 

Sizes of grooves and chamfers of internal metric threads 

Dimensions in millimeters 

  

Thread 
pitch Р 

Type 1 
Type 2 

Df 
Chamfer  с Undercut 

Groove 
Normal Narrow 

Type  1 Type  2 Normal Reduced 
f R R1 f R R1 f R2 

0,4 1,0 0,3 0,2 - - - - - d-0,6 0,3 - 1,0 0,8 
0,45 1,0 0,3 0,2 - - - - - d-0,7 0,3 - 1,0 0,8 
0,5 1 6 05 03 1 0 03 D? - - d-0,8 0,5 - 1,6 1,0 
0,6 1,6 0,5 0,3 1,0 0,3 0,2 - - d-0,9 0,5 - 1,6 1,0 
0,7 2,0 0,5 0,3 1,6 0,5 0,3 - - d-1,0 0,5 - 2,0 1,6 
0,75 2,0 0,5 0,3 1,6 0,5 0,3 - - d-1,2 1,0 - 2,0 1,6 
0,8 3,0 1,0 0,5 1,6 0,5 0,3 - - d-1,2 1,0 - 3,0 1,6 
1,0 3,0 1,0 0,5 2,0 1,0 0,5 3,6 2,0 d-1,5 1,0 2,0 3,0 2,0 
1,25 4,0 1,0 0,5 2,5 1,0 0,5 4,4 2,5 d-1,8 1,6 2,5 4,0 2,5 
1,5 4,0 1,0 0,5 2,5 1,0 0,5 4,6 2,5 d-2,2 1,6 3,0 4,0 2,5 
1,75 4,0 1,0 0,5 2,5 1,0 0,5 5,4 3,0 d-2,5 1,6 3,5 4,0 2,5 
2,0 5,0 1,6 0,5 3,0 1,0 0,5 5,6 3,0 d-3,0 2,0 3,5 5,0 3,0 
2,5 6,0 1,6 1,0 4,0 1,0 0,5 7,3 4,0 d-3,5 2,5 5,0 6,0 4,0 
3,0 6,0 1,6 1,0 4,0 1,0 0,5 7,6 4,0 d-4,5 2,5 6,5 6,0 4,0 
3,5 8,0 2,0 1,0 5,0 1,6 0,5 10,2 5,5 d-5,0 2,5 7,5 8,0 5,0 
4,0 8,0 2,0 1,0 5,0 1,6 0,5 10,3 5,5 d-6,0 3,0 8,0 8,0 5,0 

Thread 
pitch Р 

Type  1 
Type  2 

df 
Chamfer  с Undercut 

Groove 
Normal Narrow 

Type  1 Type  2 Normal Reduced 
f R R1 f R R1 f R2 

0,4 - - - - - - - - - 0,3 - 2,0 1,8 
0,45 - - - - - - - - - 0,3 - 2,0 1,8 
0,5 2 0,5 0,3 1,0 0,3 0,2 - - d+0,3 0,5 - 3,5 3,0 
0,6 - - - - - - - - - 0,5 - 3,5 3,0 
0,7 - - - - - - - - - 0,5 - 3,5 3,0 
0,75 3,0 1,0 0,5 1,6 0,5 0,3 - - d+0,4 1,0 - 4,0 3,2 
0,8 - - - - - - - - - 1,0 - 4,0 3,2 
1,0 4,0 1,0 0,5 2,0 0,5 0,3 3,6 2,0 d+0,5 1,0 2,0 5,0 3,8 
1,25 5,0 1,6 0,5 3,0 1,0 0,5 4,5 2,5 d+0,5 1,0 2,0 5,0 3,8 
1,5 6,0 1,6 1,0 3,0 1,0 0,5 5,4 3,0 d+0,7 1,6 2,5 6,0 4,5 
1,75 7,0 1,6 1,0 4,0 1,0 0,5 6,2 3,5 d+0,7 1,6 3,0 7,0 5,2 
2,0 8,0 2,0 1,0 4,0 1,0 0,5 6,5 3,5 d+1,0 2,0 3,0 8,0 6,0 
2,5 10,0 3,0 1,0 5,0 1,6 0,5 8,9 5,0 d+1,0 2,5 4,0 10,0 7,5 
3,0 10,0 3,0 1,0 6,0 1,6 1,0 11,4 6,5 d+1,2 2,5 4,0 - 9,0 
3,5 10,0 3,0 1,0 7,0 1,6 1,0 13,1 7,5 d+1,2 3,0 5,5 - 10,5 
4,0 12,0 3,0 1,0 8,0 2,0 1,0 4,3 8,0 d+1,5 3,0 5,5 - 12,5 
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2.3.3. Fastening threaded parts 

2.3.3.1. Technical requirements for fasteners  

ГОСТ 1759.0-87 establishes requirements for the mechanical properties of fasteners, types and 
symbols of coatings for them, marking, packaging of products and their symbols. 

The accuracy of fasteners can be coarse (class C), normal (class B), and high (class A). Fasteners are 
produced uncoated or coated. The thickness of the coating for a particular type of material is selected in 
accordance with ГОСТ 9.303-84. 

If the individual parts of an assembly are joined together with screws or pins, a smooth through hole is 
made in one of the parts. If you use bolted or riveted connections, you must make through smooth holes for 
the fasteners in both parts to be joined. The diameters of the holes for fasteners are chosen slightly larger 
than the nominal diameters of the fasteners to ensure free assembly at the specified accuracy. Table 2.16 
shows the diameters of through holes for fasteners in accordance with ГОСТ 11284-75. 

Table 2.16 

Diameters of holes for fasteners 

Dimensions in millimeters 

Continuation of the table 2.16 

2.3.3.2. Conventional designations of fasteners 

According to ГОСТ 1759.0-87, full symbols for bolts, screws and studs made of carbon steels of 
strength classes 4...8 and 04 and fasteners made of non-ferrous metals are given in the following diagram: 

Bolt A2M20x1.5-LH-6gx60.58.S.029 ГОСТ..., 
Where A ‒ accuracy class; 2 ‒ version; M20 ‒ thread diameter, mm; 1.5 ‒ small thread pitch, mm; 

LH ‒ thread direction; 6g ‒ thread tolerance field; 60 ‒ bolt length, mm; 58 ‒ strength class (no dot between 
the numbers) or group; C ‒ indication of the use of calm steel; 02 ‒ numerical designation of the type of 
coating; 9 ‒ coating thickness, μm; ГОСТ... ‒ the number of the standard for the design and dimensions of 
the part. 

The designation does not include version 1, large cut pitch, right-hand cut, no coating, parameters 
that are clearly defined by the standards for specific fasteners, or accuracy class B if the standard for specific 
fasteners provides for two accuracy classes (A and B). To indicate that a product is made of automatic steel, 
the letter A is placed after the number indicating the strength class. 

If the standard for specific fasteners provides for three accuracy classes, the corresponding letter 
should be put in the symbol before the performance (A - increased accuracy class, B - normal, C - coarse). 
Technical requirements for bolts, studs and nuts with a thread diameter of more than 48 mm are set out in 
ГОСТ 18126-94. 

Diameters of the rods 
of fasteners 

Diameters of through holes Diameters of the rods of 
fasteners 

Diameters of through holes 
1st line 2st   line 3st   line 1st   line 2st   line 3st   line 

2,0 2,2 2,4 2,6 18 19 20 21 
2,5 2,7 2,9 3,1 20 21 22 24 
3,0 3,2 3,4 3,6 22 23 24 26 
4,0 4,3 4,5 4,8 24 25 26 28 
5,0 5,3 5,5 5,8 27 28 30 32 
6,0 6,4 6,6 7,0 30 31 33 35 
7,0 7,4 7,6 8,0 33 34 36 38 
8,0 8,4 9,0 10,0 36 37 39 42 

Diameters of the rods 
of fasteners 

Diameters of through holes Diameters of the rods of 
fasteners 

Diameters of through holes 
1st line 2st   line 3st   line 1st   line 2st   line 3st   line 

10,0 10,5 11,0 12,0 39 40 42 45 
12,0 13,0 14,0 15,0 42 43 45 48 
14,0 15,0 16,0 17,0 45 46 48 52 
16,0 17,0 18,0 19,0 48 50 52 56 
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The symbols for bolts, studs and nuts with a thread diameter of more than 48 mm include the 
following data: part name; accuracy class; version (version 1 is not shown); thread diameter; thread pitch 
(large is not shown); thread diameter tolerance margin; bolt or stud length; material group; indication of 
the use of calm steel; type of coating; coating thickness; design standard number; part dimensions. 

2.3.4. Design and dimensions of elements of fastening threaded products 

The basic dimensions of hexagonal bolt heads, screws and screws, as well as hexagonal nuts, are set 
forth in ГОСТ 24671-84. 

2.3.4.1. Bolts 

A bolt is a cylindrical rod with a head at one end and a thread at the other. A nut is screwed onto the 
threaded part of the bolt. Bolts are distinguished by: the shape and size of the head, the shape of the rod, 
the pitch of the thread, the nature of the design (Figure 2.40, 2.41, 2.42), and the accuracy of manufacturing. 

 

 
Fig. 2.40. Bolts of accuracy class (normal, coarse) 
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Fig. 2.41. Bolts with hexagonal head shape 

Depending on the working conditions and purpose, bolt heads can have hexagonal, semicircular, and 
countersunk shapes. Bolts with hexagonal and hexagonal reduced heads and hexagonal reduced head and 
guide subhead are produced in normal, increased and coarse accuracy (accuracy classes B, A, C, 
respectively). They differ in the cleanliness classes of the threaded surface, cylindrical rod, and head support 
surface. Figure 2.40 shows bolts of accuracy class B (normal accuracy) and shows bolts of accuracy class 
C (coarse accuracy). 

 

 

Fig. 2.42. Bolts with semicircular head shape 
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Depending on the working conditions and purpose, bolt heads can have hexagonal, semicircular, and 
countersunk shapes. Bolts with hexagonal and hexagonal reduced heads and hexagonal reduced head and 
guide subhead are produced in normal, increased and coarse accuracy (accuracy classes B, A, C, 
respectively). They differ in the cleanliness classes of the threaded surface, cylindrical rod, and head support 
surface. Figure 2.40 shows bolts of accuracy class B (normal accuracy) and bolts of accuracy class C (coarse 
accuracy). 

Depending on the version, the bolts can be made with a cotter pin hole in the rod or with two holes 
in the head. To ensure the exact relative position of the parts, bolts are provided with a hexagonal reduced 
head for reamer holes. Semicircular head are made with a whisker, and bolts with an enlarged semicircular 
head are made with a whisker or a square subhead. Countersunk head bolts can also be with a whisker or 
with a square socket head, and enlarged countersunk head bolts can be with a square socket head. Bolts 
with semicircular and enlarged semicircular heads, as well as countersunk and enlarged countersunk heads, 
are made of accuracy class C. Tire bolts are made with a thread with a diameter of M10 of accuracy clas. 

The design and dimensions of bolts are determined by state standards. For example, bolts with a 
hexagonal head: 

accuracy class В 
(execution 1…4)  ГОСТ 7798-70 
accuracy class А 
(execution 1…4)  ГОСТ 7805-70 
accuracy class С 
(execution 1)  ГОСТ 15589-70 
All types of bolts are manufactured with a metric thread, which is obtained by tapping or rolling. 
Hexagonal head bolts (Table 2.17) can have large or small pitch threads; however, the standard 

provides for only one large pitch for each diameter. 
 

Examples of conventional symbols: 
 

version 1 bolt, thread diameter d=20 mm, length L=90 mm, large thread pitch, tolerance field 6g, 
strength class 5.8, uncoated- 

Bolt М20-6gх90.58 ГОСТ 7798-70; 
bolt version 3, thread diameter d = 20 mm, length L = 90 mm, with a small thread pitch, with a 

tolerance field of 6g, strength class 10.9, made of 40X steel, coated with 01, 9 microns thick- 
Bolt3М20х1.5-6gх90.109.40Х.019 ГОСТ 7798-70 
In engineering practice, special bolts are also used, for example, folding, foundation, and eyebolts. 

Table 2.17 

Basic dimensions of hexagonal head bolts (ГОСТ 7798-70) 

Dimensions in millimeters 

d S H D r l0 l 
6 10 4 10,9 0,25-0,6 18 8-90 
8 13 5,5 14,2 

0,4-1,1 
22 8-100 

10 17 7 18,7 26 10-150 
12 19 8 20,9 

0,6-1,6 
30 14-150 

14 22 9 23,9 40 16-150 
16 24 10 26,2 38 20-150 
18 27 12 29,6 

0,8-2,2 

42 23-150 
20 30 13 33,3 46 25-150 
22 32 14 35 

54 
30-150 

24 36 15 39,6 35-150 
27 41 17 45,2 

1,0-2,7 
65 35-150 

30 46 19 50,9 66 40-150 
 

Notes: Bolt lengths l are selected from the following range: 8; 10; 12; 14; 16; [20; 25; 30; 35; 40; 45; 50; 55; 60; 
65; 70; 75; 80; 90; 100; 110; 120; 130; 140; 150] 
(20 ‒ 75)  ending in 0 і 5 
(80 ‒ 150)  ending in 0. 
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2.3.4.2. Studs 

A threaded part, which is a cylindrical rod with a thread at both ends, is called a stud. Studs are 
available in accuracy classes A and B in two versions. The diameter of the rod of studs of version 2 is 
approximately equal to the average diameter of the thread. 

Conventional designations of stud elements (Figure 2.43, Table 2.18): d ‒ nominal diameter of the 
thread; P ‒ thread pitch; d1 ‒ diameter of the rod; l ‒ length of the stud; 11 ‒ length of the screwed-in 
threaded end; 10 ‒ length of the threaded end of the nut. Length 11 depends on the material of the part into 
which the stud is screwed. For hard materials 11 is equal to d and 1.25d, for soft materials - 1.6d, 2d, 2.5d. 

 

 
Fig. 2.43. Conventional designations of studs 
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Stud designs and dimensions are defined by standards: 
With screwed end of length d: 
accuracy class B   ГОСТ 22032-76 
the same, А   ГОСТ 22033-76 
With screwed end 1.25 d long: 
accuracy class B   ГОСТ 22034-76 
the same, А   ГОСТ 22035-76 
With screwed end 1.6 d long: 
accuracy class B   ГОСТ 22036-76 
the same, А   ГОСТ 22037-76 
With a screwed end 2 d long: 
accuracy class B   ГОСТ 22038-76 
the same, А   ГОСТ 22039-76 
With a screwed end 2.5 d long: 
accuracy class B   ГОСТ 22040-76 
the same, А   ГОСТ 22041-76 
For parts with smooth holes : 
precision class B   ГОСТ 22042-76 
same, A    ГОСТ 22043-76 
Studs in accordance with ГОСТ 22032-76... ГОСТ 22041-76 are manufactured with a nominal 

thread diameter of 2...48 mm: with a large thread pitch at the nut and screwed ends; with a small thread 
pitch at the screwed end and a large one at the nut end; with a large thread pitch at the screwed end and a 
small one at the nut end. 

Table 2.18 

Basic dimensions of studs (ГОСТ 22032-76.... ГОСТ 22041-76) 

Dimensions in millimeters 

 
Threads - according to ГОСТ 24705-81, thread tolerance field 6g - according to ГОСТ 16093-81, 

thread matches - according to ГОСТ 27148-86. Technical requirements - according to ГОСТ 1759.0-87. 
 

d 
P 

d1 l1 = d l1 = 1,25d l1 = 1,6d l1 = 2d l1 = 2,5d 
big small 

2 0,4 - 2 3 3 3,2 4 5 
2,5 0,45 - 2,5 3 4 4 5 6 
3 0,5 - 3 3 4 5 6 7,5 
4 0,7 - 4 4 5 6,5 8 10 
5 0,8 - 5 5 6,5 8 10 12 
6 1 - 6 6 7,5 10 12 16 
8 1,25 1 8 8 10 14 16 20 

10 1,5 1,25 10 10 12 16 20 25 
12 1,75 1,25 12 12 15 20 24 30 

(14) 2 1,5 14 14 18 22 28 35 
16 2 1,5 16 16 20 25 32 40 

(18) 2,5 1,5 18 18 22 28 36 45 
20 2,5 1,5 20 20 25 32 40 50 

(22) 2,5 1,5 22 22 28 35 44 55 
24 3 2 24 24 30 38 48 60 

(27) 3 2 27 27 35 42 54 68 
30 3,5 2 30 30 38 48 60 75 
36 4 3 36 36 45 56 72 88 
42 4,5 3 42 42 52 68 84 105 
48 5 3 48 48 60 76 95 120 

Notes:  1. The length of the studs l is selected from the following range: 10; 12; 14; 16; (18); 20; (22); 25; 28; 30; 
(32); 35; (38); 40; (42); 45; (48); 50...120 with an ending in 0 or 5. 
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Examples of conventional symbols: 
 
Stud with screwed end, length d, accuracy class B (ГОСТ 22032-76), version 1, with a thread 

diameter d = 20 mm and a large pitch P = 2.5 mm, tolerance field 6g, length 1 = 150 mm, strength class 
5.8, uncoated 

Stud M20-6g x 150.58 ГОСТ 22032-76.Stud with screwed end 2.5 d long, accuracy class B, version 
1, with thread diameter d = 20 mm, with small pitch P = 1.5 mm at the screwed end, with large pitch  
P = 2.5 mm at the nut end, with a tolerance field of 6g, length 1 = 160 mm, strength class 6.6 with a coating 
of 0.5. 

Stud M20 x 1.5 /2.5-6g x 160.66.05 ГОСТ 22040-76. 

2.3.4.3. Nuts 

A nut is a product that has a threaded hole for screwing onto a bolt or stud. Nuts are classified 
according to their surface shape, design, thread pitch, and manufacturing accuracy. 

Hexagonal nuts, round nuts, cap nuts and wing nuts are distinguished by their surface shape. 
Hexagonal nuts are the most widely used, and they are manufactured in accuracy classes A, B, C (high, 
normal, and coarse accuracy). The accuracy class determines the cleanliness of the individual nut surfaces. 

Hexagonal nuts (Table 2.19) are divided by design into ordinary, slotted and crowned, normal, low, 
high and extra high (Figure 2.44). 

Table 2.19 

Dimensions of hexagonal nuts of accuracy class B (ГОСТ 5915-70) 

Dimensions in millimeters 

Nominal 
thread 

diameter d 

Thread pitch Р 

S e da dwmin hw m 
big small 

1,6 0,35 - 3,2 3,3 1,6...1,84 2,9 0,1...0,2 1,3 
2 0,4 - 4 4,2 2...2,3 3,6 0,1...0,2 1,6 

2,5 0,45 - 5 5,3 2,5...2,9 4,5 0,1...0,3 2 
3 0,5 - 5,5 5,9 3...3,45 5,0 0,1...0,4 2,4 

(3,5) 0,6 - 6 6,4 3,5...4 5,4 0,15...0,4 2,8 
4 0,7 - 7 7,5 4...4,6 6,3 0,15...0,4 3,2 
5 0,8 - 8 8,6 5...5,75 7,2 0,15...0,5 4 
6 1 - 10 10,9 6...6,75 9,0 0,15...0,5 5 
8 1,25 1 13 14,2 8...8,75 11,7 0,15...0,6 6,5 
10 1,5 1,25 17 18,7 10...10,8 15,5 0,15...0,6 8 
12 1,77 1,25 19 20,9 12...13 17,2 0,15...0,6 10 

(14) 2 1,5 22 23,9 14...15,1 20,1 0,15...0,6 11 
16 2 1,5 24 26,2 16...17,3 22,0 0,15...0,6 13 

(18) 2,5 1,5 27 29,6 18...19,4 24,8 0,15...0,6 15 
20 2,5 1,5 30 33 20...21,6 27,7 0,2...0,8 16 

(22) 2,5 1,5 32 35 22...23,8 29,5 0,2...0,8 18 
24 3 2 36 39,6 24...25,9 33,2 0,2...0,8 19 
27 3 2 41 45,2 27...29,2 38,0 0,2...0,8 22 
30 3,5 2 46 50,9 30...32,4 42,7 0,2...0,8 24 
36 4 3 55 60,8 36...38,9 51,1 0,2...0,8 29 
42 4,5 3 65 71,3 42...45,4 59,9 0,2...0,8 34 
48 5 3 75 82,6 48...51,8 69,4 0,25...0,8 38 

Notes:  
1. Nuts with dimensions in parentheses are not recommended. 
2. Thread ‒ according to ГОСТ 24705-81, technical requirements ‒ according to ГОСТ 1759-87. 
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Fig. 2.44. Types of hexagon nuts 

According to the nature of the design, nuts can be of three types: version 1 - with two external conical 
chamfers, version 2 - with one external conical chamfer, version 3 - with a cylindrical or conical protrusion 
on one end and without external chamfers (Figure 2.45). 

The design and dimensions of nuts are defined by standards. For example: 
Hex nuts: 
accuracy class B ГОСТ 5915-70 
same, A  ГОСТ 5927-70 
same, C  ГОСТ 15526-70 
 
Examples of conventional symbols: 
 
Nut version 1, with thread diameter d=16 mm, large thread pitch and tolerance field 6Н, strength 

class 5, uncoated 
Nut M16-6N.5 of ГОСТ 5915-70; 
the same, version 2, with a small cut pitch and a 6H tolerance field, strength class 12, made of 40X 

steel grade, with coating 01, 9 microns thick 
Nut 2M16x1.5-6N.12.40X.019 ГОСТ 5915- 
 

 

Fig. 2.45. Types of hexagon nuts 
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2.3.4.4. Screws 

A screw is a cylindrical rod with a head at one end and a thread for screwing into one of the parts to 
be joined at the other. According to their purpose, screws are divided into fastening and installation screws. 
Fastening screws are used for detachable connection of parts, and set screws are used for mutual fixation.  

 
Examples of conventional symbols: 
 
The design and dimensions of the screws are shown in Figure 2.46 and in Tables 2.20 and 2.21 

 

  
Fig. 2.46. Pan head screw 

Examples of conventional symbols: 
 

Cylindrical head screw (ГОСТ 1491-80) of accuracy class A, with thread diameter d = 8 mm, large 
thread pitch and tolerance field 6g, length l = 50 mm, normal thread length b = 22 mm, strength class 4.8, 
uncoated 

Screw A. M8-6g x 50.48 ГОСТ 1491-80; 
the same, accuracy class B, with a small cut pitch, increased cut length b = 34 mm, with a 6 μm thick 

zinc coating, chromated 
Screw B. M8 x 1-6g x 50-34.48.016 ГОСТ 1491-80. 

Тable 2.20 

Basic dimensions of cylindrical head screws (ГОСТ 1491-80) 

Dimensions in millimeters 

Nominal diameter of the 

thread  d 
4 5 6 8 10 12 14 16 18 20 

Thread pitch 

Р 

big 0,7 0,8 1 1,25 1,5 1,75 2 2 2,5 2,5 

small - - - 1 1,25 1,25 1,5 1,5 1,5 1,5 

Head diameter D 7,0 8,5 10,0 13,0 16,0 18,0 21,0 24,0 27,0 30,0 

Head height k 2,6 3,3 3,9 5,0 6,0 7,0 8,0 9,0 10,0 11,0 

Thread of 

cutting b 

elongated 22 25 28 34 40 46 52 58 64 70 

normal 14 16 18 22 26 30 34 38 42 46 
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Тable 2.21 

Standard lengths of cylindrical head screws 

Dimensions in millimeters 

Nominal screw 
length l 

Nominal diameter of the  thread  d 
4 5 6 8 10 12 14 16 18 20 

2 - - - - - - - - - - 
(2,5) - - - - - - - - - - 

3 - - - - - - - - - - 
(3,5) - - - - - - - - - - 

4  - - - - - - - - - 
5  - - - - - - - - - 
6   - - - - - - - - 

(7)    - - - - - - - 
8    - - - - - - - 
9    - - - - - - - 

10    - - - - - - - 
11    - - - - - - - 
12     - - - - - - 

(13)     - - - - - - 
14     - - - - - - 
16     - - - - - - 

(18)       - - - - 
20       - - - - 

(22)       - - - - 
25        - - - 

(28)        - - - 
30         - - 

(32)   
Standard 

length 

 - - 
35     - 

(38)     - 
40      

(42) -          
45 -          

 (48) -          
50 -          
55 - -         
60 - -         
65 - - -        
70 - - -        
75 - - -        
80 - - -        

(85) - - - -       
90 - - - -       

(95) - - - -       
100 - - - -       
110 - - - - - - - -   
120 - - - - - - - - -  

Notes.    
1. It is not recommended to use the screw lengths in brackets. 
2. The extended length of the thread is more acceptable. 
3. Screws with a rod length shorter than the length of the thread, taking into account the undercut, are 
manufactured with threads along the entire length of the rod. 

2.4.4.5. Washers 

These parts are installed under the nut or bolt head to prevent the material from scoring and crushing 
during tightening, as well as to prevent the fastener from self loosening. Washers are divided into round, 
locking, etc. 

The design and dimensions of washers are defined by standards. For example:  
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1. Round washers (Figure 2.47) ‒ ГОСТ 11371-78 (Table 2.22). 
 
Examples of conventional symbols: 
 
washer version 1 for fasteners with a diameter of 14 mm, a thickness specified in the standard, made 

of material 01, with a coating of group 01, 6 microns thick. 
Washer 14.01 .016 ГОСТ 11371-78 
 

          Execution 1  Execution 2 

 
Fig.  2.47. Round washers 

Тable 2.22 

Dimensions of round washers of accuracy class C and A (ГОСТ 11371-78) 

Dimensions in millimeters 

Diameter of the 
thread the 

fastening part 
d1 d2 S e c 

1 1,1 3,5 0,3 0,08…0,15 0,15 
1,2 1,3 4 0,3 0,08…0,15 0,15 
1,4 1,5 4 0,3 0,08…0,15 0,15 
1,6 1,7 4 0,3 0,08…0,15 0,15 
2 2,2 5 0,3 0,08…0,15 0,15 

2,5 2,7 6,5 0,5 0,13…0,25 0,25 
4 4,3 9 0,8 0,2…0,4 0,4 
3 3,2 7 0,5 0,13…0,25 0,25 
5 5,3 10 1,0 0,25…0,5 0,5 
6 6,4 12,5 1,6 0,4…0,8 0,8 
8 8,4 17 1,6 0,4…0,8 0,8 
10 10,5 21 2,0 0,5…1 1 
12 13 24 2,5 0,6…1,25 1,25 
14 15 28 2,5 0,6…1,25 1,25 
16 17 30 3,0 0,75…1,5 1,5 
18 19 34 3,0 0,75…1,5 1,5 
20 23 37 3,0 0,75…1,5 1,5 
22 23 39 3,0 0,75…1,5 1,5 
24 25 44 4,0 1…2 2 
27 28 50 4,0 1…2 2 
30 31 56 4,0 1…2 2 
36 37 66 5,0 1,25…2,5 2 
42 43 78 7,0 1,75…3,5 2,1 
48 50 92 8,0 2…4 2,4 
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2. Spring washers (Figure 2.48) ‒ ГОСТ 6402-70 (Table 2.23). 
 

            Execution 1     Execution 2 

 
Fig..2.48. Spring washers 

Таble 2.23 

Spring washers (ГОСТ 6402-70) 

Dimensions in millimeters 

Nominal thread 
diameter of 

bolt, screw, stud 
d 

Types of washers 

Lightweight washers 
Normal 

washers (Н) 
Heavy 

washers (В) 
Extra heavy 

washers (ОВ) k, not more 
than 

b s b=s b=s b=s 
2 2,1 0,8 0,5 0,5 0,5 0,6  

2,5 2,6 0,8 0,6 0,6 0,6 0,8  
3 3,1 1,0 0,8 0,8 0,8 1,0  

3,5 3,6 1,0 0,8 1,0 1,0 - 
0,15 4 4,1 1,2 0,8 1,0 1,0 1,4 

5 5,1 1,2 1,0 1,2 1,2 1,6 
6 6,1 1,6 1,2 1,4 1,4 2,0 

0,2 
7 7,2 2,0 1,6 2,0 2,0 - 
8 8,2 2,0 1,6 2,0 2,0 2,5 

0,3 
10 10,2 2,5 2,0 2,5 2,5 3,0 
12 12,2 3,5 2,5 3,0 3,0 3,5 0,4 
14 14,2 4,0 3,0 3,2 4,0 4,5 

0,4 
16 16,3 4,5 3,2 3,5 4,5 5,0 
18 18,3 5,0 3,5 4,0 5,0 5,5 
20 20,5 5,5 4,0 4,5 5,5 6,0 
22 22,5 6,0 4,5 5,0 6,0 7,0 
24 24,5 6,5 4,8 5,5 7,0 8,0 

0,5 
27 27,5 7,0 5,5 6,0 8,0 9,0 
30 30,5 8,0 6,0 6,5 9,0 10,0 

0,8 

33 33,5 10,0 6,0 7,0 - - 
36 36,5 10,0 6,0 8,0 10,0 12,0 
39 39,5 10,0 6,0 8,5 - - 
42 42,5 12,0 7,0 9,0 12,0 - 
45 45,5 12,0 7,0 9,5 - - 
48 48,5 12,0 7,0 10,0 - - 

 
Notes: 

Spring washers can be manufactured in four types: 
Н ‒ normal with a square cross section; 
В ‒ heavy with a square cross section; 
ОВ ‒ extra heavy with a square cross section; 
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Examples of conventional symbols: 
 
washer version 1 for bolt, screw, stud with a diameter of 8 mm: 
normal steel grade 3X13 uncoated  
Washer 8 3X13 ГОСТ 6402-70 
lightweight of steel grade 65G with a 9 μm thick chromated cadmium coating  
Washer 8L 65G 029 ГОСТ 6402-70 

 

2.4. Assembly drawings 

2.4.1. Contents of the drawings 

According to ГОСТ 2.109-73, the assembly drawing contains: 
 ‒ an image of the assembly unit, which gives an idea of the location and interconnection of the 

components that are connected according to this drawing and provide the ability to assemble and control 
the assembly unit (it is allowed to place additional schematic images of connections and the location of the 
components of the product); 

 ‒ dimensions with maximum deviations and other parameters and requirements that are fulfilled 
and controlled according to this assembly drawing (it is allowed to indicate the dimensions of parts and 
maximum deviations that determine the nature of their conjugation as reference); 

 ‒ instructions on the nature of the mating of detachable parts of the product and on the methods of 
its implementation, if the accuracy of the mating is ensured not by the specified maximum dimensional 
deviations, but by selection, fitting, etc. (instructions may be given on the method of connecting non-
detachable parts);номери позицій складових частин, які входять до виробу; 

‒ overall dimensions of the product; 
‒ installation, connection and other reference dimensions; 
‒ technical characteristics of the product (if necessary); 
‒ coordinates of the center of mass (if required). 
If the technical characteristic of the product and the coordinates of the center of mass are specified 

in other design documents for this product (for example, in a dimensional drawing, technical specifications, 
etc.), they are not included in the assembly drawing. 

2.4.2. Development of drawings 

The completeness of the product image in the assembly drawing depends on the presence of the 
necessary views, sections, sections, and external elements. The number of views required is determined 
based on the complexity of the product. 

The number of views should be minimal, but sufficient to provide a complete picture of the product 
structure. To reduce the number of main views, it is recommended to use local and additional views. 

In most cases, assembly drawings are made with cuts that allow you to identify the nature of the 
connection of parts. Simple and complex, full and local sections are used. If the depicted product is 
projected in the form of a symmetrical figure, then it is advisable to combine half of the view with half of 
the section or part of the view and part of the section in one image. 

Often, cuts include solid parts (shafts, bolts, keys, pins, etc.) that are in contact with other parts of 
the product. When cross-sectioned in the longitudinal direction, such parts are conventionally shown uncut 
and not shaded. 

Movable parts of the product are generally shown in the working position in the drawings. They may 
also be shown in the end or intermediate position by using a thin dashed line with two points. The drawing 
shall be marked with the appropriate dimensions characterizing the different positions of the parts to be 
moved. If the depiction of these parts makes it difficult to read the drawing, they may be depicted in 
additional views with appropriate labels (for example, «End position of the caliper, item 3»). 
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2.4.3. Conventions and simplifications in the execution of drawings 

Assembly drawings should be made, as a rule, with simplifications that meet the requirements of the 
standards. 

Assembly drawings may not show: 
‒ chamfers, grooves, roundings, protrusions, recesses, corrugations, notches, braids and other small 

elements; 
‒ gaps between the hole and the rod that enters the hole; 
‒ covers, shields, enclosures, partitions, etc., if it is necessary to show the components of the product 

covered by them; in this case, a corresponding inscription is made above the image (for example, 
«Handwheel item 5 is not shown»);  

‒ visible component parts of products that are located behind a mesh or partially covered by 
component parts located in the front; 

‒ inscriptions on plates, branded strips, scales, and other similar parts, as well as marking technical 
data and inscriptions on the product (only the outline of the plate, strip, or scale is drawn). 

Products made of transparent material are depicted as opaque. Component parts of products and their 
elements located behind transparent objects may be depicted as visible (scales, dials, instrument hands, 
internal structure of lamps, etc.). 

Products located behind the helical spring shown in the sectional drawing are drawn conventionally 
only to the axial lines of the cross-section of the spring coils, taking into account that the spring covers the 
parts of the product located behind it. 

In sections of the assembly drawing, it is permissible to depict uncut components of products for 
which there are independently drawn assembly drawings.  

Standard, purchased, and other products shall be depicted with external contours. It is allowed to 
simplify the external contours of objects without depicting small protrusions, recesses, etc.  

In assembly drawings with images of several identical component parts (wheels, support rollers, 
etc.), it is allowed to show a full image of one part, and to give simplified images of other parts in accordance 
with the above requirements. 

A welded, brazed, or glued product made of a homogeneous material is drawn as a monolithic body 
in sections and cross-sections when assembled with other products, i.e., in one direction, showing the 
boundaries between parts as solid main lines (Figure 2.49). The boundaries between the parts can be 
omitted, i.e., the structure can be represented as a monolithic body. 

Seals in assembly drawings are allowed to be depicted conditionally, showing the direction of its 
action with an arrow (Figure 2.50) 

 
 
 
 
 
 
 

Fig. 2.49. Hatching when 
drawing a welded, soldered or 

glued product made of 
homogeneous material 

Fig. 2.50. Symbolic representation of seals 
in assembly drawings 
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2.4.4. Dimensioning 

The product is marked on the assembly drawing: 
 overall dimensions, which characterize the height, length and width of the product or its largest 

diameter; if any dimension is variable due to the movement of a part of the mechanism, the drawing 
indicates the dimensions at the extreme positions of the moving parts; 

 installation and connection dimensions, which show the location and dimensions of the elements 
in relation to which the product is installed at the installation site or connected to another product (diameters 
of center circles and bolt holes, distances between mounting holes, distances between axes of foundation 
bolts, etc;) indicating these dimensions, the location coordinates and dimensions with maximum deviations 
of the elements used to connect to the products to be joined are indicated; if the external connection is made 
by gears, the module, number and direction of the teeth are indicated; 

 assembly dimensions, which indicate the interconnection of parts and their relative position in the 
assembly unit (for example, the distance from the product axis to the plane on which it is mounted, 
mounting gaps, etc.); these dimensions are also given with maximum deviations; 

 operational dimensions that indicate the design and construction characteristics of the product (e.g., 
diameters of bore holes, thread sizes on connecting fittings, wrench dimensions, modulus and number of 
teeth, etc.). 

If necessary, the designer shows some characteristic structural or design dimensions on the product 
drawing to check them against the dimensions on the part drawings. As a rule, the dimensions of individual 
parts or elements are not shown on the assembly drawing, since the finished parts are delivered for 
assembly. Dimensions, installation, connection, operating, and those that characterize the position of 
moving parts of the product are for reference and are marked with an asterisk. 

In the assembly drawing, mark the dimensions of the holes for bolts, screws, pins, and rivets, if these 
holes are made during assembly. 

If it is necessary to show the position of the center of mass of the product, the corresponding 
dimensions are given in the drawing and the inscription «C.M.» is placed on the shelf of the line-extension. 
The lines of the centers of mass of the component parts of the product are drawn with a dashed line, and 
the inscription «C.M. line» is made on the shelf of the line-extension. 

2.4.5. Application of item numbers of component parts 

The component parts of an assembly unit are numbered according to the item numbers specified in 
its specification, i.e., first fill out the specification and then transfer the item numbers to the assembly 
drawing of the product. 

The item numbers are placed on the shelves of the footnote lines, which are drawn as thin solid lines 
and end with a thickening in the form of a dot on the part image. Position the item numbers parallel to the 
main drawing label outside the image contour and group them in a row or column, if possible on the same 
line. Footnote lines are drawn away from those images in which the component part is projected as visible, 
in preference to the main views or sections placed in place of the main views. 

As a rule, a part number is indicated once in a drawing. Repeated designation of item numbers for 
identical parts of the product is allowed. The font size used to write the item numbers should be one or two 
numbers larger than the font used for dimensional numbers in this drawing. Footnote lines should not, if 
possible, be parallel to the hatching lines of sections and cross-sections and should not intersect each other. 

It is permissible to draw a common line with a vertical arrangement of item numbers for a group of 
fasteners (bolt, nut, washer) that relate to the same fastening point and for a group of parts with a clear 
relationship if the line cannot be drawn from each component part (Figure 2.51). In these cases, the lead 
line is drawn from the fastening component. 
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Fig.  2.51. Drawing a general leader line with a vertical arrangement  
of item numbers for a group of fasteners 

If there are two or more fasteners and different component parts are fastened with the same parts, the 
number of fasteners may be indicated in parentheses after the number of the corresponding item and 
indicated only for one unit of the fastening component part, regardless of the number of these component 
parts in the product. 

It is also possible to draw a general line for individual component parts of the product if they are 
difficult to depict graphically. In this case, these component parts are not shown in the drawing, their 
location is determined by means of a line from the visible component part and the technical requirements 
contain a corresponding indication (for example, «Harnesses of item 10 under the brackets are wrapped 
with pressing span of item 18»). 

2.4.6. Performing individual views of assembly drawings 

If the assembly drawing of the product includes parts for which no working drawings have been 
issued, the image or technical requirements provide additional data to the information specified in the 
specification that is necessary for the manufacture of these parts (surface roughness, shape deviations, etc.). 

In assembly drawings of single products, it is allowed to provide data on the preparation of edges for 
permanent connections (welding, brazing, etc.) directly on the image or as a separate element (Figure 2.52), 
if this data is not provided in the detail drawings. 

 

Fig. 2.52. Drawing of data on edge preparation for non-separable joints 

Component parts of the product for which it is allowed not to produce drawings can be accounted 
for in two ways: as parts with a designation and name or as materials without a designation and name with 
an indication of length, weight and other parameters. 

If a certain section material is specified for the manufacture of a part of a simple configuration 
(without the production of an independent drawing for it) according to an assembly drawing, the 
corresponding dimensions of the part are given in the specification. When there is no need to specify a 
sectional material for a part, all dimensions are placed on the image of the part, and only the material grade 
is indicated in the specification. 

If a part has a complex configuration and significant dimensions and is connected to a part of a less 
complex configuration and smaller dimensions by pressing, soldering, welding, riveting or other similar 
methods, then, provided that the quality of the drawing and the production capabilities are maintained, it is 
allowed to place all dimensions and other data necessary for the manufacture and control of the main part 
on the assembly drawings of products and to issue drawings only for less complex parts. The name and 
designation of the main part is written in accordance with the general rules. 
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A reinforced part is an assembly unit made by surfacing a metal or alloy onto a part or by filling the 
surfaces of a part with metal, alloy, rubber, plastic, etc. A reinforced part consists of reinforcement and 
filler or welded material. The assembly drawing of a reinforced part shows the shape and dimensions for 
all elements of the product in its final form, indicates the dimensions of surfaces or elements to be surfaced, 
and provides other data necessary for manufacturing and inspection. 

Based on this data, the forming surfaces of the die and punch were designed with consideration for 
material shrinkage. The drawing of the reinforced part contains additional images of elements that are not 
visible on the main projections, with the corresponding dimensions. The drawing often contains instructions 
for additional machining of individual elements of the part. 

A specification is drawn up for the reinforcing part as an assembly unit, which is usually made on 
the same sheet as the drawing. If a separate drawing is made for a reinforcement, such as a handle rod, the 
dimensions of this part are not marked on the assembly drawing. The welded metal, alloy, plastic, rubber 
or other materials used to fill the reinforced parts are recorded in the assembly unit specification in the 
«Materials» section, indicating their weight in the «Quantity» column. 

2.4.7. Requirements for specifications 

The specification is the main design document. In general, a specification consists of sections that 
are arranged in the following sequence:  

1) documentation; 2) assembly units; 3) parts; 4) standard products; 5) materials. The presence of 
certain sections depends on the composition of the specified product. The name of each section, which is 
underlined, looks like a heading in the «Name» column.  

Let's consider the content and procedure for filling out each section. 
The «Documentatio» section includes the main set of design documents for the specified product 

(except for its specification), a list of operational documents and a list of repair documents, as well as the 
documents of the main set that are recorded in the specification of non-specified component parts, except 
for their working drawings. 

In this section, documents for specified products are recorded first, followed by documents for non-
specified components. The order of recording documents within the product designation corresponds to the 
sequence in which they are listed in ГОСТ 2.102-68. 

In the «Format» column, indicate the dimensions of the formats according to ГОСТ 2.301-68 on 
which the part drawings or other design documents are made, the designations of which are recorded in the 
«Designation» column. If the document is executed on several sheets of different formats, an asterisk is 
placed in the «Format» column, and all formats are listed in the «Note» column in ascending order. Do not 
fill in this column for documents recorded in the Standard Products, Other Products, and Materials sections. 
For parts for which no drawings have been issued, indicate in the column: «WD».  

In the «Item number» column, enter the serial numbers of the component parts that are directly 
included in the specified product, following the sequence in which they are written in the specification. For 
the «Documentation» and «Kits» sections, the column is not filled in. 

In the column «Designation» indicate: 
‒ in the section «Documentation» - designation of the recorded documents; 
‒ in the sections «Complexes», «Assembly units», «Parts» and «Kits» ‒ designations of the basic 

design documents for the products recorded in these sections, and for parts for which no drawings have 
been issued - the designation assigned to them. 

In the sections «Standard products», «Other products», and «Materials», the «Designation» column 
is not filled in. If design documentation has been issued for the manufacture of a standard product, the 
designation of the issued design document is entered in the Designation column. 

In the «Name» column write down:  
  in the «Documentation» section for documents that are part of the main set of documents for the 

specified product ‒ only the names of the documents (for example, «Assembly drawing», «Dimensional 
drawing», «Technical specifications»); 

 in the sections «Assembly Units», «Parts» ‒ the names of products in accordance with the main 
inscription on their main design documents, and for parts for which no drawings have been issued - their 
name and material, as well as the dimensions required for manufacture; 
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  in the section «Standard Products» ‒ names and designations of products in accordance with the 
standards for them: 

  in the «Materials» section ‒ the designation of materials established by standards or specifications 
for these materials; if a number of products and materials are recorded that differ in size and other data, but 
are used according to one document (and are recorded in the specification after the designation of this 
document), then it is allowed to record the general part of the name of these products or materials with the 
designation of the specified document in each specification sheet once in the form of a general name 
(heading); for each of these products and materials, only their parameters and dimensions are recorded 
under the general name; this simplification is not allowed to be used when the main parameters or 
dimensions of the product are indicated by only one number or letter; in these cases, the entry is made as 
follows: «washers of ГОСТ 18123-82»; «washer 3»; «washer 4», etc.  

In the column «Quantity» indicate: 
  for component parts of the product that are recorded in the specification ‒ the number of them per 

one specified product; 
  in the «Materials» section ‒ the total amount of materials for one specified product with indication 

of units of measurement; units of measurement may be recorded in the «Note» column in the immediate 
vicinity of the «Quantity» column. 

After each section of the specification, several free lines are left for additional entries (depending on 
the stage of development, the volume of entries, etc). It is also allowed to reserve the item numbers that are 
entered in the specification by filling in the reserve lines. 

When filling out the specification, it is allowed to combine it with the assembly drawing, provided 
that they are placed on an A4 sheet (ГОСТ 2.301-68). In this case, the specification is placed above the 
main inscription and filled in in the same order and form as the specification made on separate sheets. The 
combined document is assigned the designation of the main design document, i.e. the specification. The 
main inscription is made in accordance with ГОСТ 2.104-68 (Figure 2.2). 

2.5. Working drawings of parts 

2.5.1. General requirements 

A part is a product made of a material of a homogeneous type and grade. It is made without the use 
of assembly operations.  

A part is manufactured according to a working drawing or sketch.  
A working drawing of a part is a document that contains an image of the part and other data necessary 

for manufacturing and inspection. 
A working drawing of a part must have: 
a) a minimal but sufficient number of images (views, sections, cross-sections, and extensions) that 

fully reveal the shape of the part; 
b) required dimensions with their maximum deviations; 
c) requirements for surface roughness; 
d) designation of the maximum deviations of the shape and location of surfaces; 
e) data on the material, heat treatment, coating, finishing that the part must have before assembly; 
f) technical requirements, etc. 
Requirements for working drawings of parts are given in ГОСТ 2.109-73. 
The main ones are as follows: 
1) a separate drawing is made for each part on sheets of the established format according to ГОСТ 

2.301-68. The drawing must contain the main inscription in accordance with ГОСТ 2.104-68. The name of 
the part in the main inscription is written in the nominative singular. If the name consists of several words, 
the first name is a noun, for example; «Gear wheel»; 

2) the main inscription shall indicate the designation of the material from which the part is made and 
the standard number of this material; 

3) the mass of the part is indicated in the main inscription in kilograms without specifying the unit 
of mass, for example: 4,25. This number means that the mass of the part is 4.25 kg; 

4) the drawing of the part is made to scale in accordance with ГОСТ 2.302-68; 
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5) the working drawing shall indicate the dimensions, maximum deviations, surface roughness and 
other data that the part must have before assembly; 

6) parts made of transparent materials are depicted as opaque; 
7) working drawings for standard parts are not made; 
8) reamings are depicted in the drawings of parts of complex configuration made of sheet steel. 

Only those dimensions that cannot be indicated on the image of the finished part are shown. 

2.5.2. Designation of materials in the drawings 

Material designations are divided into two groups according to their content: 
a) designations that contain only a qualitative characteristic of the material of the part; 
b) designations that contain not only a qualitative characteristic of the material, but also a 

characteristic of the profile of the section material from which the part is made. 
Designations containing only a qualitative characteristic: this group includes designations of 

materials for parts whose design is determined by the drawing. For such parts, the designation does not 
provide for the use of long products, i.e., materials with a specific profile and dimensions (round, square, 
hexagonal, strip, angular, etc.). 

Material designations that characterize only its quality shall include: name and grade of material; 
number of the standard that contains the full characteristics of the specified grade of material. 

Conventional designations that also contain a description of the profile of a section material shall 
include: quality characteristics of the material; name of the section material; dimensional and quality 
characteristics of the profile; number of the state standard that specifies all requirements for the profile. 

 
Examples of part material symbols: 
 
1. Carbon steel of ordinary quality ‒ St3 of ГОСТ 380-2005. The number 3 indicates the serial 

number of the steel. 
2. Structural quality carbon steel ‒ Steel 20 of ГОСТ 1050-88; Steel 40G of ГОСТ 1050-88. 
The numbers 20, 40 indicate the average carbon content in hundredths of a percent, the letter «G» 

indicates an increased manganese content. 
3. High-quality steel ‒ Steel 30XNZA ГОСТ 4543-71. 
The first two digits indicate the carbon content in hundredths of a percent; the letters indicate the 

name of the additive (X ‒ chromium, N ‒ nickel, S ‒ silicon, M ‒ manganese, etc.). The number next to the 
letter on the right indicates the percentage of the additive. If the additive does not exceed 1%, the number 
is not indicated in the designation. The letter A, which is indicated at the end of the designation, indicates 
high quality steel. 

4. Hot-rolled steel hexagonal profile in accordance with ГОСТ 2879-88 (turnkey size) 22 mm, steel 
grade 25 in accordance with ГОСТ 1050-88: 

 

Hexagon 
22 ГОСТ 2879-88

25 ГОСТ 1050-88
 

 
5. From a square bar with a side of 40 mm in accordance with ГОСТ 2591-88, steel grade 20 in 

accordance with ГОСТ 1050-88: 
 

 Sguare 4 ГОСТ 2591-88
20 ГОСТ 1050-88

 
 

6. From a round bar of Ø20 mm in accordance with ГОСТ 2590-88, steel grade Ст3, manufactured 
in accordance with the technical requirements of ГОСТ 535-2005: 

 

 Сircle 20 ГОСТ 2590-88
Ст3 ГОСТ 535-2005
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7. From a strip 10 mm thick, 70 mm wide, made of strip steel of ГОСТ 103-76, steel grade Ст3, 
manufactured in accordance with the technical requirements of ГОСТ 535-2005: 

 

 Strip 10х70 ГОСТ 103-76
Ст3 ГОСТ 535-2005

 
 

8. From an equilateral angle with dimensions of 50x50x3 mm in accordance with ГОСТ 8509-93, 
steel grade Ст3, manufactured in accordance with the technical requirements of ГОСТ 535-2005: 

 

An equilateral corner 
50х50х3 ГОСТ 8509-93
Ст3 ГОСТ 535−2005

  
 
9. From the dvotavr I-beam No. 16 in accordance with ГОСТ 8239-89, steel grade Ст5, supplied 

according to the technical requirements of ГОСТ 535-2005: 
 

  Dvotavr
16 ГОСТ 8239-89

Ст5 ГОСТ ହଷହିଶ଴଴ହ
  

 
10. From schweller No. 12 in accordance with ГОСТ 8240-97, steel grade Ст4, manufactured in 

accordance with the technical requirements of ГОСТ 535-2005: 
 

Schweller
12 ГОСТ 8240−97

 Ст4 ГОСТ 535−2005
   

 
 

Control questions 
 

1. Which drawing is called a working drawing? 
2. Types of images and their number in the working drawing? 
3. What are the dimensions of the working drawing? 
4. What dimensions are put on the assembly drawing? 
5. What simplifications and conventions are used in the implementation of the assembly drawing? 
6. What types of welded joints exist and how are they indicated in the drawings?  
7. What simplifications are used in the designation of welds? 
8. What are the features in the designation of invisible welds? 
9. How are threaded and threaded connections depicted and labeled in the drawings? 
10. What simplifications are used to depict connections with standard threaded products? 
11. For which parts in the assembly drawing are drawings or sketches made? 
12. When a drawing or sketch is not made for a non-standard part? 
13. How are materials designations made in the drawings?   
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3.  GRAPHIC PRACTICUM 

3.1. Aims and objectives of graphic practicum 

Aims ‒ to acquire knowledge, skills and abilities to read working assembly drawings and drawings 
of products made with both detachable and non-detachable connections, and to draw them using computer 
graphics, using knowledge and skills in further education and future professional activities. 

Tasks ‒ using your knowledge of engineering and computer graphics, move on to the execution of 
drawings of products manufactured using both non-detachable and detachable assembly operations, 
constantly improving your ability to work with a graphic editor of computer graphics. 

3.2. Setting tasks 

3.2.1. Task 1. «Frame» 

According to the scheme shown in Figure 3.1 (Frame assembly scheme) and Table 3.1 of the 
options, determine the dimensions of the elements of the product «Frame». Create an assembly drawing of 
the product «Frame», draw up a specification for the product, and develop working drawings of the 
component parts using a computer graphic editor. 

Table 3.1 

Task variants 

Dimensions in millimeters 

Variant number a b c d Schweller number 
1  300 400 350 450 12 
2  250 300 300 500 12 
3  200 250 320 400 10 
4  400 300 350 300 18 
5  250 200 250 200 12 
6  300 250 250 450 14 
7  350 350 200 300 16 
8  400 250 400 400 14 
9  500 500 400 400 18 

10  400 500 300 350 16 
11  350 400 500 500 10 
12  250 400 350 300 14 
13  300 400 350 450 14 
14  250 300 300 500 10 
15  200 250 320 400 12 
16  400 300 350 300 16 
17  250 200 250 200 10 
18  300 250 250 450 10 
19  350 350 200 300 14 
20  400 250 400 400 18 
21  500 500 400 400 16 
22  400 500 300 350 18 
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Continuation of the table 3.1  

Variant number a b c d Schweller number 
23  350 400 500 500 14 
24  250 400 350 300 10 
25  300 400 350 450 16 
26  250 300 300 500 14 
27  200 250 320 400 14 
28  400 300 350 300 14 
29  250 200 250 200 14 
30  300 250 250 450 12 

 
 

Material schweller: 
№ ГОСТ 8240-97

Ст3пс3 ГОСТ 535-2005
   

 

 

Fig.  3.1. Frame assembly scheme 

The profile of rolled products and their structural elements are shown in Figure 3.2 and Table 3.2  
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Fig. 3.2. Schweller 

Table 3.2 

Main dimensions of the schweller profile 

Dimensions in millimeters 

Slope of the inner surface of the shelf 4÷10% 
 

Recommendations for execution 
 
1. Study the product diagram and find out the design features of each part. 
2. Find out the list of parts that do not require the production of working drawings. 
3. Calculate the dimensions of the parts in accordance with the specified parameters and mark the 

dimensions. 
4. Make a specification for the product. 
5. Perform a prefabricated drawing of the product with the specified number of types according 

to the task. 
6. Determine the types of welds and mark them on the drawing according to the standard. 
7. Identify the components of the product according to the specification. 
8. Depict the dimensional lines and put the necessary dimensions, identifying among them the 

working and reference ones. 
9. Make cuts along the specified cross-sectional planes. 
10. Perform surface machining after welding and annealing the product. 

3.2.2. Task 2. «Pneumatic cylinder» 

According to the scheme shown in Figure 3.3 (Scheme of the pneumatic cylinder) and Figure 3.4 
(Structural elements of the product) and tables 3.3 and 3.4 of the options, make drawings of the components 
of the product «Pneumatic cylinder», draw up a specification and make a assembly drawing of the product, 
using the recommended conventions and simplifications. Perform the task usinga computer graphic editor. 

 

Schweller 
number 

h m S n Dnом R r t 

10 100 46 4,5 30 11,0 7 3 7,6 
12 120 52 4,8 30 17,0 7,5 3 7,8 
14 140 58 4,9 35 17,0 8 3 8,1 
16 160 64 5,0 35 20,0 8,5 3,5 8,4 
18 180 70 5,1 40 20,0 9 3,5 8,7 
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Fig. 3.3. Scheme of the pneumatic cylinder 
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Fig. 3.4. Structural elements of the product 
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Table 3.3 
Pneumatic cylinders without braking, with external thread on the rod end, with metric connection thread, piston diameter D=40...320 mm 

Dimensions in millimeters 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Designation of the 
cylinders 

D d 

D1 
deviation 

limits  
 h8 

d1 d2 d3 A В l l1 l2 m h h1 К К1 

S 
deviatio
n limits 

h12 

Stroke of 
the piston 

L 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 
1011-040 40 12 45 

M12*1,5 
M8 M6 42 55 20 20 20 

12,5 12 
4 

98 127 10 40…160 
1011-050 50 

16 52 M10 M8 
52 70 

25 24 25 106 143 14 
40…125 

1011-063 63 60 78 5 40…125 

1011-80 80 

25 65 

M12*1,5 

M16 

M8 75 92 

32 28 

28 12,5 

13 

5 

110 150 

22 

40…160 

1011-100 100 M12*1,5 M10 92 115 35 12,5 110 160 40…160 

1011-125 125 32 75 M16*1,5 M20 M12 110 140 40 35 42 15 18 120 180 27 40…250 

1011-160 160 40 85 M16*1,5 M24 M16 140 180 50 38 52 15 22 

8 

120 193 36 40…250 

1011-200 200 50 110 M18*1,5 M30 

M20 

172 220 

60 

45 62 17,5 29 132 220 45 50…250 

1011-250 250 60 115 M18*1,5 M36 210 275 55 70 17,5 35 150 245 55 50…360 

1011-320 320 80 135 M24*1,5 М48 М24 265 345 80 77 80 20 55 10 160 270 75 50…400 
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Table 3.4 

Standard products 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Diameter of the 
piston 
D,мм 

Nut  GОSТ 
5915-70 
(pos.1) 

Washer 
ГОСТ 

11371-78 
(pos.2) 

Washer 
ГОСТ 6402-

70 
(pos.19) 

Screw ГОСТ 1491-80 
 

(pos.3) 

Cuff ГОСТ 
 6678-72 
(pos.7) 

Ring ГОСТ 
9833-73 
(pos.9) 

Cuff ГОСТ  
6678-72 
(pos.12) 

Ring ГОСТ 
9833-73 
(pos.13) 

Nut ГОСТ 
5915-70 
(pos.15) 

40 М6 6 6 М4х10.56.019 1-040-3 034-040-36 2-12-3 005-008-19 М8 

50 

М8 8 8 
М4х10.56.019 

1-050-3 044-050-36 2-16-3 008-012-25 М10 

63 1-063-3 057-063-36 2-16-3 008-012-25 М10 

80 

М5*12.56.019 

1-080-3 074-080-36 2-25-3 014-018-25 М16 

100 М10 10 10 1-100-3 094-100-36 2-25-3 014-018-25 М16 

125 М12 12 12 1-125-3 118-125-46 2-32-3 018-022-25 М20 

160 М16 16 16 М6*14.56 019 1-160-3 150-160-46 2-40-3 020-025-30 М24 

200 
М20 20 20 

М8*20.56.019 

1-200-3 190-200-46 2-50-3 026-032-36 М30 

250 1-250-3 240-250-58 2-63-3 034-040-36 М36х3 

320 М24 24 24 1-320-3 310-320-58 2-80-3 044-050-36 М48х3 
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Rings for pneumatic cylinders D=40...320 mm (pos. 4)   Covers for pneumatic cylinders D=40...320 mm (pos. 5) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1. Material: sheet 
 GОSТ 19903ି74

St3 GОSТ 14637ି89
      1. Material: steel 35 GОSТ1050-88 

2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14
   2. Unspecified maximum dimensional deviations: H14,h14,

2

JT14
  

D D1 D2 D3 S 
40 13 19 25.5 

1.0 

50 17 22 31.5 
80 26 34 41.5 

125 33 40 47.5 
160 41 48 57.5 
200 51 61 69.5 
250 64 70 82.5 
320 81 90 99,5 

D D2 D3 D4 D5 d d1 l l1 h D1 h1 

40 26 44 34 13 
5 8 9 3 3,5 

Take  
accordingly 
Table 3.5 

50 32 51 40 17 
80 42 64 52 26 

6 10 11 
4 

4 
125 48 72 58 33 
160 58 84 70 41 7 11 12 5 
200 70 108 88 51 

9 14 
13 

6 250 80 114 96 64 14 5 
320 100 134 114 81 13 4,5 
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Front covers for pneumatic cylinders D=40, 50 and 63 mm (pos. 6) 

 
 

D D2 D3   
deviation 
limits H8 

D4 

D5  
deviation 

limits 
H7 

D6 A B d1 l-0,1 l1 l2 l3 h+0,2 r 
D1 

deviation 
limits h8 

R α 
h1 

deviation 
limits h12 

R1 deviation limits 
h8 

40 45 26 26 22 34 42 55 7 42 12 7,5 27 16 6 Take  
accordingly 
Table 3.6 

50 
52 32 34 28 40 

52 70 
9 43 15 8 35 14 

8 
63 60 78 9 

 

1.   Material: aluminum alloy D1 ГОСТ 4784-97  2.    Unspecified maximum dimensional deviations: H14,h14,
2

JT14

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Front covers for pneumatic cylinders D=80, 100 and 125 mm (pos. 6) 

 

1. Material: Cast iron СЧ 21 ГОСТ 1412-85  2.   Unspecified maximum dimensional deviations: H14,h14,
2

JT14
  

D D2 D3  
deviation 
limits H8 

D4 
D5  

deviation 
limits H7 

D6 D7 D8 D9 D10 A A1 B R R1 b b' b1 d d1 d2 d3 l l1 m h+0,2 S α 
D1  

deviation 
limits h8 

R2 α1 h1 R3 deviation 
limits h8 

80 65 42 42 37 52 72 50 62 20 75 28 92 12 5 7 - - 
M12*1,5-

6Н 
9 10,5 17 45 5 12,5 3,5 30 - 

Take  
accordingly 
Table 3.6 

100 65 42 42 37 52 72 68 82 20 92 36 115 12 10 8 8 24 
M12*1,5-

6Н 
11 10,5 23 45 5 12,5 3,5 12 30˚ 

125 75 48 50 44 58 82 90 105 24 110 48 140 16 10 10 10 32 
M16*1,5-

6Н 
13 14,3 - 55 10 15 4 14 45˚ 
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Front covers for pneumatic cylinders D=160 and 200 mm (pos. 6) 

 
 

1.    Material:Cast iron СЧ 21 ГОСТ 1412-85  2.    Unspecified maximum dimensional deviations: H14,h14,
2

JT14


D D2 D3  
deviation 

limits 
H8 

D4 

D5  
deviation 
limits . 

 H7 

D6 D7 D8 D9 D10 D11 A A1 B R R1 b b1 d d1 d2 d3 l l1 l2 l3 l4 m h+0,2 S 
D1  

deviation
limits h8 

R2 R3 

h1  
deviation 

limits 
h12 

α deviation 
limits h8 

160 85 58 56 52 70 92 120 140 24 130 140 66 180 16 12 12 32 M16*1,5-6H 17 14,3 M6 58 13 31 14 15 15 3 15 Take  
accordingly 
Table 3.6 

200 110 70 70 64 88 120 160 180 26 160 172 80 220 16 16 16 32 M18*1,5-6H 22 16,3 M8 69 19 42 22 20 17,5 4,5 18 
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Front covers for pneumatic cylinders D=250 and 320 mm (pos. 6) 

 

1.   Material:Cast iron СЧ 21 ГОСТ 1412-85  2.    Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 D3  
deviation 
limits  H8

D4 
D5  

deviation 
limits H7 

D6 D7 D8 D9 D10 D11 A A1 B R R1 b b1 d d1 d2 l-0,2 l1 l2 m h+0,2 h1 S α 
D1  

deviation 
limits h8

R2 R3 h2 α deviation 
limits h8 

250 115 80 82 77 96 125 200 225 26 210 210 105 275 16 60 18 32 M18*1,5-6H 22 16,3 80 25 42 17,5 5 1 20 45˚ Take  
accordingly 
Table 3.6 320 135 100 100 94 114 145 260 290 34 290 265 137 345 20 80 25 40 M24*1,5-6H 26 21б7 105 45 47 20 5,5 1 24 30˚ 
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Sleeves for pneumatic cylinders D=40...320 mm (pos. 8)         Locking washers for pneumatic cylinders D=40...320 mm (pos. 14) 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
1. Material: Bronze Br.AZh9-4 ГОСТ 493-79     1. Material: sheet 

S GОSТ 19903-74

St3GОSТ14637ି89
 

2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14   2. Unspecified maximum dimensional deviations H14,h14,
2

JT14


D 
D1  

deviation 
limits H7 

D2  
deviation 
limits r6 

D3 D4 l l1
+0,2 b r c 

40 12 22 25 21,5 18 15,5 

3 1 1,5 
50 16 28 31 27,5 22 19,5 
80 25 37 39 36,5 32 29 

125 32 44 48 43,5 42 38,5 
160 40 52 55 51 45 42,5 

5 1,6 2 
200 50 61 69 63 55 51 
250 63 77 79 76 65 60,5 
320 80 94 98 93 90 85 

D D1 d 

a   
deviation 

limits 
h12 

t+0,2 h S 

40 22 8 
4 

6 
3 

0,8 

50 25 10 7 
80 35 16 

5 
13 

4 
125 42 20 17 
160 48 24 21 

5 
200 62 30 

6 
27 

250 72 36 33 
1,0 

320 90 48 8 45 
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Sleeves for pneumatic cylinders D=40...320 mm (pos.10) 

 
 

Stroke  
of the 
piston 

L 

D 
deviation 

limits 
Н11 

D1 D2 l l1 

50 

40 47 43 

98 

12 

60 108 
80 128 
100 148 
125 173 
160 208 
40 

50 58 53 

96 

 

50 106 
60 116 
80 136 
100 156 
125 181 
40 

63 71 66 

96 

15 

50 106 
60 116 
80 136 
100 156 
125 181 
40 

80 90 83 

100 

15 

50 110 
60 120 
80 140 
100 160 
125 185 
40 

100 112 103 

100 

15 

50 110 
60 120 
80 140 
100 160 
125 185 
160 220 
40 

125 138 128 

100 

15 

50 110 
60 120 
80 140 
100 160 
125 185 
160 220 
180 240 
200 260 
220 280 
250 310 
50 

160 174 163 

110 

15 

60 120 
80 140 
100 160 
125 185 
160 220 

Stroke  
of the 
piston 

L 

D 
deviation 

limits 
Н11 

D1 D2 l l1 

180 240 
200 260 
220 280 
250 310 
50 

200 215 203 

112 

15 

60 122 
80 142 
100 162 
125 187 
160 222 
180 242 
200 262 
220 282 
250 312 
280 342 
320 382 
50 

250 268 253 

130 

20 

60 140 
80 160 
100 180 
125 205 
160 240 
180 260 
200 280 
220 300 
250 330 
280 360 
320 400 
360 440 
50 

360 340 324 

130 

20 

60 140 
80 160 
100 180 
125 205 
160 240 
180 260 
200 280 
220 300 
250 330 
280 360 
320 400 
360 440 
400 480 

1.  Material: Steel 45 ГОСТ 1050-88 
2.  Unspecified maximum dimensional 

deviations: H14,h14,
2

JT14
  
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Rods with external thread for pneumatic cylinders D=40...320 mm (pos. 11) 
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D 
Stroke  

of the piston L 
d d1 

d2 l l1 l2 l3 l4 l5 L6 L7 b S t R 
d4  

deviation 
limits h8 

h1 α R1 R2 

deviation limits 
  f7 f8                   

40 

40 

12 8 M8-6g 

152 

20 8 10 20 35 

Determine 
according to 
 table 2.14 

4 10 6 2 

Take  
accordingly 
Table 3.6 

50 162 
60 172 
80 192 
100 242 
125 237 
160 272 

50,63 

40 

16 12 M10-6g 

166 

25 10 11 21 37 4 14 7 2 

50 176 
60 186 
80 206 
100 226 
125 251 

80,100 

40 

25 18 M16-6g 

188 

32 15 11 24 48 5 22 13 2,5 

50 198 
60 208 
80 228 
100 248 
125 273 
160 308 

125 

40 

32 22 M20-6g 

213 

46 15 11 24 53 5 27 15 2,5 

50 223 
60 233 
80 253 
100 273 
125 298 
160 333 
180 353 
200 373 
220 393 
250 423 

160 

40 

40 25 M24-6g 

229 

50 15 11 24 56 5 36 20 2,5 

50 239 
60 249 
80 269 
100 289 
125 314 
160 349 
180 369 
200 389 
220 409 



149 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

1. Material: Steel 40X ГОСТ 4543-71   2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14
   

3. Take the value of c in accordance with the norms of Table 2.14

D 
Stroke  

of the piston L 

d d1 
d2 l l1 l2 l3 l4 l5 l6 l7 b S t R 

d4  
deviation 
limits h8 

h1 α R1 R2 deviation limits 

  f7 f8                   
160 250 40 25 M24-6g 439 50 15 11 24 56 

Determine 
according to 
 table 2.14 

5 36 20 2,5 

Take 
according to 

 table 3.6 

200 

50 

   

268 

         

60 278 
80 298 
100 318 
125 343 
160 378 
180 398 
200 418 
220 438 

250 

50 

63 40 M36-6g 

296 

60 18 17 35 76 6 55 32 3 

60 306 
80 326 
100 346 
125 371 
160 406 
180 426 
200 446 
220 466 
250 496 
280 526 
320 566 

320 

50 

63 40 M36-6g 

296 

60 18 17 35 76 6 55 32 3 

60 306 
80 326 
100 346 
125 371 
160 406 
180 426 
200 446 
220 466 
250 496 
280 526 
320 566 
360 606 
400 646 
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Pistons for pneumatic cylinders D=40...320 mm (pos. 16) 
 

 

1. Material: aluminum alloy D1 ГОСТ 4784-97        2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14


D  deviation 
limits f8 

D2 D3 D4 
d deviation 
limits H8  

d1 l l1 l3 n h c 
D deviation 

limits h8 
D5 l2 

40 - - 38 8 11 24 15 2,5 1 
- 

0,5 
Take 

according to 
 table 3.7 

50 - - 48 
12 14 26 15,8 3 1 

63 - - 61 
80 40 50 78 

18 20 
30 19 3,5 

2 
2 

100 40 68 98 
125 55 90 123 22 24 
160 60 115 158 25 28 

1,0 
200 80 160 198 32 35 32 20 4 

3 250 100 200 247 40 43 
40 26,5 4,5 4 

320 120 260 317 50 53 
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Tie rods for pneumatic cylinders D=40...320 mm (pos.17) 

 

D 
Stroke 

of the piston L d l l1 

40 

40 

M6-6g 

167 

25 

50 177 
60 187 
80 207 

100 227 
125 252 
160 287 

50,63 

40 

M8-6g 

183 

28 

50 193 
60 203 
80 223 

100 243 
125 268 

80 

40 

M8-6g 

190 

35 

50 200 
60 210 
80 230 

100 250 
125 275 
160 310 

100 

40 

M10-6g 

200 

42 

50 210 
60 220 
80 240 

100 260 
125 285 
160 320 

125 

40 

M12-6g 

220 

50 

50 230 
60 240 
80 260 

100 280 
125 305 
160 340 
180 360 
200 380 
220 400 
250 430 

160 

40 

M16-6g 

233 

60 
50 243 
60 253 
80 273 
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1.  Material: circle
ௗ -  GОSТ 7417-75

20- GОSТ 1051-73
 

2.  Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

3.  Take the value of c in accordance with the norms of Table 2.14 
 

D 
Stroke  

of the piston L d l l1 

 

100 

 

293 

 

125 318 
160 353 
180 373 
200 393 
220 413 
250 443 

200 

50 

M20-6g 

270 

70 

60 280 
80 300 

100 320 
125 345 
160 380 
180 400 
200 420 
220 440 
250 470 

250 

50 

M20-6g 

295 

80 

60 305 
80 325 

100 345 
125 370 
160 405 
180 425 
200 445 
220 465 
250 495 
280 525 
320 565 
360 605 

320 

50 

M20-6g 

320 

80 

60 330 
80 350 

100 370 
125 395 
160 430 
180 450 
200 470 
220 490 
250 520 
280 550 
320 590 
360 630 
400 670 
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Rear covers for pneumatic cylinders D=40 and 50 mm (pos. 18) 

 
 

1. Material: aluminum alloy D1 ГОСТ 4784-97 

2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 
D3 D4 A B d1 l l1 l2 h h1 r 

D1  
deviation 
limits h8 

R R1 h2 α 

deviation limits h8 

40 45 35 20 42 55 7 41 12 7,5 14 30 6 Take according to 
 table 3.6 50 52 40 24 52 70 9 44 15 8 16 38 8 
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Rear covers for pneumatic cylinders D=63 and 80 mm (pos. 18) 

 
 

1. Material:  D = 63 mm - aluminum alloy D1 ГОСТ 4784-97,     D = 80 mm - cast iron СЧ21 ГОСТ 1412-85 

2. Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 D3 D4 D5 D6 D7 D8 A A1 B R1 b d d2 l m h h1 S S1 D1  deviation limits h8 R R2 h2 α deviation limits h8 
63 52 40 24 - 45 - 20 60 20 78 10 - M12*1,5-6Н 10,5 45 12,5 16 - - 5 Take according to 

 table 3.6 80 65 55 35 50 62 72 20 75 28 92 10 7 M12*1,5-6Н 10,5 45 12,5 20 2 30 8 
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Rear covers for pneumatic cylinders D=100 and 125 mm ( pos. 18) 

 

1.   Material: Cast iron СЧ21 ГОСТ 1412-85  2.   Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 
D3 D4 D5 D6 D7 D8 A A1 B R b b1 d d1 d2 l m h S α α1 

D1  
deviation 
limits h8 

R1 R2 h1 α2 

deviation 
limits h8 

100 65 48 35 68 82 72 20 92 36 115 12 8 24 M12*1,5-6Н 11 10,5 45 12,5 20 12 30˚ 10˚ Take according to 
 table 3.6 125 75 55 35 90 105 82 24 110 48 140 16 10 32 M16*1,5-6Н 13 14,3 50 15 25 14 45˚ 15˚ 
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Rear covers for pneumatic cylinders D=160 and 200 mm (pos. 18) 

 

1.   Material: Cast iron SCh21 ГОСТ 1412-85  2.   Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 
D3 D4 D5 D6 D7 D8 D9 A A1 B R R1 b b1 d d1 d2 l l1 m h S S1 

D1 

deviation 
limits h8 

R2 R3 h1 α deviation 
limits h8 

160 85 65 52 120 140 92 24 130 140 66 180 16 12 12 32 M16*1,5-6Н 17 14,3 53 31 15 30 15 8 Take according to 
 table 3.6 200 110 90 60 160 180 120 26 160 172 80 220 16 16 16 32 M18*1,5-6Н 22 16,3 58 42 17,5 35 18 10 
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Rear covers for pneumatic cylinders D=250 and 320 mm (pos. 18) 

 
 

 

1.   Material: Cast iron SCh21 ГОСТ 1412-85  2.   Unspecified maximum dimensional deviations: H14,h14,
2

JT14  

D D2 
D3 D4 D5 D6 D7 D8 D9 A A1 B R R1 R2 b b1 d d1 d2 l l1 l2 m h h1 S S1 α α1 

D1  
deviation 
limits h8 

R2 R3 h2 α2 deviation 
limits h8 

250 115 92 65 200 225 125 26 210 210 105 275 16 60 16 18 32 М18*1,5-6Н 22 16,3 63 42 8 17,5 38 1 20 12 45˚ 15˚ Take according to 
 table 3.6 320 135 120 95 260 290 145 34 290 265 137 345 20 80 20 25 40 М24*1,5-6Н 26 21,7 70 47 10 20 48 1 24 14 30˚ - 
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Cylinder 
diameter , D 

D5 D1 l2

40 39,3 28,0 6,6 
50 49,3 37,0 

7,2 
63 62,3 50,0 
80 79,3 67,0 

100 99,3 87,0 
125 124,0 112,0 

7,7 160 159,0 146,0 
200 199,0 186,0 
250 248,8 234,0 

8,8 
320 318,8 304,0 

Ring size D(d1) 
Movable joint 

Fixed 
connection 

D1(d4) h1 D1(d4) h1

005-008-19 8 5 2,4 5,2 2,6 
008-012-25 12 8 

3,3 
8,3 

3,6 014-018-25 18 14 14,3 
018-022-25 22 18 18,3 
020-025-30 22 17 3,7 17,3 4,0 
026-032-36 32 26 

4,4 

26,4 

4,7 

034-040-36 40 34 34,4 
044-050-36 50 44 44,4 
057-063-36 63 57 57,4 
074-080-36 80 74 74,4 
094-100-36 100 94 94,4 
032-040-46 40 32 

5,2 

32,6 

5,6 
118-125-46 125 117 117,6 
150-160-46 160 152 152,6 
190-200-46 200 192 192,6 
240-250-58 250 240 

6,5 
240,8 

7,0 
310-320-58 320 310 310,8 

Rod diameter , 
d 

D1 D5 h1 

12 22 12,4 5,5 
16 28 16,4 

6,5 
25 37 25,4 
32 44 32,4 
40 52 40,4 
50 64 50,8 

7,7 
63 77 63,8 

l

D

2x45°

5 D

D

2

1

D
  (

d 
 )D
 (

d 
 )

R0,2

h

R0,6

=0   5°

1

4

1

1

2x45°

d

D
1

D
5

h1

Table 3.5 

 Seats for rod seal cuffs (type 2)  
(ГОСТ 6678-72) 

Table 3.6 

Seating for rings 
(ГОСТ 9833-73) 

Table 3.7 

 Seating for sealing cuffs cylinder 
(type 1)  

(ГОСТ 6678-72) 
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Recommendations for execution 

1. Study the product diagram, its functioning, the purpose of each part, and the functional features of
the parts.

2. According to the variant, determine the size and shape of the component parts.
3. Identify parts that are manufactured by industry, that is, standard.
4. Make a specification for the product, taking into account the availability of standard and standardized

parts.
5. Develop drawings of components of non-standard parts, taking into account the design of standard

elements.
6. Make an assembly drawing of the product, putting the necessary dimensions and positions of the

components.
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